Contents

1. Copyright Notice ........................................................................................................................................................................ 9
2. What's New for WebCenter Administrators? .......................................................................................................................... 11
3. WebCenter Administration Basics ......................................................................................................................................... 13
   3.1 A Note on Web Browsers ................................................................................................................................................ 13
   3.2 Understanding the WebCenter Page Layout ..................................................................................................................... 13
   3.3 Filtering Content ................................................................................................................................................................. 15
   3.4 The Admin Menu ............................................................................................................................................................... 16
4. WebCenter Preferences .............................................................................................................................................................. 17
   4.1 General Preferences ............................................................................................................................................................ 17
      4.1.1 Viewer ........................................................................................................................................................................... 19
      4.1.2 Approval ........................................................................................................................................................................ 23
      4.1.3 ArtiosCAD ................................................................................................................................................................... 24
      4.1.4 Text Management ......................................................................................................................................................... 25
   4.2 Password Preferences ........................................................................................................................................................... 25
   4.3 Security Preferences ............................................................................................................................................................ 26
   4.4 Document Type Preferences ................................................................................................................................................. 27
   4.5 Notifications Preferences ...................................................................................................................................................... 27
   4.6 Menus Preferences .............................................................................................................................................................. 28
      4.6.1 Create a Custom Menu through the WebCenter User Interface .................................................................................. 28
      4.6.2 Update a Custom Menu through the WebCenter User Interface ............................................................................. 35
      4.6.3 Create a Custom Project Details / Document Details Menu through the User Interface ....................................... 35
      4.6.4 Create a Custom Menu Using XML .......................................................................................................................... 38
      4.6.5 Update a Custom Menu Using XML ......................................................................................................................... 39
      4.6.8 Delete a Custom Menu .................................................................................................................................................. 42
   4.7 My Work Preferences .......................................................................................................................................................... 42
      4.7.1 About My Work Sections .............................................................................................................................................. 42
      4.7.2 Create a My Work Section ............................................................................................................................................ 43
      4.7.3 Edit the Default My Work Page ................................................................................................................................... 44
   4.8 WebCenter Reporting ......................................................................................................................................................... 45
      4.8.1 Accessing WebCenter Reports .................................................................................................................................... 45
      4.8.2 Types of Reports Available ......................................................................................................................................... 46
      4.8.3 Configuring a Report ...................................................................................................................................................... 48
      4.8.4 Running a Report ............................................................................................................................................................ 48
      4.8.5 Managing Reports ......................................................................................................................................................... 49
5. CAD Options ............................................................................................................................................................................. 50
   5.1 CAD Download Format ......................................................................................................................................................... 50
   5.2 Boards ....................................................................................................................................................................................... 50
8. Advanced Search Setups in WebCenter

8.1 Search enhancement

6. CHILI

6.1 Configure WebCenter-CHILI Server Connection
6.2 Upload a CHILI Package
6.3 Locking behavior
6.4 Download CHILI Documents
6.5 Dynamically assign workspaces and constraints to CHILI Documents
6.6 Loading Assets into the CHILI Editor

7. Project Management for Administrators

7.1 Projects
7.2 Project Templates
7.2.1 Create a Template from Scratch
7.2.2 Create a Template from a Project Template
7.2.3 Save a Project as a Template
7.2.4 Changing What Users See When They Create a Project
7.3 Document Templates
7.3.1 Create Document Templates
7.4 Project Creation Settings
7.5 Document Creation Settings
7.5.1 Uploading documents in project creation
7.6 Document Types
7.7 Create Project Thumbnails Automatically from Documents
7.8 Project Statuses
7.8.1 Viewing a List of Project Statuses
7.8.2 Adding a Project Status
7.8.3 Editing a Project Status
7.8.4 Deleting a Project Status
7.8.5 Customizing a Project Status
7.8.6 Searching based a Project Status
7.8.7 Filtering based on Project Status
7.8.8 Setting a Project Status to Active or Non Active
7.9 Find and Unlock Locked Documents
7.10 Delete View Files
7.10.1 Regenerate View Files

8. Advanced Search Setups in WebCenter
9. Managing Companies

9.1 Create a New Company

9.2 Edit a Company

9.3 Delete a Company

9.4 Add Locations

9.5 Edit a Location

9.6 Delete a Location

10. Managing Users

10.1 Create a User

10.2 Licensing and Users

10.3 Check the Licensing Status

10.4 Editing Users and their Preferences

10.4.1 Edit a User

10.4.2 Change the Password for a User

10.4.3 Change a User’s License Status

10.4.4 Set the Preferences for a User
14.1.4 Export / Import Restricted Sets.................................................................................................................................153
14.2 Attributes.......................................................................................................................................................................................154
  14.2.1 Create an Attribute...........................................................................................................................................................154
  14.2.2 Edit an Attribute...............................................................................................................................................................156
  14.2.3 Delete an Attribute.............................................................................................................................................................156
14.3 Attribute Categories...........................................................................................................................................................................156
  14.3.1 Create an Attribute Category............................................................................................................................................156
  14.3.2 Rename an Attribute Category.........................................................................................................................................156
  14.3.3 Add Attributes to an Attribute Category...........................................................................................................................157
  14.3.4 Delete an Attribute Category...........................................................................................................................................162
  14.3.5 Use a Grid Layout.................................................................................................................................................................163
  14.3.6 Enhancing Attributes with Advanced Features from Grid Layout..................................................................................169
  14.3.7 Restrict Attribute Values to Previously Selected Values................................................................................................182
14.4 Cascading Dropdowns....................................................................................................................................................................183
  14.4.1 Lists.........................................................................................................................................................................................183
  14.4.2 Cascading Dropdowns from Excel Sheet................................................................................................................................190
  14.4.3 Why Use Database Lists instead of Web Server Lists?....................................................................................................199
14.5 Document References.....................................................................................................................................................................199
  14.5.1 Create a Document Reference Attribute..........................................................................................................................200
  14.5.2 Edit a Document Reference Attribute................................................................................................................................204
  14.5.3 Delete a Document Reference Attribute............................................................................................................................205
  14.5.4 Document References in an Attribute Category................................................................................................................205
  14.5.5 How to Create a Functioning Document Reference System...........................................................................................217
15. WebCenter Configuration..................................................................................................................................................................224
  15.1 Configure E-Mail.........................................................................................................................................................................224
  15.2 Configure Search Crawler Setup..........................................................................................................................................225
  15.3 Configure External Web Connections.....................................................................................................................................226
    15.3.1 Create an External Web Connection................................................................................................................................226
    15.3.2 Edit an External Web Connection...................................................................................................................................227
    15.3.3 Delete an External Web Connection................................................................................................................................227
  15.4 Configure Workflow Connections...............................................................................................................................................228
    15.4.1 Workflow Connections........................................................................................................................................................228
    15.4.2 Create a Workflow Connection.........................................................................................................................................229
    15.4.3 Edit a Workflow Connection............................................................................................................................................232
    15.4.4 Delete a Workflow Connection..........................................................................................................................................232
    15.4.5 Add a Workflow Connection to a Project / Template......................................................................................................232
    15.4.6 Define When the Project and Workflow Synchronize....................................................................................................234
  15.5 Configure Push-Through Configurations for Workflow Folders..............................................................................................235
    15.5.1 About Workflow Folders...................................................................................................................................................235
    15.5.2 Create a Push-Through Configuration................................................................................................................................235
    15.5.3 Delete Push-Through Configurations................................................................................................................................236
  15.6 Configure Workflow Approval and Tunnel Clients..................................................................................................................236
    15.6.1 Create a Workflow Approval and Tunnel Client..............................................................................................................237
<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>16. Connecting to Automation Engine</td>
</tr>
<tr>
<td>16.1 Create a Tunnel between WebCenter and Automation Engine</td>
</tr>
<tr>
<td>17. Bill of Materials</td>
</tr>
<tr>
<td>17.1 What is a Bill of Materials?</td>
</tr>
<tr>
<td>17.2 Enabling the Bill of Materials Feature</td>
</tr>
<tr>
<td>17.3 Viewing a Project's Bill of Materials</td>
</tr>
<tr>
<td>17.4 Editing the Bill of Materials</td>
</tr>
<tr>
<td>17.4.1 Who Can Edit the Bill of Materials?</td>
</tr>
<tr>
<td>17.4.2 Adding Documents to the Bill of Materials</td>
</tr>
<tr>
<td>17.4.3 Removing Documents from the Bill of Materials</td>
</tr>
<tr>
<td>17.5 How to Search for a Bill of Materials</td>
</tr>
<tr>
<td>17.5.1 Search for Projects that have a Bill of Materials</td>
</tr>
<tr>
<td>17.5.2 Viewing the Bill of Materials in a Project Search</td>
</tr>
<tr>
<td>17.6 How to See if a Document is Part of a Bill of Materials</td>
</tr>
<tr>
<td>17.7 Bill of Materials History</td>
</tr>
<tr>
<td>17.8 Email Notifications for Bill of Materials Changes</td>
</tr>
<tr>
<td>17.9 Working on the Bill of Materials from ArtiosCAD Enterprise</td>
</tr>
<tr>
<td>18. Autoname Generation</td>
</tr>
<tr>
<td>18.1 Structure of Autoname Generation</td>
</tr>
<tr>
<td>18.1.1 Types of Autoname Generation</td>
</tr>
<tr>
<td>18.2 Things to Keep in Mind</td>
</tr>
<tr>
<td>18.3 Using SmartNames in Autoname Generation</td>
</tr>
</tbody>
</table>
18.3.1 What is a SmartName? ............................................................................................................................ 267
18.3.2 Using a SmartName .................................................................................................................................. 268
18.3.3 List of Available SmartNames .................................................................................................................. 268
18.3.4 Using SmartNames in Autonaming .......................................................................................................... 269
18.4 Using Autoname Generation ......................................................................................................................... 270
18.4.1 System-Wide Project Autonaming ........................................................................................................... 270
18.4.2 Template-based Project Autonaming ........................................................................................................ 271
18.4.3 System-Wide Document Autonaming ...................................................................................................... 272
18.4.4 Template/Project-based Document Autonaming ...................................................................................... 273

19. Migrating your WebCenter Data .................................................................................................................... 274
19.1 Possible Use Cases ........................................................................................................................................ 274
19.2 Things to Know about Migrating Data ....................................................................................................... 274
19.3 Exporting Data .............................................................................................................................................. 274
19.3.1 Exporting Groups ...................................................................................................................................... 274
19.3.2 Exporting Attribute Categories .................................................................................................................. 275
19.3.3 Exporting Task Types ............................................................................................................................... 275
19.3.4 Exporting a Workflow ............................................................................................................................... 275
19.3.5 Exporting Templates ............................................................................................................................... 276
19.3.6 Exporting Projects .................................................................................................................................... 276
19.4 Importing Data ................................................................................................................................................ 277
19.4.1 Importing Groups ........................................................................................................................................ 277
19.4.2 Importing Attribute Categories ................................................................................................................ 277
19.4.3 Importing Task Types ............................................................................................................................... 278
19.4.4 Importing a Workflow ............................................................................................................................... 278
19.4.5 Importing Templates .................................................................................................................................. 278
19.4.6 Importing Projects .................................................................................................................................... 279
19.5 Migration File Contents ............................................................................................................................... 280
1. Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. What's New for WebCenter Administrators?

**HTML 5 Viewer**
- Restricted mode in *Viewer* on page 19.
- *General Preferences* on page 17
- *Viewer quality setting*

**CAD**
- *Enable New Revision Upload*
- *Canvas Support*

**Persistent Cart**
- *General Preferences* on page 17

**SmartName Searches**
- *SmartNames in Search* on page 114

**Search Improvements**
- *Advanced Search Setups in WebCenter* on page 82

**Main Task Assignee**
- *Edit a Task Type*

**Document References**
- *Document References* on page 199
- *Searching for Document References* on page 119
- *Configure Document Actions*

**Connection with Automation Engine (out of LAN)**
- *Configure Workflow Connections* on page 228

**User Login Tracking**
- *Login Tracking* on page 129

**Licensing**
- *Licensing and Users* on page 127
- *Edit a User* on page 131
Configurable Project / Document Details menu items

- Create a Custom Project Details / Document Details Menu through the User Interface on page 35
3. WebCenter Administration Basics

WebCenter installs with a minimal configuration because every installation has different needs. This guide explains how to set up WebCenter and make it ready for use.

3.1 A Note on Web Browsers

Due to differences between the Web browsers, some configuration issues in Firefox and Safari require extra action in order for WebCenter to function properly. Anyone using WebCenter with either of these browsers on any platform should consider performing these configuration changes.

Mozilla Firefox

Refreshing pages may not get the most current data from the WebCenter Web server. In order to ensure the most current data is seen, caching must be disabled, or you must press ctrl-r on any suspect pages to forcibly reload them.

To disable caching, do the following:

1. Log in and start Firefox.
2. In the Address field, type about:config and press enter.
3. Scroll down to the network.http.use-cache entry and double-click it so that its value changes from true to false.
4. Restart Firefox.

Safari

When using Safari, the built-in browser for Apple Macintosh computers running OS X, there is no way to configure caching. When using the Back button, click Refresh to ensure you see the most current data.

3.2 Understanding the WebCenter Page Layout

Header

The top right of the WebCenter page always shows:

- the name of the current user,
- a icon to go back to the user’s start page,
- the Cart ,
- a link to the WebCenter Welcome page,
- Admin (if the user is a member of the Admins group),
- Contact,
- Logout.
Top Menu Bar

By default, the top menu bar contains the following menus: **My Work**, **Projects**, **Task Types**, **Search**, **My WebCenter**, **Create** (if you are a Project Manager) and **Upload** (see *The Default WebCenter Menus* for more details). An administrator can customize the menus.

If you have the optional Task Management module and the **User Can Create Task Type** permission, **Task Types** also appears in the top menu bar.

Documents Pages

Below is a sample of project's **Documents** page, in grid layout, for a user who is a Project Manager.

- **Area 1** is the project actions area, allowing you to perform actions on the whole project (for example, mail a link to the project to a reviewer, add the project to your favorite projects...).
- **Area 2** is the Project Details area, containing the project icon, the name and description of the project, the project status...
- **Area 3** shows links to the project pages. For example, click **Members** to view the project members. The page you are on is shown in bold.
- **Areas 4** and **5** are part of the content pane, that changes depending on the project page you are on. Here, on the **Documents** page, they show the project folders and documents.
- **Area 4** is the Folders pane, showing the projects folders. Click a folder to see the documents it contains.
- **Area 5** is the document pane, that can show the documents in a list or grid view, with or without thumbnails.

Notes

- To act on many documents at once, select their checkboxes and then choose an action in the **Actions** menu.
- To select all documents in the current folder, select the checkbox before the **Documents** header.
• To switch to a list layout, click **Show as List**.

• Hovering over a thumbnail shows a larger version of it in a pop-up window.

For Graphic documents viewable by the WebCenter Viewer, you can click the zoom icon to show an even larger thumbnail (500 x 500 pixels). This is applied to all Graphic documents on which you hover until the page is reloaded.

The pop-up window closes when you move the cursor off the thumbnail.

There is usually more than one way to accomplish a task by using a combination of menu entries, action menus, and clicking status messages. Many methods will lead to the same result.

### 3.3 Filtering Content

As more information is managed over time by WebCenter, some pages can potentially show large amounts of information. To reduce the time needed to show the page when it first loads, some pages have a filter and a **Go** button at the top.

To use the filter, enter a search string with an asterisk either before it, surrounding it, or after it in the **Search** field, and click **Go**. For example, on the **Companies** page, to only see those companies with the word **Containers** in their name, enter **“Containers”** and click **Go**.

When filtering users, use the last name of the user.

To show all the items, up to the truncation limit, click Go with nothing in the field.

**Note:** The truncation limit prevents lists of thousands of items from impacting response time; if you know in advance that your search will return that many items, refine it with the filter. The truncation limit can be changed; contact Professional Services at your local Esko office for more information.
3.4 The Admin Menu

All administration is done initially by Admin, the administrative user who has full control over WebCenter.

The Admin user and members of the Admins group have the Admin link in the right side of the header.

Click **Admin** to open the Admin menu. The **Users** page is shown by default.

To return to the normal WebCenter menus, click **Exit Admin**.
4. WebCenter Preferences

The Preferences menu in the Admin section of WebCenter allows you to set system-wide preferences in a number of categories:

- General
- Passwords
- Security
- Document Types
- Notifications
- Menus
- My Work
- Reports

4.1 General Preferences

Click General on the Preferences menu to set system-wide preferences.

**Note:** The individual users can override nearly all of these properties for themselves in My WebCenter > My Preferences. Those users who have changed these settings are not affected by later changes made to the same fields in Admin > Preferences > General by an administrator.

**General**

- **Language** sets the language used by the user interface.
- **Start Page** sets the page that appears when you log on.
- **Default Project Page** sets the page that appears when clicking a project name.
- **Default Document Page** sets the page that appears when clicking a document name.
- **Units** sets units for all measurements to either Metric (mm, cm, dm, m) or Imperial (in, ft, yd).
- **Thumbnails:** selecting Show thumbnails shows thumbnails in document lists by default.
- **Cart:** Clear cart on Logout is always enabled by default. Disable this option if you want your users to access their cart contents across sessions.

**Project Lists**

- **Show ... rows** sets the number of projects displayed in the List layout.

**Document Lists**

- **Default Layout** sets the default view for document lists: Grid or List layout.
- **Show in Grid** sets the number of documents displayed on a single page in the Grid layout (defined as a number of Columns and Rows in the grid).
- **Show in List** sets the number of documents displayed on a single page in the List layout (defined as a number of Rows in the list).

**Search Results - All**

**Show in List** sets the number of documents displayed on a single page in the Search results List layout (defined as a number of Rows in the list).
Search Results - Documents

- **Default Layout** sets the default view for document search results pages to Grid or List layout.
- **Show in Grid** sets the number of documents displayed on a single page in the Search results Grid layout (defined as a number of **Columns** and **Rows** in the grid).

Search Results - Projects

- **Default Layout** sets the default view for project search results pages to Grid or List layout.
- **Show in Grid** sets the number of projects displayed on a single page in the Search results Grid layout (defined as a number of **Columns** and **Rows** in the grid).

Discussions

- **Discussions per Page** sets the number of discussion threads displayed per page on the Discussions pages.
- **Postings per Page** sets the number of discussion posts displayed per page on a Discussions page.

Roles

**Invite Group Default** sets the system-wide default state of the Invite Group check box, available on the Manage Roles page and in the Members area of the Project Creation page (when creating a project based on a project/template that contains roles).

Bill Of Materials

**Use Bill of Materials** enables the Bill of Materials functionality for the entire WebCenter system. See Bill of Materials on page 251 for more information.

My Work Defaults

- **My Approvals Assignee Filter** sets what users view by default in the My Approvals section of their My Work page (approvals assigned to Me, Me or Group I Am In or Group I Am In).
- **My Tasks Assignee Filter** sets what users view by default in the My Tasks section of their My Work page (tasks assigned to Me, Me or Group I Am In or Group I Am In).
- **Non Started Tasks** sets whether users’ My Work page displays tasks assigned to them that aren’t started yet.

Project Autoname Generation

Use the **Project Autoname Generation** settings to automatically generate project names.

These settings use a naming template (**Prefix**, **Suffix** and **Counter Length**) to define the automatically generated names.

For the **Prefix** and **Suffix**, use building blocks. You can find a list of the building blocks you can use by clicking Help at the top right of the page.

**Note:** Make sure to read the notes at the bottom of the page for restrictions. The building blocks are case-sensitive.

The **Counter Length** is a numerical field that gets incremented for each new Project using the same prefix. It is placed between the prefix and the suffix.

In the **Counter Length** field, enter the length of that incremental counter. For example, enter 5 for numbers that will be five digits long.
Select **Use Automatic Naming for Creation of Blank Projects** if you want to automatically generate the names of projects created from a blank project.

**Other Preferences**

- **Host URL** sets the URL at which the WebCenter site can be accessed. This is the URL used to send automatic email notifications.

- **Host URL for internal use** sets the URL at which internal components, like Automation Engine, can access the WebCenter site. Use this to go through the local network (using your WebCenter server’s local computer name) instead of through the internet (using your WebCenter server’s public IP or computer name).

  You should use this if, due to your setup, the DNS doesn’t know the WebCenter server’s public name inside your Local Area Network.

  **Note:** You can only use this when Automation Engine and WebCenter are on the same LAN.

  If this is not filled in, Automation Engine will connect to WebCenter using the **Host URL**.

  For both **Host URL** and **Host URL for internal use**, you can choose to use either **http://** or **https://**. Choose the protocol defined during the WebCenter installation.

**4.1.1 Viewer**

- Select your **Viewer Type**. You can set your preference to the **HTML5 Viewer** or keep at the default (**Java Viewer**).

  **Note:** You can always switch to **Java Viewer** from **HTML5 Viewer** using the button.

- **Viewer and Workflow Applet**: When opening a document in the **Viewer** or when creating a workflow, WebCenter will download a Java applet to your computer.

  From Java 1.7.0_21 (for Windows and Mac OS X 10.7 or later), you will get a security warning as the one below when the applet is downloaded. This makes the WebCenter applet look like a security risk for your computer.
You can adapt how this security warning will look like when downloading the applet. In **Viewer** and **Workflow Applet**, choose either:

- **Signed (sandboxed)** if you want to run the applet in a strict sandboxed environment (with no access to your computer’s resources). As the applet is signed by Esko, the security warning looks less threatening.
Note:
As the applet is sandboxed, it will also show a warning when trying to print from the Viewer. You will just need to click OK to be able to print.

- **Signed (not sandboxed)** if you want to run the applet without restricting it to a sandbox (the applet can request additional access to your computer's resources). This means that you will not get an additional warning when printing from the Viewer.

As the applet is signed by Esko, the security warning looks less threatening.

- **Unsigned** if you want to run the applet as a default unsigned applet. You will get the default security warning that does not mention Esko, but the applet will be sandboxed. This means that you will have an additional security warning when printing from the Viewer, as for the Signed (sandboxed) applet.
Tip:
By default, the applet is set to run as Signed (sandboxed). This will work fine for most users.

More frequent users may want to switch to the Signed (not sandboxed) option to avoid always having to click an extra warning when printing from the Viewer.

Mac OSX 10.6 users running Java 1.6.0 may also want to switch to the Signed (not sandboxed) option to avoid getting a warning when closing the Viewer by clicking Ω.

With the latest versions of Java 1.7 installed, most browsers block unsigned applets by default. In this situation, it is recommended to use one of the signed settings instead.

- **Viewer Style** sets the Viewer mode as:
  - **Normal** (Default): All HTML5 Viewer features are available in this mode.
  - **Restricted**: In this mode, the user cannot access features such as Channels widget, CAD widget, and View widget.

  The side panels displaying the widgets will be in a collapsed format by default.
  - **Advanced** (Java Viewer only): All HTML5 Viewer features are available in this mode. In Java Viewer features will be activated.

- **Specify the Viewer Quality** as:
  - **Best Performance** (Default): In this mode, the Viewer uses lossy compression to transfer images. These images are transferred faster but may contain small compression artifacts.
  - **Best Quality**: In this mode, the Viewer uses lossless compression to transfer images. It takes longer to transfer these images. However, you can view them without compression artifacts.

  **Note**: This setting is applicable to both the HTML5 and Java Viewers.

- **Annotation Color** sets the color in which annotations will be displayed in the Viewer (you can set Viewer Default or choose a color from the list).

- **Annotate Approved Documents** sets if and how the users are allowed to annotate documents that are already approved.
  - Select **Enabled** if you want the users to be allowed to annotate approved documents.
  - Select **Warn if Approved** if you want to display a warning before allowing the users to annotate approved documents.
  - Select **Read-Only if Approved** if you don’t want the users to be allowed to annotate approved documents.
  - Select **Warn if Approved or Rejected** if you want to display a warning before allowing the users to annotate approved or rejected documents.
  - Select **Read-Only if Approved or Rejected** if you do not want the users to be allowed to annotate approved or rejected documents.

- **Annotate Documents under Approval** sets who can add annotations in the documents under approval.
Choose from the following settings:

- **All Users**: This is the default setting. All users with view access to a document can annotate that document once the approval cycle has started.

- **All Approvers and Approval Master**: The Approvers and Approval master defined in the document approval setup (all stages) for the current version can annotate during the approval cycle.

- **All Approvers**: All approvers defined in the document approval setup (all stages) can annotate the document while it is being approved.

- **Pending Approvers and Approval Master**: Only an approval master or approvers who can submit an approval state (Approve or Reject) for the current version can annotate the document during the approval cycle.

- **Pending Approvers Only**: Only approvers who can submit an approval state (Approve or Reject) for the current version can annotate the document during the approval cycle.

**Note**: Project Managers who can Force Approve or Force Reject is not considered an approver. They can add annotations only if the setting is **All Users**.

**Collada Viewer Preferences**

- Select your Collada **Viewer Type** as **Java Viewer** (the default option) to use the Visualizer quality Java applet.

- Select the Collada **Viewer Type** as **HTML5 Viewer** to set this as the preferred Collada Viewer. This allows you to view 3D files on browsers / devices lacking Java Applet capabilities.

**4.1.2 Approval**

**Approval Cycle Start when Uploading new Document or Version**

Define what should happen to a document approval cycle **When uploading a new document or version**. You can choose to:

- **Start if previous version's approval is ongoing or finished**

- **Always start (if approval setup exists)**

- **Never start**

Check the

- **Allow the uploader to override the approval cycle start option** check box to allow the user to overwrite the approval start behavior upon upload.

**Require approval comments on viewable documents**

Use this option to require the approvers to add their comments as annotations in the document. Select:
• **Prompt** to start a dialog with a comment field when the Approver Rejects or Approves with a Condition. The approver can choose to comment in the dialog or leave the comment field empty. This is the default setting.

• **Any Annotation** to enforce that at least one annotation is present while Rejecting or Approving with a Condition. The comment field will contain the following message.

| Document annotated |

• **User Annotation** to force the Approver to add at least one annotation in the document version before Rejecting or Approving with Condition. The comment field will always contain the following message.

| Document annotated |

**Note:** This setting will be applied when submitting an Approval Status from pages outside the viewer.

### Block approval when an annotation was set/changed on current version

Check this option to prevent users who have created an annotation on the current version of a document from submitting the **Approved** status without a condition.

If **Approved with Condition** is not enabled, you can submit only the **Rejected** approval state. If users have replied to an existing annotation from another user, they will no longer be able to approve the document without condition.

**Note:** This setting will also be applied when submitting an Approval Status from any page outside the Viewer. The user will then get the corresponding feedback.

### 4.1.3 ArtiosCAD

To open your document in the ArtiosCAD desktop application directly from the WebCenter server, you need to set the **ArtiosCAD Preferences** accordingly.

#### Open ArtiosCAD Documents

• **No Application:** This is the default **Preference**. When this is selected, you cannot open the documents in the ArtiosCAD desktop applications.

• **ArtiosCAD Standard Edition:** Select this setting to be able to download ArtiosCAD documents and open them in your ArtiosCAD desktop application.

• **ArtiosCAD Enterprise Edition:** Select this to open your ArtiosCAD documents in the installed ArtiosCAD Enterprise Edition directly from WebCenter.

The documents will open in the **managed mode** allowing you to make modifications to the file and update it without having to browse to the corresponding project and folder.

**Note:** This option is only supported from ArtiosCAD Enterprise 14 onwards.

#### Document Upload Preferences

• **Allow raising Document Revision when uploading a new Document Version:** Enable this to allow the users to raise the **revision** while uploading a new **document version**.
4.1.4 Text Management

Section 1

Text

4.2 Password Preferences

The Password Preferences determine whether passwords must meet security requirements, whether they expire, and whether or not users need to provide their passwords when approving or rejecting documents.

Complexity

You can enforce a number of password rules by enabling **Passwords must meet complexity requirements**. When this feature is not enabled the only requirement is that passwords be non-blank.

If **Passwords must meet complexity requirements** is enabled, WebCenter passwords:

- May not contain the user's username, first name, or last name
- Must be at least **eight** characters in length
- Must contain characters from three of the following four categories:
  - English uppercase characters (A through Z)
  - English lowercase characters (a through z)
  - Base 10 digits (0 through 9)
  - Non-alphanumeric characters (for example: ! $# %)

**Note:** Enabling this option expires all passwords. Users will be required to change their password on the next login.

Expiration

Enabling password expiration allows you to limit the length of time that a password may be used. When a user logs in with a password that has not been changed in the required number of days, he/she will be required to change their password before accessing the site.

To enable password expiration, select the option **Expire user passwords when they are ... days old** and type a number of days.

**Note:** To immediately expire all passwords without changing the other password preferences, click **Expire all passwords now** in the top right of the page.

Approval

Enable the option **Require password for approvals/rejections** if you want to force users to provide their passwords whenever they approve or reject a page or document in WebCenter.
4.3 Security Preferences

Use the Security preferences if you want to tighten the security in WebCenter.

By default, all the actions are allowed. Deselect them if you don’t want any user to perform these actions.

- **Allow removing documents with approval actions** lets Project Managers or project members with the Delete right delete documents that have already been approved/rejected/commented by at least one person/group.

- **Allow changing attributes of approved documents** lets Project Managers or project members with the Change Properties right edit the attributes of already approved documents.

- **Allow Force Approval** lets Project Managers Force Approve documents.

- **Allow Force Rejection** lets Project Managers Force Reject documents.

- **Allow changing attributes of inactive projects** lets Project Managers or project members with the Change Properties right edit the attributes of inactive projects (projects with the Non Active, Completed, On Hold or Cancelled status).

- **Allow changing members of inactive projects** lets Project Managers edit the members' list for inactive projects.

- **Allow document operations on inactive projects** lets project members with the Change Properties right edit documents in inactive projects.

   When this is selected, project members can:

   - download documents (the project history is updated in that case),
   - view documents,
   - see a document history or the project history,
   - copy documents to other projects (but not within the project).

   But cannot:

   - upload documents to the project,
   - start an approval cycle or do approval operations on documents,
   - move documents,
   - delete documents,
   - annotate documents.

   **Note:** Administrators and the Project Manager for the inactive project can perform more document-related actions.

- **Allow Project Members with Download permission to e-mail a link for non-authenticated download of a document**, allows Project Managers and members of a project with Download permissions to send a download link for a file within their project to non-WebCenter users.

   This link will only be valid for a certain number of days (enter that number in the The download link will be valid for ... days field). The default value is 14 days.
Note:
• By default, this option is deselected.
• If you deselect this option after non-authenticated download links have been sent, these download links will become invalid.
• When a non-WebCenter user clicks a link that is invalid, expired or tampered with (for example if the URL was changed), he/she will see a web page stating that the link is invalid.
• Changing the link validity (number of days) will only apply to new links.

4.4 Document Type Preferences

The Document Types page controls the kind of files WebCenter supports. The document types you enable here are available for selection:

• When uploading a new file.
• In the Search for field when searching for documents.

To enable document types, select the corresponding option in the Enable column. Click Save to confirm.

On this page you can control the system wide settings for Automatic Document Naming, Default Attribute Category and Start Task for new Documents/ Versions. You can either choose None or choose a different value. Similar settings can be found in each project and template on the Document Creation page, here you are able to choose None, Default (using the system wide settings) or Custom (defining project/template wide settings).

You can set up an Automatic Document Name per document type, as well as a Default Attribute Category. At the top of the page you can choose whether you would like to apply these settings to blank projects, by enabling the options Apply Automatic Naming to Documents in Blank Projects and Apply Default Attribute Categories to Documents in Blank Projects.

In the two columns Start Task for new Documents and Start Task for new Versions, you can setup a task to start automatically when you upload a (new version of) a specific file type. At the top of the page you can choose whether you would like to apply these settings to blank projects, by enabling the options Apply Default Start Task options to new Documents in Blank Projects and Apply Default Start Task options to new Versions in Blank Projects.

Note:
If you disable a document type and you already have documents of that type in WebCenter, they can still be found by selecting All in the Search for field when searching.

Document Details pages for those document types will still be available, and the documents can still be downloaded and have new versions uploaded.

4.5 Notifications Preferences

The Notifications page allows you to specify exactly which events in WebCenter should trigger an e-mail notification to the users involved.

For every event or action in WebCenter, you can determine whether it:
• is logged in the project history (select Include in Project History).

• triggers an e-mail notification to:
  • the Project Manager only (select Manager),
  • all the members involved with the event (select Involved People),

  **Tip:** Click on Involved People to see a list of involved people for each event.

  • all the project members (select Members).

You can also set up WebCenter to Send a reminder to the assignee/approver when a task or an approval is overdue and Repeat the reminder every x days until the task or approval is finished.

To limit the number of overdue reminders, you can set the system to only send reminders for Started tasks or Tasks that can be completed (for example, for tasks having a predecessor needing to be completed before they can be started).

Those options are available when Send a reminder... is selected.

### 4.6 Menus Preferences

The **Menus** preferences allow you to define what users can see by customizing the WebCenter menus. For example, you can remove certain menus for some users, so they have a simpler user interface to work with (they only see the menus they need to use).

You can assign custom menus to users and / or companies (see Edit a User on page 131 and Edit a Company on page 122).

The **Menus** page contains the **Default** menu, and any custom menu you have already created.

You cannot edit or delete the **Default** menu, but you can use it as a basis for creating custom menus.

From here, you can create/update a custom menu either through the WebCenter user interface or using XML. You can also delete a custom menu.

#### 4.6.1 Create a Custom Menu through the WebCenter User Interface

You can create a custom menu for each category of users, to make it more convenient for them.

You will need to:

1. Determine which menus a particular group of users needs, and which menus they don’t need.
2. On the Admin > Preferences > Menus page, click Add Menu.
3. Create your custom menu.
Note: If you do not have Task Management License, the Task related items will show the following warning:

4. Assign the menu to the user, group or company you created it for.
5. Log in to WebCenter as one of the users to which you gave the custom menu, and check whether the menu works.

Create a Custom Menu

1. On the Admin > Preferences > Menus page, click Add Menu.
2. On the Add Menu page, enter a Menu Name and Menu Description for your new menu.
3. Click the type of menu you want to customize: Main Menu, Project Details or Document Details.

   You are starting with a copy of the Default Menu.

On the left hand side, you can see the Menu Gallery (1) containing the default menu items in bold, and the default sub menu items under them.

On the right side, you can see the Menu Builder Canvas (2) (which is a graphical representation of the menu). This reflects any changes you make.

At the bottom (3), you can see and edit the details of the menu or sub menu item currently selected.

4. Edit the menu as desired:
• Add a Default (Sub) Menu Item on page 30,
• Add a Custom (Sub) Menu Item on page 33,
• Remove a (Sub) Menu Item on page 35.

Tip: You can also re-order the menus, or the sub menus within a menu, by drag-and-dropping them on the Menu Builder Canvas. You cannot drag-and-drop a sub menu to a different menu though.

5. Click Save at the bottom of the page.
6. When you are done editing your custom menu, you can click Return to go back to the Menus page.

Add a Default (Sub) Menu Item

To add a default menu or sub menu item:

1. Drag it from the Menu Gallery into the Menu Builder Canvas.

Note:
You can add the same sub menu item to different menus on the Menu Builder Canvas, but you cannot add the same sub menu item twice to the same menu, or add the same menu twice to the Menu Builder Canvas.

To quickly see whether a (sub) menu item is already used in your custom menu, you can select it in the Menu Gallery: this highlights where it is used on the Menu Builder Canvas.

Tip: After making a change, you will see that the Default Menu label above the Menu Gallery becomes Custom Menu. You will also see a Revert Menu link under it. Click this link if you want to cancel all your changes and go back to an unedited copy of the default menu.

2. In the Edit Menu area at the bottom, you can change the properties of your (sub) menu:
   a) To define what the (sub) menu is called:
      • If you don't want to translate the (sub) menu (it will have the same name in all languages):
        1. Choose Simple as Label Type.
        2. In Label, enter the name to give your (sub) menu.

      • If you want to define a new name in different languages:
        1. Choose New Localized as Label Type.
        2. In Language Tag, enter a new language tag to associate to that menu name in all languages (this language tag is how WebCenter refers to that menu name internally. It must be unique).
        3. In the dialog that opens at right, enter the translations of that menu name in all your WebCenter languages. You need to enter at least the English name.
Note:

Make sure your customizationConfig.xml file contains language tags for all the languages you use here (see Customize the Language Files).

If this is the case, your translations will automatically be added to your custom language files. If you didn't have a custom language file for one or more languages in which you add a translation here, these files will be created automatically.

Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a Simple Label (it will be shown as it is for all languages).

• If you want to use an existing WebCenter string (piece of user interface text) and its translations as menu name:

  1. Choose Existing Localized as Label Type.
  2. In Language Tag, enter the language tag that is associated with the string you want to use in your language files (in your custom language files if you have any, otherwise in your default language files).

    Tip: When you start typing a language tag, the Language Tag field shows all language tags starting with the characters you typed; you can select the desired one in the list.

  3. The dialog that opens at right shows the translations of that string in all your WebCenter languages.

    Note: You can edit those translations (click Edit and enter the new translations), but then they will be changed on every WebCenter page that uses that string.

b) To define who can see it:

Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu’s visibility to certain groups, select Groups and enter the names of the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You can see this example when hovering on the field.
c) To define where a user goes to when clicking it:

- If you want the (sub) menu to link to a specific page (within WebCenter or external):
  1. In **URL Type**, select **Provide URL**.
  2. In **URL**, enter or paste the URL of the page to link to.

- If you want it to show the results of a (global) saved search:
  1. In **URL Type**, select **Saved Search**.
  2. In **Saved Search**, select the global saved search you want to link to.

- If you want it to use it as a shortcut to create a Project with a specific characteristic:
  1. In **URL Type**, select **Create Project with Characteristic**.
  2. In **Characteristics**, select the characteristic you want to use for the Project.

- If you want it to use it as a shortcut to create a Project from a specific template:
  1. In **URL Type**, select **Create Project with Template**.
  2. In **Project Template**, select the template you want to use for the Project.

- If you want it to show a list of Projects that have a specific characteristic
  1. In **URL Type**, select **Project List with Characteristic**.
  2. In **Characteristics**, select the characteristic of the Projects you want to show.

**Note:** You can only select a Parent Menu when creating a new (sub) menu, not when editing an existing one.

3. Click **Save** at the bottom of the page.
Add a Custom (Sub) Menu Item

1. On the Menu Builder Canvas, click where you want to add your sub menu (if you want to add a top-level menu, you can click anywhere on the canvas).

2. In the Edit Menu area at the bottom, click Add Custom Menu.

3. Still in the Edit Menu area, define the properties of your (sub) menu:
   a) To define what the (sub) menu is called:
      • If you don’t want to translate the (sub) menu (it will have the same name in all languages):
        1. Choose Simple as Label Type.
        2. In Label, enter the name to give your (sub) menu.
      
      • If you want to define a new name in different languages:
        1. Choose New Localized as Label Type.
        2. In Language Tag, enter a new language tag to associate to that menu name in all languages (this language tag is how WebCenter refers to that menu name internally. It must be unique).
        3. In the dialog that opens at right, enter the translations of that menu name in all your WebCenter languages. You need to enter at least the English name.

        Note:
        Make sure your customizationConfig.xml file contains language tags for all the languages you use here (see Customize the Language Files).

        If this is the case, your translations will automatically be added to your custom language files. If you didn’t have a custom language file for one or more languages in which you add a translation here, these files will be created automatically.

        Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a Simple Label (it will be shown as it is for all languages).

      • If you want to use an existing WebCenter string (piece of user interface text) and its translations as menu name:
        1. Choose Existing Localized as Label Type.
        2. In Language Tag, enter the language tag that is associated with the string you want to use in your language files (in your custom language files if you have any, otherwise in your default language files).

        Tip: When you start typing a language tag, the Language Tag field shows all language tags starting with the characters you typed; you can select the desired one in the list.

        3. The dialog that opens at right shows the translations of that string in all your WebCenter languages.

        Note: You can edit those translations (click Edit and enter the new translations), but then they will be changed on every WebCenter page that uses that string.

   b) To define who can see it:
Edit the menu item to limit the visibility. Specify the **Visible To > In Groups** as **Specific Groups**.

If you want to limit the menu’s visibility to certain groups, select **Groups** and enter the names of the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You can see this example when hovering on the field.

c) To define where a user goes to when clicking it:

- If you want the (sub) menu to link to a specific page (within WebCenter or external):
  1. In **URL Type**, select **Provide URL**.
  2. In **URL**, enter or paste the URL of the page to link to.

- If you want it to show the results of a (global) saved search:
  1. In **URL Type**, select **Saved Search**.
  2. In **Saved Search**, select the global saved search you want to link to.

- If you want it to use it as a shortcut to create a Project with a specific characteristic:
  1. In **URL Type**, select **Create Project with Characteristic**.
  2. In **Characteristics**, select the characteristic you want to use for the Project.

- If you want it to use it as a shortcut to create a Project from a specific template:
  1. In **URL Type**, select **Create Project with Template**.
  2. In **Project Template**, select the template you want to use for the Project.

- If you want it to show a list of Projects that have a specific characteristic
1. In **URL Type**, select **Project List with Characteristic**.
2. In **Characteristics**, select the characteristic of the Projects you want to show.
   d) To define where to put it in the menu structure:
      - If you want this menu item to be a top-level menu, select **Top Menu** in **Parent Menu**. This will place it at the right of the Menu Builder Canvas, after all the other menus.
      
      **Tip:** You can re-order the menus by drag-and-dropping them.
      
      - If you want it to be under an existing menu item, select this existing menu item in **Parent Menu**.
      
      **Tip:** You can also re-order the sub-menus within a menu by drag-and-dropping them.

   **Note:** You can only select a **Parent Menu** when creating a new (sub) menu, not when editing an existing one.

   Click **Add** when you are done.

4. Click **Save** at the bottom of the page.

## Remove a (Sub) Menu Item

1. To remove a menu or sub menu item from your menu, select it in the **Menu Builder Canvas** and click the grey cross ☓ beside it.
2. Click **Save** at the bottom of the page.

### 4.6.2 Update a Custom Menu through the WebCenter User Interface

**Note:** You cannot edit the **Default** menu.

1. On the **Admin > Preferences > Menus** page, click the name of the menu you want to update.
2. On the **Edit Menu** page, edit your menu as desired (as explained in **Create a Custom Menu** on page 29).
3. Click **Save** at the bottom of the page when you are done editing the menu.

### 4.6.3 Create a Custom Project Details / Document Details Menu through the User Interface

You can create a custom menu item for **Project Details / Document Details** page. For example, you can create a menu item for adding a **Saved Search** using **SmartNames**.

You can also specify the visibility of this menu item for particular **groups** or for certain types of projects.

1. On the **Admin > Preferences > Menus** page, click **Add Menu**.
2. On the **Add Menu** page, enter a **Menu Name** and **Menu Description** for your new menu.
3. Click the type of menu you want to customize: **Project Details** or **Document Details**.

   In the menu builder, you will see all the menu items of a default **Project Details** or **Document Details** menu.

   On the left hand side, you can see the **Menu Gallery** containing the default menu items in bold, and the default sub menu items under them.

   On the right side, you can see the **Menu Builder Canvas** (which is a graphical representation of the menu). This reflects any changes you make.

   At the bottom, you can see and edit the details of the menu or sub menu item currently selected.

4. Edit the menu item. Select the **URL Type** as:

   - **Saved search** if you are configuring a **Saved Search** as the menu item. Select your search from the **Saved search** drop down list below.
   - **Attribute Category View** to configure a menu item with a specific attribute category view.

   Specify the **Name** as the attribute category view name.

   **Note:**

   The name entered here has to match the custom Attribute Category View name of the Attribute Category (of the current Project or Document).
Your users can edit the attribute values and save them from this custom view.

Note: From this Project Details attribute category view, the users cannot:

- change the attribute category.
- export or import the attribute category.

Read also Use Case: SmartName Search to find Related Projects on page 116.

5. Optionally:

You can assign a Project Details menu item for a certain group of Projects having a specific Characteristic. This allows you to create menu items (for example, dedicated Saved Searches) visible only in certain types of Projects.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics for your custom menu items as well as the default ones.
2. Create a Custom Project Details menu or select the default menu item to edit.
3. Select the specific Characteristic in the Project Visibility field. You can select this from the drop down list.
This menu item will appear in the Project Details page only if the specified Characteristic was assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.

6. Assign the menu to the user, group or company you created it for.

4.6.4 Create a Custom Menu Using XML

You can create a custom menu for each category of users, to make it more convenient for them.

Note:

Menus are XML files, so you can edit them using an XML editor (you can find various freeware XML editors on the internet, for example XML Marker or Notepad++).

See the WebCenter Customization Guide for more details on how to edit the XML files to create custom menus.

You will need to:

1. Determine which menus a particular group of users needs, and which menus they don’t need.
2. Download the default menu to use as a starting point (click the Download Menu link corresponding to the Default menu, then save it to a file when it opens in your browser).
3. In an XML editor, remove the menu items that are not necessary for those users.
   This allows you to simplify the WebCenter interface, especially for occasional users. For example, you can create a menu that only contains My Work for approval users.
4. Add custom menu items, to link to the WebCenter pages of your choice.
This allows you to make the pages most used by your users more accessible. For example, you can add menu items linking to saved searches, or to project creation from a specific project template.

5. When you are done editing the menu file, save it under a meaningful name.

6. Upload your custom menu:
   a) click the Menu Upload button on the Menus page
   b) on the Menu Upload page, browse to your XML file,
   c) give your custom menu a Name and a Description,
   d) click Upload.

7. Assign the menu to the user, group or company you created it for.

8. Log in to WebCenter as one of the users to which you gave the custom menu, and check whether the menu works.

### 4.6.5 Update a Custom Menu Using XML

To update a menu you have created:

1. On the Menus page, click the Download Menu link corresponding to the menu to update.
2. Edit it in an XML editor (see the WebCenter Customization Guide).
3. On the Menus page, click the Menu Update link corresponding to the menu to update.
4. On the Menu Update page:
   a) browse to the XML file you edited,
   b) change the menu’s Name and / or Description if necessary,
   c) click Update.
   This updates your custom menu.

**Note:** You cannot edit the Default menu.

### 4.6.6 Menu: Visibility Groups

You can decide the group visibility of a menu item present in the Main menu / Project Details / Document Details page.

For example, you can create a Project details menu item with a custom Saved Search using SmartNames and make it visible only to a particular group.

Follow the steps below:

- On the Admin > Preferences > Menus page, select the menu.
- Click the type of menu for which you want to edit the visibility: Main menu or Project Details or Document Details.

At the bottom, you can see and edit the details of the item currently selected.

- Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu’s visibility to certain groups, select Groups and enter the names of the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You can see this example when hovering on the field.
4.6.7 Customize the Project Details Menu Using Characteristics

You can assign a **Project Details** menu item for a certain group of **Projects** having a specific **Characteristic**. This allows you to create menu items (for example, dedicated Saved Searches) visible only in certain types of Projects.

1. **Create a specific Characteristic** for configuring a menu item. You can create characteristics for your custom menu items as well as the default ones.
2. **Create a Custom Project Details menu** or select the default menu item to edit.
3. Select the specific Characteristic in the **Project Visibility** field. You can select this from the drop down list.
This menu item will appear in the Project Details page only if the specified Characteristic was assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.
4.6.8 Delete a Custom Menu

To delete a custom menu:

1. On the Menus page, click the Delete Menu link corresponding to the menu to delete.
2. Click OK in the confirmation dialog.
3. If your menu is assigned to users and / or companies, you need to assign another menu to them.
   In the Menu Deletion page:
   a) Select the new menu to assign to them.

   Note: This will assign the same menu to all those users / companies. If you want them to have different menus, you need to edit the users / companies individually from the Users or Companies page.
   b) Click Delete.

4.7 My Work Preferences

The My Work preferences allow you to define what users can see on their My Work page.

Default and Custom My Work Pages

As an Admin, you define a default My Work page, that will be available to all WebCenter users. You can also define custom My Work pages for specific users or companies, when editing that user or company (see Create a User on page 125 and Create a New Company on page 122).

Users can then customize their personal My Work page to a certain extent, by adding or removing predefined sections (using My WebCenter > My Work Setup ).

Note that they can only add sections that you (as Admin) have made visible for their user role or group.

In the My Work preferences, you can:
- create a new My Work section (to use in the default or custom My Work pages),
- change what the default My Work page looks like.

4.7.1 About My Work Sections

A My Work page contains different Sections, displayed either on the Left Column or Right Column of the page.
Default My Work Sections

WebCenter has the following default sections, that you can use in the default and custom My Work pages:

<table>
<thead>
<tr>
<th>This section</th>
<th>will show...</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Approvals</td>
<td>a list of documents a user has to approve or reject.</td>
</tr>
<tr>
<td>My Recently Submitted Approvals</td>
<td>a list of documents a user has recently approved or rejected.</td>
</tr>
<tr>
<td>Approvals to Follow Up</td>
<td>a list of documents for which a user is Approval Master.</td>
</tr>
<tr>
<td>My Tasks</td>
<td>a list of tasks assigned to a user</td>
</tr>
<tr>
<td>My Recently Handled Tasks</td>
<td>a list of tasks a user has recently handled</td>
</tr>
</tbody>
</table>

Custom My Work Sections

You can create a My Work section from any html page. You can define which users will be able to see and use the sections you create, and you can even specify the height the section will take in the page. For details, see Create a My Work Section on page 43.

4.7.2 Create a My Work Section

To create a section to use in My Work pages, you need an html page, whose content will be shown in the section.

2. Click Create New My Work Section.
3. Give your new section a Name.
4. In the Type option, indicate if this section will show:
• an html page specifically designed for this purpose (Generic).

Note: Please contact Esko’s Professional Services if you require such a web page.

• a Saved Search (a search you have saved, see To Save a Search for more information),

• an External Web Page.

Note: We recommend you do not add WebCenter pages as My Work sections.

5. If you have chosen to show a saved search, select the Saved Search to show.

6. If you have chosen to show an external web page, enter or paste its address in the External Web Page field (for example: http://www.esko.com).

For saved searches and external web pages, the URL field is filled automatically by WebCenter.

7. If desired, you can change the height of the section.

To do this, add &h= followed by the desired height in pixels at the end of the URL. For example iframe.jsp?url=http://www.esko.com&h=400 has a height of 400 pixels.

WebCenter calculates the width automatically.

8. In Scope, choose which type of users will be able to use this section in their My Work page:

• All Users,
• Administrators,
• Project Managers.

Note: You can also change this for the default My Work sections.

9. You can use groups to further filter the users that will be able to see the section. In Role Groups, choose either:

• All Users if you want all users of the type specified in Scope to be able to use the section,
• Specific Groups if you want to restrict the section’s visibility to specific groups (within that user type).

In this case, select the groups which will able to use this section.

10. Click Create.

4.7.3 Edit the Default My Work Page


2. Click Default My Work Setup. The Default My Work Setup page appears.

3. In the Available Sections column, select a section to add and click either:

• Left Column >> to add it to the left column,
• Right Column >> to add it to the right column.
Do this for all the sections you want to add.

**Note:** To remove a section from the left or right column, select it and click ««.

4. If you don’t want the users to be able to click through to the Document Details or Project Details page from their My Work page, select Show Simplified My Work page.

5. Click Save to make changes.

### 4.8 WebCenter Reporting

A WebCenter **Report** is a document derived by querying the WebCenter database. It contains information of selected parameters in tables and also represented in Pie Chart and Bar Chart. WebCenter 12 is integrated with Jasper Reports, an open source reporting engine. Jasper reports allows creating reports which go well beyond what search results can do.

The report is created based on a report definition (template). The report definition is an XML file (.jrxml). The JasperReports scheme or a ZIP file containing this jrxml file, supports files such as images and style sheets. Report templates can be created in iReport, a free visual designer tool for JasperReports.

The WebCenter Reports feature can be accessed by an Admin or member of the ADMIN group.

Using WebCenter Reports, you have the:

- Ability to calculate averages and compare actuals to targets (KPI’s).
- Ability to create charts, such as Bar Chart and Pie Chart.
- Freedom on terminology, look, logo’s, amount of detail required to be displayed.
- Choice of report output to PDF, XML, XLS, CSV, TXT, RTF and XHTML.
- Ability to create one PDF with a general report and iterate over a set of sub-reports.

#### 4.8.1 Accessing WebCenter Reports

The WebCenter Reports feature can be accessed by an Admin or member of the ADMIN group.
1. Log in to WebCenter as an Admin user.
2. Click Admin > Preferences > Reports.
3. The Reports page appears with the list of available reports.
   This page displays the report name, report actions, report description, last modified and the user who uploaded the report (Creator). The Reports page also displays Upload Report, Download Report, Update Report and Delete Report buttons.
   **Note:** The built-in reports cannot be deleted.
4. Click the desired report name to go to report details page, where you can run the report.

### 4.8.2 Types of Reports Available

The WebCenter Reports comes with two default reports. The default reports have a typical WebCenter look. However the report definitions can be downloaded and changed in iReport to a different look.

**Note:** Reporting is a separate license in WebCenter. Without this license you can only run the default reports.

The default reports provided are as follows:

- **Approval Statistic (built-in)** report: This report is on duration of approvals. This report has lots of parameters to filter the report on customers, duration and influence on what is shown in the report and how it is displayed.

- **Task Management (built-in)** report: This report is on the duration of tasks. This report comes with many parameters, for example to filter on a task type (showing all CAD Design tasks and disregarding all other tasks).
You can also create a custom report using **iReport** tool. To create a new custom report, you can start from a blank template, use the template provided by Esko, or just modify the built-in reports. Upload these to WebCenter and then let WebCenter run the report. One report design is typically used over and over again, for example to create a weekly or monthly report.

**Note:** To learn how to create such reports, read the **CustomReport.doc** document.
4.8.3 Configuring a Report

To configure a WebCenter Report:

1. Click on the desired report name link on the Reports page.
2. In the Reports Details page that appears, specify the Report parameters.
   This can be very simple or very complex depending on the amount of parameters foreseen by
   the report design. Most often, the time span on which to calculate the report is a parameter. But
   equally so the report could accept a customer ID (a drop down of customers will be shown) or an
   option to show more or less detail or what type of charts to use.

   The mandatory fields (parameters) are marked by an *.
3. Under Report Output:
   a. Click the Upload Report to Project check box if you want to upload the generated report
directly to the required project folder. When it is not selected, the report is generated on the UI.
   b. Specify the report Document Name and output Format. By default PDF is the output format.

   Note: XHTML format is not available if the Upload Report to Project option is selected.
4. In Report is visible for groups, select or enter the name of the groups that can run this report.
   To remove a selected group, click the minus sign in front of its name.
5. In case the jxml defines projectId as a parameter (with uiTypeID set to PROJECT), an additional
   Project Report checkbox appears on the report details page. In case this option is enabled, this
   report will only be used as a project report.

   You can also set which roles in the project(s) can run this report (in addition to the groups you
   defined). This way it is possible to create a report that can only be run by the CSR or the SALES
   person but not by other people (for example suppliers and other external people).

   In Report is visible for roles, select or enter the name of the roles that can run this report. To
   remove a selected role, click the minus sign in front of its name.
6. Click the Save button, to save the parameters. The next time you want to run this report, you can
   use the same parameters. If you want to run the same report with two sets of saved parameters
   you need to upload the report definition twice.

4.8.4 Running a Report

To run a WebCenter Report:

1. Click on the desired report name link on the Reports page.
2. In the Reports Details page that appears, specify the Report parameters.
   This can be very simple or very complex depending on the amount of parameters foreseen by
   the report design. Most often, the time span on which to calculate the report is a parameter. But
   equally so the report could accept a customer ID (a drop down of customers will be shown) or an
   option to show more or less detail or what type of charts to use.

   The mandatory fields (parameters) are marked by an *.
3. Click the Run Now button. The report is generated as per your specification. The Report Successfully created message appears in the Reports Details page.

4.8.5 Managing Reports

The Reports page also helps you in managing the existing reports. You can Download Report, Update Report and a Delete Report.

Note: The built-in reports cannot be deleted.
5. CAD Options

Use the CAD menu to set options related to working with ArtiosCAD.

WebCenter allows you to:

- create a CAD document from a standard directly WebCenter
- view the CAD documents with folding angles in 3D
- view CAD documents in the Viewer
- search for CAD documents

5.1 CAD Download Format

**Synchronize with Defaults**

WebCenter administrators can download ArtiosCAD files in different formats as specified in **Defaults** of the ArtiosCAD instance running on the Application Server.

On the **CAD > CAD Download Formats** page, you can enable or disable download formats for all users.

Click the **Synchronize** button to import the settings from ArtiosCAD **Defaults**. A successful status message should appear after a few moments, and the list of formats is populated. Select the formats you want to make available for the users.

**Note:** The three native ArtiosCAD formats (ARD, MFG and ACD) do not require any configuration.

**Download formats and users**

User and group permissions for the download formats are set in **Users > select user > Download** and **Groups > select group > Download**, respectively. You must set permissions on the formats before users can download documents.

**Note:** Members of the Admins group are granted all download format permissions by default, and the Change and Use Group Permissions buttons are unavailable when attempting to change permissions for those users.

5.2 Boards

The **CAD > Boards** page shows the types of boards that can be used for CAD designs (paper, corrugated board, folding carton...).
These boards are defined in ArtiosCAD. They cannot be edited, created or deleted from WebCenter. However, you can set the boards' default location(s) and use them in a Restricted Set.

5.2.1 Assigning a Board to a Company or Location

You can assign a specific board to a Company, or a Location of that company.

1. In the CAD > Boards page, browse the Boards tree to find the board you are interested in.
2. Click that board to show the Edit Default Locations for board ... page.

   Note: You can only assign boards to companies/locations, not boards folders.

3. On that page, select the companies/locations to associate with this board, and click Finish.

   Tip: If you want to assign this board to all companies/locations, select the checkbox next to Company at the top.

The users in these companies/locations will see the board as default.

5.2.2 Creating a Boards Restricted Set

You can create a Restricted Set of boards, so that users can pick from a short list of relevant boards when creating a design.

To do this, click Create Boards in Restricted Set, then add boards to the Restricted Set as explained in Create a Restricted Set on page 152.

   Note: The data Type is always Text in a boards Restricted Set.

5.3 Run a CAD Standard from WebCenter

A CAD standard is a default ArtiosCAD document, to be customized with parameters supplied by the user to make a design. This will be a 2D design, that can be made 3D if the standard has fold information.

In WebCenter, an ARD document template is used as the CAD standard, and attributes are used as the parameters needed to make the design.

In practice, you create a new document from the ARD document template, filling in the template's attributes' values to give your parameters.

5.3.1 CAD Standard Configuration

You need to:

1. Set up an attribute category containing the attributes necessary to create the design, and their default values.
2. Set up a document template with this attribute category.
Create an Attribute Category

You will need to create attributes that match the CAD standard’s parameters in ArtiosCAD. They must have the same name as the corresponding parameters, and any parameter required in ArtiosCAD must translate into a Required attribute in WebCenter.

Generally, you will use at least BOARD (this is always Required), and mostly L (length), W (width) and D (depth).

BOARD parameter: Creating different board attributes will allow the usage of different board restricted sets. Attributes will be selected by WebCenter, if the name of the attribute starts with “BOARD”.

Other parameters are less standardized. You need the person who built the standard to clearly indicate which parameters are needed.

Here is an overview table of the attributes you will probably need the most:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Use case</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOARD</td>
<td>The type of board to use for the design. Used for every CAD standard (this is a Required attribute).</td>
<td>A Restricted Set of Text type. Set your desired values in the Restricted Set.</td>
</tr>
<tr>
<td>L, W and D</td>
<td>Length, Width and Depth. Used for most CAD standards.</td>
<td>Prompted values (the user can set what he/she wants) of Float type.</td>
</tr>
<tr>
<td>ISSTANDARD</td>
<td>To indicate if an ARD document template should be used to run CAD standards or not.</td>
<td>A Restricted Set of Text type. The values in the Restricted Set must be YES and NO.</td>
</tr>
<tr>
<td></td>
<td>• ARD document templates to be used for CAD standards should have YES as ISSTANDARD value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ARD document templates NOT to be used for CAD standards should have NO as ISSTANDARD value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This should be a Hidden attribute.</td>
<td></td>
</tr>
<tr>
<td>UNITS</td>
<td>To set units other than the user’s default units.</td>
<td>A Restricted Set of Text type. The values in the Restricted Set must be mm and in.</td>
</tr>
<tr>
<td></td>
<td>If no unit is set, the standard will be run in the units set in My WebCenter &gt; My Preferences by the user.</td>
<td></td>
</tr>
<tr>
<td>ISCORRUGATED</td>
<td>To indicate whether the resulting design should be corrugated.</td>
<td>A Restricted Set of Text type. The values in the Restricted Set must be true and false.</td>
</tr>
<tr>
<td></td>
<td>If this attribute is not present, the design is understood NOT to be corrugated.</td>
<td></td>
</tr>
</tbody>
</table>
1. Create the **Restricted Sets** needed by your attributes as listed in the table above.
   See *Create a Restricted Set* on page 152 for details.

2. Create your attributes (the ones listed in the table above as applicable, and any other attribute you may need to run your particular CAD standards).
   Assign the relevant Restricted Sets to your attributes. See *Create an Attribute* on page 154 for details.

3. **Create an attribute category** containing all the attributes you have just created.

4. **Add a Creation View** to your attribute category and click *Use Grid Layout*.
   a) Make the **BOARD** attribute **Required**.
   b) If you are using the **ISSTANDARD** attribute, make it **Hidden**.
   c) Change the **Visibility** of your other attributes as desired.

   **Tip:** You can add use a **Label** to change how your attributes appear to the user (for example, you can show the **L** attribute as **Length**).

If you want to work with several CAD standards, you can either reuse this attribute category for more designs, or create more attribute categories.

### Create an ARD Document Template

You now need to set up an ARD document template using the attribute category you just created.

For this, you need to use an ARD document corresponding to the CAD standard in ArtiosCAD (same default design).

1. Set up your **Document Library** as explained in *Create Document Templates* on page 64.
2. Upload your ARD file into the **Document Library**.
3. Link the attribute category you just created to this ARD file.
4. Point to the **Document Library** in:
   - existing projects in which you want to create a design from a CAD standard,
   - project templates that will be used to create projects with designs from CAD standards.

   See *Create Document Templates* on page 64 for details.

### 5.3.2 Run a Standard in an Existing Project

To create a design from a CAD standard in an existing project:

1. If your project isn’t already linked to the **Document Library**:
   a) In the **Project Details** page, click **Configure** then **Document Templates**.
   b) Select **Template**, then select your document library in the list.
c) Under When the document library contains ARD files..., select either:

- **Always run the ARD as a standard** if you want to be able to use any ARD document template in the document library to run a CAD standard,

- **Run the ARD as a standard when the IsStandard attribute is set to 1** if you only want to use some ARD document templates to run CAD standards.

These ARD document templates must have the ISSTANDARD attribute assigned, with the default value set to YES (see Create an Attribute Category on page 52).

d) Click **Save**.

2. Create a design from your ARD document template:
   a) Click the **Upload** button.
   b) Select **New** in the **Source** list and select your ARD document template.
   c) Fill in the **Attributes** as desired.
      
      For example, specify the **BOARD** to use, and the **L** (length), **W** (width) and **D** (depth) of the design.
   d) Click **Upload**.

Note: This is only possible through the normal WebCenter upload (see Upload via Upload Document and Upload Multiple Documents), not the Java applet upload or when uploading documents from other applications like Automation Engine and ArtiosCAD.

Your design is created. You can click its thumbnail to view it in the Viewer.

### 5.3.3 Run a Standard at Project Creation

To create a design from a CAD standard when creating a project from a project template:

1. If your project template isn’t already linked to the **Document Library**:
   a) In the **Project Details** page, click **Configure** then **Document Templates**.
   b) Select **Template**, then select your document library in the list.
   c) Under When the document library contains ARD files..., select either:
• **Always run the ARD as a standard** if you want to be able to use any ARD document template in the document library to run a CAD standard,

• **Run the ARD as a standard when the IsStandard attribute is set to 1** if you only want to use some ARD document templates to run CAD standards.

These ARD document templates must have the **ISSTANDARD** attribute assigned, with the default value set to **YES** (see *Create an Attribute Category* on page 52).

d) Click **Save**.

2. When **creating a project from your project template**:
   a) Click **New** in the **Documents** section of the **Create Project** page.
   b) Select your ARD document template from the pop-up and click **OK**.

   ![](image.png)

   **Tip:**
   If you have many ARD document templates, use the **Filter** field to filter them alphabetically on the file name.

   You can also filter them based on document characteristics if you have created a custom project creation page to do so (see *Create a Project and Run a CAD Standard* in the Customization Guide).

c) **Fill in the attributes to use in the** **Documents** **section.**
   For example, specify the **BOARD** to use, and the **L** (length), **W** (width) and **D** (depth) of the design.

d) Fill in the rest of the project settings as desired and click **Create Project**.

Your project containing your design is created.
5.4 Canvas related Attribute Categories

A document reference attribute and two attribute categories are created by default in WebCenter during the installation or upgrade.

These will create a document reference system to contain different Canvas parts saved to WebCenter:

- The default document reference attribute named as CANVAS PARTS.

- This default empty CANVAS REFERENCE CATEGORY. This category will contain the reference attributes associated with the CANVAS PARTS attribute.

- The default DEFAULT CANVAS CATEGORY will contain the the CANVAS PARTS. This allows the ArtiosCAD Enterprise client to save managed parts as individual document reference values.

Note:

During an update, these attributes will get created if they do not exist yet.
6. CHILI

You can edit your documents online using WebCenter - CHILI Publish integration.

6.1 Configure WebCenter-CHILI Server Connection

Administrator users can configure the CHILI server connection in the admin section under the 'CHILI' menu, 'CHILI Setup' item.

In this page, the following fields must be specified:

Address to the CHILI server example: http://chili01/CHILI/main.asmx
CHILI Share example: \chili01\chilishare
CHILI Environment name – name of the CHILI environment
User login/password – user login and password (defined within the CHILI environment)

When the admin user clicks at the 'Save' button, the configuration is stored in the WebCenter database.

6.2 Upload a CHILI Package

In the Document Types page, a new type “CHILI” will be added. This document type will only be visible if the right license is purchased.

A CHILI Package has the .zip extension. When uploading a zip file in the single document upload page, you will now get the possibility to select “CHILI Package” as Document Type. If you upload the CHILI package with the extension .chp, it will be automatically recognized as a CHILI package, without having to select it. However, this is not an official CHILI extension. It is a way to make the upload go easier (e.g. it can be used for multiple file upload).

6.3 Locking behavior

When a user is editing a CHILI document in the editor, the document will be locked automatically. The document can be unlocked only manually, by saving a new version or by just exiting the editor without saving your changes as a draft. When the editor is opened in read-only mode, however, the document will remain unlocked.

When a user has no editing rights and has no specific workspace assigned, the document will be opened in read-only mode. The editor will also be opened in read-only mode when the document is locked by another user or if it's not the latest version of the document. In the read-only mode, the file can still be viewed, but no changes can be made. The save buttons are not shown, but approval buttons will still be shown to approver if an approval cycle is ongoing.
The CHILI administrator is able to set up a customized read-only view. WebCenter will look for a workspace named “Read-Only” on the CHILI server. Only if that workspace is not found, the default CHILI read-only mode will be loaded.

Note: Draft versions are saved as long as the document is locked. When the document is unlocked, the draft version will be removed. To reset the document, the user can simply remove the lock and start the editor again. To save the changes permanently, the user will have to save the document as new version.

6.4 Download CHILI Documents

A user may want (or be allowed by the Administrator) to download different kinds of output of a CHILI document. Some will want to download the original CHILI package or the CHILI XML, while others want download a PDF file. An artwork creator will want the XML to update the master Illustrator document.

When the user wants to download a CHILI document, a page with the available formats will be shown. Users can have different permissions for different download formats. The ‘CHILI Package’ format is the default option in places where an explicit choice of a target Download Format is not available. If a user has none of the available Download Formats enabled for CHILI document type, he will not be able to download a CHILI document from within any Project.

The different download types are also supported in the SDK. A new parameter was introduced for the DownloadDocument.jsp SDK call

downloadtype: Name of the download format to download. If it is not specified, the default download type will be used.

Example:


NOTE: When a document is being edited (has a draft version), the downloaded version will not contain the changes of the draft.

Setup of different download types for a CHILI WCR Document

In order to maintain a highly secure environment – enabling/disabling CHILI Download Formats is only available for an Administrator user and is done for individual User/Group at a single moment. User settings can be derived from a sum of Groups Download settings for all the Groups that the User is a member of.

When a new Download Type is defined on the system level it is initially disabled for all Users and Groups in the system.

There are two levels of enabling or disabling CHILI download types. You can either do this system wide or per user/group.

If you want to disable or enable a download type system wide, you can go to the page “Admin > CHILI > CHILI Download Types”, where you have a checkbox with the available Download types. A default setup will have three download types pre-installed which are all enabled by default:

Chili Package
CHILI XML
PDF

For the PDF output, PDF Export Settings named 'Default' must be defined at the CHILI server. An additional column is displayed at the 'CHILI download types' page with the name and availability check (icon) of the PDF Export Settings at the CHILI server.

If you want to set it per user or group, go to the user or group section and click on the user/group you want to give download rights. Then go to the download tab. You will see that the section CHILI Package is added, where all download types that are enabled system wide can be enabled or disabled (disabled by default) for that user or group.

For a user, if you click on “Use Group Permissions”, the CHILI download types are also updated with those of the groups the user is in.

6.5 Dynamically assign workspaces and constraints to CHILI Documents

CHILI workspaces can be assigned dynamically by matching workspace names with role names. When a user is assigned to a role in the project the CHILI document is in, WebCenter will look if the CHILI server has a workspace with the name of that role and assign that workspace upon loading the editor. E.g. If the user has the roles “Approver and the CHILI server has a workspace “Approver”, the CHILI editor will be opened in workspace “Approver”.

If no workspace was assigned to the user, and that user has edit rights, WebCenter will look for the workspace name “Default” and assign it to the user. If the workspace “Default” was not found, the editor will open in real-only mode. If a user has multiple workspace/constraint matches, the user will have to select a workspace before the editor opens.

Note: For linked documents, the available workspaces are accumulated.

6.6 Loading Assets into the CHILI Editor

An asset is a WebCenter document that is uploaded in the project document library. At the Project/Template > Configure > Document Templates page, an administrator user can select a project or a template to serve as a document library.

For the CHILI document, documents from the document libraries of all projects the current document version is linked to can be used as assets. The documents/folders will be filtered out by the WebCenter security settings. In case of a project document library, the user must have download rights for the document/folder, to be able to use it as an asset. There are no restrictions on using documents from a template document library.

The external assets panel shows a tree structure, where each project/template represents a top level folder. For each document/asset a thumbnail is shown.

To set this up, the CHILI administrator has to add an "External Assets" panel within the workspace and leaves point the "Directory List URL” and "Asset List URL” to the WebCenter SDK with the following calls.

Directory List URL:
http(s)://<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDirectoryList.jsp;jsessionid=%qs_sessionid%%docversionid=%qs_docversionid%

Asset List URL:

http(s)://<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDocumentList.jsp;jsessionid=%qs_sessionid%?folderid=%id%&documentid=%qs_documentid%

Note: We don’t support "Search URL" and "Post URL" options. Note that these calls can also be used for image variables pointing to external assets.
7. Project Management for Administrators

Most Project Management tasks in WebCenter will be carried out by dedicated members with the Project Manager role.

However, Administrator users have some additional options: they can view and edit all Projects, create project and document Templates, and Find Locked Documents in the system, so they can reset them.

7.1 Projects

The Project Management page (Admin > Project Management > Projects) lets members of the Admins group manage all projects in WebCenter.

For more information about managing projects, see the WebCenter User Guide.

7.2 Project Templates

Members of the Admins group can create and configure project Templates. Those are pre-configured projects that Project Managers use to quickly and easily create new projects.

You can manage all project templates from WebCenter’s Templates Management page (Admin > Project Management > Templates).

- Click Create a new template in the header to create a new project template.

  **Note:** You can also save a project as a template.

- Click the name of an existing template to edit it.

- To delete a template, select it in the list and click Delete in the actions menu. Click OK to confirm the deletion.

  **Note:**

  If you try to delete a template with a custom document creation setting and if this template is being used by other projects / templates, you will get an error message.

  Go to the relevant projects/templates configuration tab and select another template before trying to delete.

7.2.1 Create a Template from Scratch

1. Click Admin > Project Management > Templates, then Create a new template.
2. In the Create a new template page, select Start from a Blank Template and click Continue.
3. Enter the Template Name and optionally a Description.
4. To use a custom thumbnail, select Specify New Thumbnail and Browse for it.
To use the default thumbnail, leave that choice selected.

5. Click Finish.

Your template is created. You can now define attributes, upload a document to the template, add project members...

### 7.2.2 Create a Template from a Project Template

1. Click Admin > Project Management > Templates, then Create a new template.
2. In the Create a new template page, select Use a Project Template and click Continue.
3. Select the Template to use and click Continue.

<table>
<thead>
<tr>
<th>Tip:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Use the filter to only show certain templates.</td>
</tr>
<tr>
<td>• Click a template to view its details in another window. Click Close Window to return to the Create a new template page when you are done looking at the template details.</td>
</tr>
</tbody>
</table>

4. Enter the Template Name and optionally a Description.

5. Choose the Thumbnail to use:
   - To use a new thumbnail, select Specify New Thumbnail and Browse for it.
   - To use the default thumbnail, leave that choice selected.
   - To keep the thumbnail of the project template you are using, select Use Template Thumbnail.

6. Click Finish.

Your template is created. You can now define attributes, upload a document to the template, add project members...

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The project template is created with the same folder structure, documents, characteristics, attributes, members, and security as in the original template.</td>
</tr>
<tr>
<td>Any documents in the template are copied into the new template as new standalone documents, even if they were linked documents in the template.</td>
</tr>
<tr>
<td>The list of Approval Users is copied if it is applicable; if there are conflicts, a warning appears and you will have to configure new approval settings.</td>
</tr>
</tbody>
</table>

### 7.2.3 Save a Project as a Template

1. Create the project as desired, or open an existing project.
2. On the Project Details page, click More actions... then Save as Template.
3. Enter the name of the template and a description in the appropriate fields.

   To use a custom thumbnail, click Specify New Thumbnail and enter the complete path and filename in the associated field or Browse for it. To use the default thumbnail, leave that choice selected.
4. Click Finish.

The template is created.

### 7.2.4 Changing What Users See When They Create a Project

It is possible to change the terminology used for project creation so that the Project Creation page talks about "Designs" instead of "Documents", or "Client" instead of "Customer", for example...

You can achieve this by customizing the terminology in the attribute category of the project or template used as a basis for project creation.

You need to:

1. Make an attribute category with **custom project creation terminology**.

   **Attention:** Your custom terms will not be automatically translated, and will show as you enter them for all languages in which you run WebCenter.

2. **Make a project template** (or a project that will be used to create other projects) using that attribute category.

Users creating projects from this project template will see your custom terminology on the Project Creation page.

### 7.3 Document Templates

As an Admin, you can create and configure **Document Templates**. These templates will serve as "dummy" documents (placeholders) that have a document type, file format, and attributes already specified. This information will be useful to real-life projects.

Those document templates will be used by Project Managers / other users to create **document placeholders** for future project documents.

For example:

1. You (the Admin) create a **Document Library** containing the document templates, and project templates referring to that document library (see *Create Document Templates* on page 64).

2. When creating a project from one of these project templates, the Project Manager will create placeholders from the document templates, to mark where the project deliverables should go.

3. When using the **Upload** function, a project member (with the **Add** right) can also create a placeholder from a document template, to indicate the characteristics (document type, file format, and attributes) of the final document to be uploaded.
7.3.1 Create Document Templates

1. Create a project template that will contain all your document templates (this will be your Document Library).

   Having all the document templates in one location makes them easier to manage, and saves disk space.

2. If desired, create a folder to contain your document templates.

   **Note:** If the project in which placeholders are created contains a folder with the same name, that folder will be used as default destination for the placeholders.

3. To create document templates:
   a) Upload a document of the right file format into the Document Library.
      You can use any document type (enabled in the Preferences) except Page Lists.
   b) Define attributes for your document template: choose an attribute category and fill in default attributes values.

      **Note:** This is important, as when users will create placeholders from this document template, the placeholders will have the attributes (and default values) you define here.
   c) Repeat for all document templates you want to create.

   **Tip:**
   - If you want a document template to always be used when creating placeholders of a certain file type, call it Default.<extension>, using the extension of that file type.
     For example, call it Default.pdf so it is always used when users create .pdf placeholders (in projects using document templates from the Document Library).
   - You can also create a generic document template called Default (without the extension), that will be used automatically for file types who don’t have a Default.<extension> template associated.
     For example if a user wants to create a .png placeholder but there is no Default.png document template in your Document Library, then the Default template will be used.

4. Create a project template for each kind of project that will be required by Project Managers.

5. In each of these project templates that need document templates, point to the Document Library:
   a) In the Project Details page, click Configure then Document Templates.
   b) Select Template, then select your document library in the list.
c) If your document library contains ARD files, and you want to use them to run ArtiosCAD standards, select either:

- **Always run the ARD as a standard** if you want to be able to use any ARD document template in the document library to run a CAD standard,

- **Run the ARD as a standard when the IsStandard attribute is set to 1** if you only want to use some ARD document templates to run CAD standards.

  These ARD document templates must have the **IsStandard** attribute assigned, with the default value set to 1.

  Select **Never run the ARD as a standard** if you are not working with CAD standards.

d) Click **Save**.

Projects created from one of those project templates will keep the project template’s link to the document library. Project Members can then create placeholders from the document templates in the document library.

**Note:**

If you know that the Project Managers will always use the same set of placeholders in all their projects, you can also:

1. Create a document library.
2. Add document templates to the document library.
3. In the document library’s **Project Details** page, go to **Configure > Document Templates**, and select your document library (itself) in the **Templates** list.

   This identifies it as the document library, containing the document templates.
4. Project Managers can create projects directly from the document library project template, and automatically have all the documents templates as placeholders in those projects.

   Note that this approach is less flexible!
7.4 Project Creation Settings

As an Admin user, you can configure the Project Creation Settings for a project or template. You can find these settings in the project or template’s Configure section, under Project Creation. These settings define what is displayed on the Project Creation Page when you create a new project from this project or template.

First of all, you can choose whether you want to Use Autonamic Naming and define the naming scheme.

Furthermore, you can choose what features are displayed on the Project Creation Page. You can choose the following options:

- **Set Project Manager**: Show/hide the project manager selection on the project creation page. If you hide it, the project manager will be the same as used in the template or parent project. If you choose to show this section, it will default to the person creating the project.
- **Set Status**: Show/hide the project status selection on the project creation page. If you hide the project status, the new project will be created using the first available active project status.
- **Set Customer**: Show/hide the customer selection. You can make this a required field. Hide this field to use the customer set in the source project or template.
- **Set Description**: Show/hide the description field. You can make this required.
- **Set Due Date**: Show/hide the due date selection. You can make this a required field.
- **Upload Documents**: Show/hide the documents section. You can make this section required, so that the project creator has to add at least one document.
- **Assign Roles**: Show/hide the role assignment section. You can decide for each role whether it is required to assign a group or user to it and/or whether you can assign multiple users or groups to this role.
- **Invite other members**: Show/hide the members section to enable/disble adding additional members to the project.
- **Set Attributes**: Show/hide the attributes section. You can show or hide the creation view of the project attributes of the source template or project.
- **Select Thumbnail**: Show/hide the project thumbnail section. If you hide this section, the thumbnail of the source project or template will be used.
- **Set Planning (Tasks)**: Show/hide the task planning section. You can make these fields required.
- **Default Planning Method**: You can set the default planning method to Forward or Backward. Even if the Set Planning section is not displayed, the setting you choose here will be used for the new project.

7.5 Document Creation Settings

As an Admin user, you can configure the Document Creation settings for a project or template. You can find these settings in the project or template’s Configure section, under the Document Creation tab.

- **Default**

  The default document creation options will be:
• **Browse**

• **Copy**

• **New** (when a template library is configured)

• **Another Template's Document Creation Setup**

  Use this to copy a setup from a template with a custom document creation set up.

• **Custom**

  When you select this, you will see a list of customizable options:

<table>
<thead>
<tr>
<th>Source</th>
<th>Where the document will be sourced from.</th>
</tr>
</thead>
</table>
| **Label** | The link description. You can create a custom label, such as *Upload a graphic file.*  
  • **Standard**  
  • **Simple**  
  • **Translated** |
| **Details** | Additional information such as:  
  • **Allowed Extensions**  
  • **Document Template Selector**  
    Here you can select the already specified document templates. *Document Templates* on page 63 |
| **Operation** | The operation depends upon the **Source** button. For example, if you have chosen **Project+Folder**, the operations would be Copy, Move or Link the document |
| **Sections** | The configured upload source is made available in these sections. By default, all the options will be available and enabled. You can deselect the sections to disable some of the locations. |
| **Target Folder** | The destination folder |

To add a new source type, click **Add Document Source**. The document sources in the list can be deleted by clicking the minus icon.
If you want to delete a template with a custom document creation setting, make sure that it is not being used by other projects/templates for document creation. If it is being used, you have to select another template in the relevant projects/templates before attempting deletion.

7.5.1 Uploading documents in project creation

When a project manager creates a project based on a template or an existing project, the document creation options as defined in the template are used to build the links in the Documents section and Bill Of Materials section.

The default values are Browse and Copy.

You can also have a template with a custom document creation set up. In this setup,

- For each row in the configuration, a link is added to the document section in the same order as in the configuration.
- Depending on the checked options in the Section column, the link may be added to:
  - the Project Creation Documents
  - the Project Creation Bill of Materials
  - Bill of Materials
  - Upload (Copy or Create Multiple Documents)
Note:
The label of the link is taken from the configuration. If the label is a tag that is found in the language file, the translated label is shown.

You can have links as:

- **Browse**: A new line is added to the document section where the user can upload the file.

- **Project + Folder**: The user can select a project and a document in that project. Depending on the operation, the document will be copied, moved or linked into the project. If a target folder is set up, the document will end up in that target folder if the user has upload rights to that folder.

If a document that belongs to more than one project is moved, the document will be deleted from all the source projects before moving into the current project.

The project manager can rename the document if needed.

- **Document Templates**

  If there is document library associated with a template, the link corresponding to the document template will be added in the project. You can choose a document from the template by clicking on the link.

  A new document will be created in the project from the template and can be renamed. The attribute category of the document from the template will be the same as before.

- **Saved Search**:

  Use this option to allow the user to select a file from a saved search. Click the given link to see a dialog with saved search results. All the filter options configured in the saved search will be available.

  Select one or more documents and click on the configured action. Depending on the setup, a document will be copied, linked or moved.

### 7.6 Document Types

As an Admin user, you can configure the **Document Types** for a project or template. You can find these settings in the project or template’s **Configure** section, under **DocumentTypes**. These settings define what happens when you add documents to your project.

The settings are organized per **Document Type**. Per type you can set the following options:

- **Automatic Document Naming**: Use this setting to enable/disable autonaming for a specific document type. Choose **None** to disable autonaming. Choose **Default** to use the system wide autonaming settings or choose **Custom** to enter a specific naming scheme for this project or template.

- **Default Attribute Category**: Use this setting to assign an attribute category to a specific document type. Choose **None** to not use a default attribute category. Choose **Default** to use the system wide settings or choose **Custom** to select a specific attribute category.

- **Start Task for new Documents**: Use this setting to start a task of the specified type when adding a document to the project. The task is automatically started, assigned to the uploader and the
uploaded file is linked to the task. Choose None to not start a task upon upload. Choose Default to use the system wide settings or choose Custom to select a specific task type.

- **Start Task for new Versions**: Use this setting to start a task of the specified type when adding a new versions of a document to the project. Choose None to not start a task upon upload. Choose Default to use the system wide settings or choose Custom to select a specific task type.

7.7 Create Project Thumbnails Automatically from Documents

As an administrator, you can configure a setup to create automatic thumbnails from the document images.

When a new graphics or CHILI document is being uploaded to a Project or Template, the user will have an option to check if the document image needs to be taken as the Project Thumbnail.

If this option is checked, the Project thumbnail will be set as the document image after checking and registering.

1. Create a text Attribute called Make Project Thumbnail.
2. Set Values to Restricted Set.
   - Create the check box by entering yes and no as values of the restricted set. The values are case sensitive.
3. Create an Attribute Category with the Make Project Thumbnail attribute.
4. Create Project Template s.
5. Go to Configure > Document Types.
6. Specify the Default Attribute Category as the Project thumbnail Attribute category for desired document types.
   - The user has to select Make project thumbnail during the upload of documents to use this feature.

7.8 Project Statuses

The Project Status feature allows you to review the current project standing. This feature can be accessed by an ADMIN or a member of the ADMIN group, Project Managers and an User.

An administrator can add statuses in WebCenter. This works similar to task statuses (whereas the statuses are not shared). A status has a name, an icon and a type. The types are Not-active, Active and Completed. The WebCenter has the functionality to limit the actions possible in not-active and completed projects. It is most typical to add active statuses, for example: Briefing, Design, Prepress, Printing. An administrator can limit the statuses for a project and this can be done for every project separately.
The Project Manager can perform following:

- Set the Project Status.
- View Project Status.
- Search Project Status and Filter projects based on Project Status.

The Project Status will appear as follows when a specific project is selected:

An administrator can limit the statuses for a project and this can be done for every project separately. Go to a project or a template as an administrator and click on the **Configure** tab. By using Add Project Statuses and Remove Project statuses (select with the check boxes and take remove from the action drop down), you can get a specific set of statuses.
The administrator can decide the sequence of the statuses. This sequence is purely used for sorting. When the projects are sorted based on Project Status, this is the sequence used. The sequence is system wide.

Apart from showing the Project Status in many project overview pages (and also in the search results), the project statuses can be used in the Workflows. For example: To decide different operations or assignees depending on the current project status.

**Note:** By using the **Set Project Status** node in Workflow, you can set the status for the current project.

In the following example, let us consider six toll gate statuses to be allowed for the HADW556 project. The Project Statuses are set as TG0, TG1, TG2, TG3, TG4 and TG5. The WebCenter has many more statuses, but only these statuses are allowed for this project. The TG0 to TG5 statuses are in this sequence in the entire system.

**Note:** You can only decide per project whether you can have these statuses, but you cannot change the sequence of the statuses per project.

### 7.8.1 Viewing a List of Project Statuses

The available Project Status can be viewed in the Project Status page. In the Project Status page, you can add, edit and delete the Project Status. You can also choose or add an icon, a color for the Project Status and decide the sequence of the statuses.

1. Click **Admin > Project Management > Project Status**. The Project Status page appears.
7.8.2 Adding a Project Status

You can add a new Project Status through the Project Status page. You can also choose or add an icon, a color for Project Status and decide the sequence of the statuses.

1. Click the Add Status link on the Project Status page.

2. In the New Status page, type the Name of the status and select the Project Status type.

You can add multiple statuses at a time. When the new status is marked as Active, it is added just behind the previous active status. When the new status is marked as Non Active or Completed, it is added at the end of the Project Statuses list with no rules applied.
3. Click the **Save** button to make changes. The Project Status page appears with the new status.

**Note:** The new status will get a default color and no icon added to it. This can be changed in Project Status page.

### 7.8.3 Editing a Project Status

You can edit the existing or newly added Project Statuses through the **Project Status** page. In the Project Status page, you can change the Name, Language key, Sequence number, Add Icon and Set Color.
Type the sequence number in the **Display Order** column to change the sequence number. The change in sequence number appears only after saving the changes. For example: If the Display order is changed for **thinking phase2** status from 4 to 2 then it appears as follows.

![Table showing project statuses with Display Order and Language Key columns]

The language string key has to be added to the XML formatted language key file (wcstrings_<2 character ISO language code>.xml for English: wcstrings_en.xml) for all used languages. By default the language (en) has to be added.

**Note:** The language key field is not mandatory. If you want all languages to follow the same names (Not translated stage names), you leave the language key field empty.

Type the **Name** of the Project Status to change the Project Status name and click the **Save** to make changes.
The new status will be set to Esko Green as default color. You can select a **Color** for a dropdown for each project status. This color will be used in the calendar-view of the project overview.

**Note:** You cannot add your own new color.

For Example: The Thinking Phase 2 has Esko Green as the default color.

Once you select the required color from the drop down list, click the **Save** button to make changes. Here, the Color is changed to Red.

You can change an icon for the existing Project Status in the Project Status page. The Project Status icon can selected from the Icon Gallery or you can also upload an icon. WebCenter allows JPG, JPEG, GIF, BMP and PNG files types as icons.

**Note:** The UI is optimized for an icon height of 16 pixels. Icons will be placed in overviews without any scaling.

Click the **Select Icon** button, to select the required icon from **Icon Gallery**.
In the **Icon Gallery** window, select an icon via the radio button and click the **OK** button. The gallery allows filtering of icons by its name.

Click the **Browse** button to upload a icon of your choice. The icon can be re-used for other statuses.

**Note:** You can change the icon of the built-in Project Statuses. When no icon is set, the name of the status is used instead.

### 7.8.4 Deleting a Project Status

You can delete a Project Status and this status will be marked as deleted/obsolete in the WebCenter database. When a project status is marked as deleted, it will no longer appear in any of the locations where a Project status can be selected. The Projects and Templates having the deleted status will still keep this status. You can however no longer change projects to the deleted status.
Select the required Project Status and click on **Delete** in the **Actions** menu. Click the **OK** button to confirm the deletion.

### 7.8.5 Customizing a Project Status

An Administrator can set allowed statuses for Templates or for Projects. By doing this an Administrator can limit the number of Project Statuses to be used for a specific project. When adding a new project status to the system, this status will be also added to all projects and templates. When a project is created from a template or from another project, it inherits the allowed statuses from its source. This happens only once and does not happen when the template changes later.

1. Log in to WebCenter as an Admin user.
2. Click the **Admin > Project Management** and select **Projects** or **Templates**.
3. Click the required Project or Template link from the list.
4. Click the **Configure > Project Statuses**. This displays a table with the current allowed statuses for this Template or Project.
5. Select the required Project Status from the list and then click the **Add Project Statuses** link.

**Note:** By default a blank Project will get the list of all statuses as allowed statuses.

6. Click the **Save** button to make changes.

**Note:** The Project Status cannot be re-ordered here, the order is inherited from the system order.

You can remove allowed statuses for a template or project by selecting the status and select **Remove** from the **Actions** menu.

### 7.8.6 Searching based a Project Status

You can search for projects based on their Project Status. Choose **Search** from the menu bar and select Project or Tasks. On the (advanced) Project Search page and the Task Search page, the list box will contain the list of all the Project Statuses.

In addition to all individual project statuses, the list also contains the following:

- Show All (default): show all projects (or tasks of all projects).
- Show All Active: show only projects or tasks of projects with an active status.
- Show All Not Active: show only projects or tasks of projects with a non-active status.
- Show All Completed.
7.8.7 Filtering based on Project Status

In Favorite Projects, Projects I Manage, and in Projects I am Invited to, you can filter on all Project Statuses individually. You can also use the filters to look for a combination of statuses: Show All, Show All Active, Show All Not Active, Show All Completed.

7.8.8 Setting a Project Status to Active or Non Active

An Administrator can set a project to Active by giving it an Active status. Whether a status is active or not is determined when the status is added.

If a project has been set to a Non Active status, by default the permissions for all members are masked with the View and Download permissions, so that these two permissions are still enabled if and only if they were enabled already, while all other permissions are disabled.

However, whether certain actions can still be performed in non-active projects, also depends on the security settings for the system. An Admin user can change these settings on the Security page (Preferences > Security). It is possible to allow or disallow changing attributes, changing members and document operations in inactive projects.

7.9 Find and Unlock Locked Documents

Locked documents are documents that users have downloaded and are working on, and want to flag to prevent others from working on them.
The Admin user (or any member of the Admins group) can find locked documents belonging to all users and unlock them so that others may work on them without receiving warnings that they are locked.

This is particularly useful for freeing up documents that have been locked by users who are absent for longer periods of time, or who have left the project entirely.

1. Click **Admin > Project Management > Find Locked Documents**.
2. Either filter for users by entering (part of) their last name in the **Search users by last name** field, or click **Go** right away to see all locked documents.
3. Select the document(s) to unlock by selecting the corresponding boxes.
4. Click **Unlock checked items**.

### 7.10 Delete View Files

View files (that make files viewable in the WebCenter Viewer) take a certain amount of disk space. If necessary, Admin users can delete those view files.

**Note:** You can only delete view files per project (for all of the project’s documents at once), not per document.

1. Use the **Search** to find the projects whose view files you want to delete.
2. Select the projects whose view files you want to delete, and click **Delete View Files** in the actions menu (🗑️).

   Confirm your choice by clicking **OK**.

   **Note:** When deleting view files, Viewer annotations, document metadata and thumbnails are kept.

You can see that the view files have been deleted on each document’s **Documents Details** page.

### 7.10.1 Regenerate View Files

Users can regenerate documents’ view files as needed provided that:

- they have the **View** permission on those documents,
- those documents’ view files can be regenerated.

**Note:**

Most view files can be regenerated, except for:

- page lists coming from Automation Engine,
- documents uploaded via Automation Engine with the **Upload only view files** option.
If you need to regenerate the view files:

1. Go into the project whose view files you deleted.
2. Select the documents for which you want to regenerate view files.
3. Click View and Annotate in the actions menu.
8. Advanced Search Setups in WebCenter

Concept definition.

8.1 Search enhancement

There are advanced search features using which you can design and create dedicated search pages. You can:

- Save a **Search** with advanced settings.
- Find assets which were stored in WebCenter with certain **attributes** or with a certain project criteria. This will help you to:
  - Find, collect and download pictures for a certain product line. You can also send these as **download links**
  - Search according to criteria to find required Packaging types: for example Carton Boxes.
  - Search based on **Project Statuses**. For example, you can find all projects with a status **Initial design**.
  - Perform bulk operations.
  - Refine **Search Results** using a search parameter panel. Using this, users can limit the list of items to be searched.
  - Define the sequence of columns in results
  - Create dedicated **Global Saved Searches** for Users. This will help in removing advanced Search functionality for some users and to determine what User gets to access. You can customize these as **Asset Browsers** which can be incorporated into the menu.

- Create Saved Searches with Calendar View

8.2 Creating Advanced Saved Searches

Normal and keyword searches may be saved for future use.

To access saved searches, click **Search > Saved Searches**. Shown below is a sample Saved Searches page.
Searches can be saved as:

- a **Personal** search visible only to the individual user.
- a **Global** search visible to all WebCenter users.

**Note:** Only an Administrators can save a search as a Global Search.

You can create global searches visible only to certain companies or groups. Some searches will be used by several groups such as Designer groups. Use this option to securely create dedicated searches to groups and companies without making them accessible to every WebCenter user.

- To execute a saved search, simply click its name from the saved searches page.
- To edit a saved search, click **Edit Search**.
- To create global saved searches dedicated to a company or group, click **Edit Visibility** link. In the next window, select the groups / companies to whom you want to give the exclusive visibility. In this case, if you assign the visibility to a group and a company location, the search will be visible to either the group or the company or both.

**Note:** It is not possible to set visibility on personal saved searches.

If you select a company without specifying any of its locations, all the company locations will be able to access the saved search.

If you remove the company / location / group, the visibility settings will be modified.
• To delete saved searches, select them and click **Delete checked items**. Use **Select All** and **Delete checked items** to delete all of them.

### 8.2.1 Search Panel Design

The saved searches can be setup for Projects, Documents and Tasks. These saved searches can be edited by an administrator. The administrator decides for each saved search (and for each operation) whether these operations are allowed or not.

All users can design searches via the advanced search panel. However, administrators get an extra check box **Search Panel Design**.

To edit a saved search:

1. Click **Search > Saved Searches**. The **Saved Searches** page appears.
2. Click the **Edit Search** link against the required saved search.
3. Select the **Search Panel Design** check box. The **Visibility**, **Label**, **Row** and **Column**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>Determines whether the criterion will appear in the saved search top panel. The available values are Hidden, Available and Visible.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Label</td>
<td>A label is the name of the criteria as it needs to appear. A label can be given regardless of the setting of visibility. The label will automatically applied to the column header in list layout and will be visible in grid layout too. If the field is left empty then, the label will be the same as the criteria and not different to other localized languages.</td>
</tr>
<tr>
<td>Row and Column</td>
<td>Position where the criteria will appear. Row and column are filled in automatically but can be changed by the user. The second criteria can have the same values for row and column. For example: If the Project Name criteria has the value Row 1 and column is 2, the criteria will appear in column two of the UI.</td>
</tr>
</tbody>
</table>

For example; when the **Visibility** is set to **Visible** for Document Name, Version Author, Author location, Description, Modified and Approval Status.

The following will be the result of Search Panel. The Document Name, Version Author, Author location, Description, Modified and Approval Status appears on the top of the search results panel.
8.2.2 Setting Search Result Layout Options

Using **Show Result Layout Options** an administrator can simplify the User Interface (UI).

This way an administrator has the ability to:

- Remove the links to Hide Thumbnail, Show as Grid and also Save Search Results.
- Display the project status as text, icon or both.
- Allow Changing Attribute Category, where-in the Change Attribute Category will show up in the actions drop-down.
- Display Labels in grid layout.
- Determine which cascading drop-downs will appear as a tree to the left of the search results.
You have an additional option **Show Cart**, in **Search > Documents**.

Using **Show Cart** the search result will show an area with the documents in the cart and also display the thumbnails including document name. The document added in the cart appears when you select
the Show Cart check box. You can also download and create a project or select the documents to remove them from the cart.

**Note:** The existing function Add to Cart allows you to add documents to the cart.

### 8.2.3 Document Operations in Search

You can configure standard Document Operations in the document Search Results page. For example, from this page, you can send download links for the selected documents.

Your users will be able to use the following operations from the Search Results page:

- **View**
- **Open in ArtiosCAD**
- **Download**
- **Define Document Attributes**
- **Approval Info**
- **Mail Download Link**
To do this:
- go to Search > Documents.
- click on the Show Result Layout Options link. Select the document operations.

By default, the following operations will be selected for you:
- View
- Open in ArtiosCAD
- Download
- Define Document Attributes
- More actions

Note: You can configure the document operations for:
- Document Search Results
- Saved Searches used in custom project/document menu items
- Saved search based My Work page

The document operations will not work in the Saved Searches used as document sources in project creation and document references.

### 8.2.4 Show Additional Project Search Criteria

You can use the Show Additional Project Search Criteria option as a advanced search for Documents and Tasks in saved searches.
After selecting **Show Project Search Criteria** option, the following option appears:

Using these you can search on project features when searching for documents and tasks. Any of the project property or attribute can be used as a search criterion for document searching and for task
searching. For example, you can search for the tasks in projects of a certain customer and what is the progress or currently going on for a customer.

**8.2.5 Define search result columns**

You can define which needs to be displayed for each search result. By entering numbers, you can change the sequence of the columns or the sequence of the information in the grid cells.

**Note:** When you enter an existing number, all others shift to upward numbers.

In case of list layout, this information will be displayed in columns.

In case of grid layout, this information will be displayed in each cell either below the thumbnail or to the right of the thumbnail.
8.2.6 Set attribute value on a search result

The administrator can set the attribute columns to be editable when you run a search. By this, the user can then select a number of projects or documents (depending on the type of search).

The administrator needs to determine what columns can be edited. This is done in the Search definition panel. The column is editable under Search Results Options and is only visible when the Search Panel Design check box is checked.
In the above example, the administrator has selected **Trademark** and **Brand** attributes to be editable. When you save and run the search, the attribute columns which are set editable will appear with a pencil icon.

By clicking on the pencil icon, you can select a number of projects or documents. A dialog box appears asking for a value. These values adapt to the type of the attribute. When the value is
provided and Start is clicked. The dialog box gives feedback about the progress and success of the operation.

![Set Attribute dialog box](image)

**Note:** When the attribute could not be set on a project or document, the feedback shows a failure icon and gives the reason (No permission to set attribute, project is non-active, etc).

By clicking on Advanced, the dialog changes to accept different values for each project or document.

![Set Attribute dialog box](image)

**Note:** Here, failure happens per item. So when selecting 20 items and the first fails, the rest is still attempted.

### 8.2.7 Sorting Search Results

You can sort the search results in the List / Grid view based on sort-enabled search columns.
In the List Layout:

You can click on the primary sort field header ▲ / ▼ to switch between ascending and descending. All the other sortable fields will have the sort icon ▼ next to their header text.

To change the primary sort field, click on the sort ▼ icon next to it.

• Up arrow ▲ in the column header indicates that the results are sorted on this field in ascending order. To sort the results in the reverse order, click ▼.

• Down arrow ▼ indicates that results are sorted on this field in descending order. To reverse the order, click ▲.

In the Grid Layout:

If the search results are in the grid layout, you will see a drop down with sortable fields instead of the sort icons.

For example, sorting by Name / Reversed Name will make the name field in the ascending or descending order.

Note:
The configured sort fields will be applicable in both the grid and list layouts.

8.3 Asset Browser

Asset browser is a user-friendly feature to search and find assets in a large collection of WebCenter assets. You can customize the Asset Browser into the WebCenter Menu for easy access. In addition, you can create more than one Asset Browsers in the same WebCenter with different names for different sets of users for easy browsing.

For example, a project manager can benefit from an Asset Browser which will collect Project Templates and a printer will benefit from one that points to finished Projects which are ready to be printed.

You can create a menu item which can be named “Assets” or “Repository” or simply “Search” or “Browse”. This menu will be linked to a highly configured Global Saved Search which will function as your Asset Browser. One Asset Browser can be linked to one Attribute Category as in saved searches. However, this Attribute Category can have multiple Cascading Dropdowns resulting in
multiple independent trees in the same asset browser. Read more in about Saving Searches as Asset Browser in Setting Up an Asset Browser on page 97.

A customized graphical Asset Browser will help you to visually browse through projects and graphical assets previously stored in WebCenter. To achieve this, you need to classify assets using custom attributes with graphical icons (Attribute Value Images). Read more about graphical labeling of attributes in Setting Up a Graphical Asset Browser on page 102.

You can set up a graphical browser or a tree browser and both. Technically, the Asset Browser has all the features of Saved searches which is enhanced with Tree and Graphical browsing through Cascading Attributes. Read more about Cascading Attributes in Cascading Dropdowns on page 183.

### 8.3.1 What You Need to Know about Asset Browsing

**Concepts Used in this Section**

<table>
<thead>
<tr>
<th>Concept</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Any digital file including pictures, graphics (PDF, Illustrator, ...) and Office documents stored in the WebCenter. For example a piece of packaging design that is uploaded to WebCenter.</td>
</tr>
<tr>
<td>Asset Browser</td>
<td>A user-friendly way to find assets in a large repository. Read more in Asset Browser on page 95</td>
</tr>
</tbody>
</table>
| Repository            | A part of WebCenter which is considered to contain assets. WebCenter as a whole is a repository but by filtering you can pin-point to the specific section of the repository. You can achieve this by filtering on:  
  - certain document types  
  - range of projects based on project characteristics or naming conventions  
  - both documents and project range. |
| Saved Search          | Highly configurable Saved Searches from WebCenter 12 onwards. Read more in the following sections from the WebCenter User Guide. Search enhancement on page 82 |
| Tree browser          | This tree is built based on your Cascading Attributes which you can put in the left panel to browse through the assets.                      |
| Search Parameter Panel| A panel appearing at the top of the search results of Asset Browser which you can use to further refine your search.                      |
Organizing Assets in WebCenter

You can use the Asset Browser to its full extent by organizing Assets in WebCenter. You can upload the assets in bulk during the early stage of the WebCenter deployment which will grow with new designs and documents. For conducting effective search via an asset browser, you need to specify Attributes (metadata) for your assets while uploading them to WebCenter. You need to:

- define Attributes.
- assign those attributes to Attribute Categories
- assign the right attributes from this Attribute Category to the assets(documents) while uploading.

From WebCenter 12 onwards, you can assign these Attribute categories automatically to uploaded documents. This is done by:

- using default Attribute Categories using Document Types.
- using document templates with Attribute categories

Read more about this in Using Autoname Generation on page 270

When you store assets in specific projects you should ideally:

- have at least one project template created for projects specifically meant to store assets. This helps in setting up Security, Roles, Autonames and default Attribute Categories which will aid in better organization.
- not store too many documents in one WebCenter Project. Since Projects only have one level of folders, project browsing gets slow when there are too many documents or too many folders in the project. Asset Browsing will be easier when they are stored with pre-determined metadata in a set of projects.

Note: You do not have to specifically create “asset projects”. It is possible to design an Asset Browser for entire WebCenter site.

8.3.2 Creating Asset Browsers

Setting Up an Asset Browser

1. Save a Search using your own search settings.
   
   **Asset Browser** is essentially a highly configured Saved Document Search. Therefore, the features of Saved Searches are available in the Asset Browser. You can

   - set the Saved search to be Global or Personal as an administrator.

   **Note:** You should use the Global setting for Asset Browsers. Personal searches does not serve the Asset Browsing function since they can only be used by admins who create them.

   - filter on almost any property or attribute of documents in advanced ways.
   - define a drill-down (parameter) panel to appear at the top of the search results
• assign the saved search to a menu item
• assign which document properties or attributes will be displayed in the search results and in what sequence.
• set the sorting order of the results
• Set a preference on how many search results will appear per search result page.
• Define what operations can be done in the saved search results
• Define layout settings of the search results (grid versus list, number of results, thumbnails or no thumbnails, …)

Read more in the following sections from the WebCenter User Guide. Search enhancement on page 82

To Save a Search
To Search Content

2. Add Cascading Attributes to the Saved Search. You need to follow the steps below.
   a) Log in as an administrator
   b) Import Cascading Attributes. Read more in Installing Cascading Dropdowns from Excel Sheet on page 190. Create an attribute category with these Cascading attributes with which you want to customize browsing and displaying.
   c) Go to Search > Saved Searches. Choose and edit the Saved Search from the previous step. If you did not save the Search, go to Search > Documents and restore the previous settings (within the same session) or start over.
   d) Click on the Attributes link. Add the Attributes from the Attribute Category that you want to assign to this search.

   Note: Only the Cascading attributes from the Attribute Category are available for tree browsing in Asset Browser.

   : Avoid Using the same Attribute in different lists used in the same Asset Browser as it leads to unpredictable results.

   e) Enable Search Panel Design. In the Search Panel Design, you should set these attributes to be Visible/Available

   Tip: The tree view in the Asset Browser requires the attributes to be set to Visible or Available in the Search Panel Design.

You will have a top panel with Visible/Available Attributes to refine the search. Selecting a value for one Attribute will limit the values for other Attributes.

   Note: If the Attributes appear but not as dropdowns, check whether the Attribute Category is correctly configured. Assign it to a document to test whether the cascading effect works.

3. Create a Browsing Tree using Cascading Dropdowns.

   A cascading attribute can be shown as a tree or as a set of mutually dependant attribute dropdowns where choice of one from a dropdown limits the choice available in other dropdowns.
You can choose from any of these two options or both views together. Read below some remarks about these options.

- The tree view takes more space and loads slower
- The tree view allows multiple selection
- The tree view can be restricted using the depth parameter
- Dropdowns in the top panel can also be restricted
- The tree view can be shown in a graphic way (using thumbnails). This takes even more space on the screen but creates a beautiful user experience provided you have good image representations.

a) Go to Search > Saved Searches. Choose and edit the Saved Search from Step 1. If you did not save the Search, go to Search > Documents and restore the previous settings (within the same session) or start with a new Search.
b) Click on **Show Result Layout Options**. This opens a panel with additional options.

![Show Result Layout Options panel](image)

- **Lists to be shown in left tree panel**
- **Add List**
- **Search**
- **Other display options**

**Note:** You can add lists to the tree panel by clicking on **Add List** or remove them by clicking on the – icon. Use the arrows in the second column to move the lists up or down.

c) Enter the list names that you have configured in `custom\excel\lists.xml`.

d) Set the properties for each list. These properties are applicable when a left tree panel is selected.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Depth</strong></td>
<td>If you leave it empty, all the columns from lists.xml will be available. If you need four columns out of five columns from your lists.xml, enter 4</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>You can set a maximum height for the tree here. If you leave it empty, the tree will take as much space as it requires. If the tree height is bigger than your entry in this setting, a scroll bar will appear.</td>
</tr>
</tbody>
</table>
e) Set the browsing style for Tree browsing and Image browsing by modifying the following fields.

<table>
<thead>
<tr>
<th>Tree panel width</th>
<th>Default Tree panel width is 300 pixels which you can increase or decrease depending on your requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Area Style</td>
<td>For a browsing tree at the left hand side, choose <strong>Left panel only (no images)</strong></td>
</tr>
</tbody>
</table>

4. Save/Run this search.

If you have save it as a global saved search, all WebCenter users can run this asset browser from their saved search lists or from the menu if you have customized a menu item for this Asset Browser.

**Note:** You can restrict access to the Asset Browser by:

- deleting **Saved Searches** item from the **Search** menu for the restricted Users.
- deleting the menu item assigned for the Asset Browser.

When you run the search, you will get a tree in the search results. This tree will have branches according to the columns in the lists (Cascading Attributes). You can see in the screenshot below:

- 1. The user can choose from three options. This is only available when you have enabled **Allow Changing Image Area Style via Dropdown**. See the explanation above.
  - **Show left Panel**
  - **Show Image Panel**
  - **Show left and image(top) panel**
- 2. Tree Panel. This shows the information from the lists
- 3. Search Parameter Panel where you can refine your search using Attributes or document properties.
4. Image Panel
5. Search Results

Setting Up a Graphical Asset Browser

As already mentioned, the tree panel to the left can be replaced with a panel of images at the top. Alternatively, you can choose to have both at the same time which will give you synchronized results. These images are a representation of the attributes. From WebCenter 12 onwards you can configure an image label for an attribute.

1. Create images for each value of Attributes and lists (the lists you have configured in lists.xml for your Cascading Attributes).

Note:

- For the best user experience, use .jpg images. It does recognize .gif,.jpeg and .png.
- The name of the Attribute (or lists) and the image should be entirely the same including the case of the letters. Extensions should be specified in lower case.
- The images appear as 100x100 pixels. If you add images exactly of this size, best performance is assured. If the sizes vary, it will be adjusted to fit into 100x100 appearance. Therefore, the image appearance will vary depending on your browser’s capacity to scale images. For instance, Internet Explorer does not give good results for .png images if they are differently sized.
2. Add these images to `WebCenter\WebServer\tomcat\webapps\WebCenterInst\custom\AttributeValueImages`.

If more than one WebCenter instance is used, you have to copy this setup to each instance.
Note:

Make sure that you have an image for each list used. In the above example screenshots above, this is Brand.jpg, Packaging.jpg and no image attached with Product.

Use a .jpg for the lists since list images will be frequently used. As mentioned earlier, WebCenter is optimized for .jpg. When some attribute value has no fitting image, the list image will be shown instead.

Removing the Search Button from the Asset Browser

If you keep the Search in the asset browser, for every search modification in the Asset Browser, you have to click it to refresh the results. You can remove this button from the Asset Browser to improve the user experience.

By removing the Search button, you can:
- save on screen space in the Asset Browser
- any change in the search criteria from the browsing tree or the search panel will update the results.

You can accomplish this by editing the Saved Search created for the Asset Browser:

1. Go to Search > Saved Searches > Edit Search
2. On the right hand side of the page, click on Show Result Layout Options
3. Disable the Show Search Button option.
8.3.3 Customizing the User Menu with the Asset Browser

Assigning a Menu Item for the Asset Browser

You can create and assign a Menu Item for easy access to your Asset Browser. The procedure is similar to assigning a menu item for Saved Searches. Read Add Custom Menu Items from WebCenter Customization Guide for details.

1. Go to Admin > Preferences > Menus. Download the XML file or create a new XML file and add the following code under the NON_ADMIN.

   `<menuitem>
   <name>AssetDemo</name>
   <labeltag>Asset Browser</labeltag>
   <url>dosavedsearch.jsp?searchName=AssetDemo</url>
   </menuitem>`

2. Assign the scope of this menu to the (set of) users or to a Company/Location. Read more in Add Custom Menu Items.

3. Save this XML and upload as a new menu.

This results in the following Menu Item named Asset Browser. The search results are directly available by clicking on this item. The name of the page is the same as the name of the Saved Search. In this example, the page appears as AssetDemo instead of “Search Results”.

Assigning Submenus to Dedicated Asset Browsers

You can customize your Asset Browser further by creating submenus for different asset browsers with a more dedicated and simplified user interface. This will help you to navigate easily between the asset browsers/saved searches. You do this by adding a submenu to the asset browser’s menu item which is explained in Assigning a Menu Item for the Asset Browser on page 105.
1. Set up dedicated Asset Browsers for your assets. These are **Saved Searches** called Brands and Packaging in this example.

2. Update the XML file with the similar fragment as in the example below. You can see that there are submenus for the set of Asset Browsers created in the previous step.

```xml
<menuitem>
    <name>Asset Browser</name>
    <url>dosavedsearch.jsp?searchName=AssetDemo&amp;actionMenu=Asset Browser</url>
    <labeltag>Assets</labeltag>
    <menuitem>
        <name>Brands</name>
        <url>dosavedsearch.jsp?searchName=Brands&amp;actionMenu=Asset Browser</url>
        <labeltag>Brands</labeltag>
    </menuitem>
    <menuitem>
        <name>Packaging Types</name>
        <url>dosavedsearch.jsp?searchName=Packaging&amp;actionMenu=Asset Browser</url>
        <labeltag>Packaging Types</labeltag>
    </menuitem>
</menuitem>
```

**Note:**
- This will result in submenu which folds out and permanent links on the top left below the main menu bar. The second one is caused by `&amp;actionMenu=Asset Browser`.
- Check the spelling as every character is important.
- This code addition is not necessary if you use one menu item for a single Asset Browser alone. Example in *Assigning a Menu Item for the Asset Browser* on page 105.

3. Upload this XML to a new menu or update a previous menu in **Admin > Preferences > Menus**

4. Assign this menu to a set of **Users** or a **User**. You can also assign a menu item to a **Company/Location**. This versatility helps you to restrict the access to specific **Groups** and **Users**.

Clicking on **Brands** under **Assets** will bring you to the saved search called Brands. You can save this with simpler settings or with a graphical asset browser according to your preference. It is possible to give different names to the **Saved Searches** and the submenu items.
8.3.4 Advanced Options in Asset Browser

Configuring the Cart in the Asset browser

You can configure the Cart in the Asset Browser which can assemble the assets selected from the Asset Browser. From the Cart, you can:

- start the viewer
- download the assets
- start a new project with these assets
- modify the assets.

You can do several rounds of searching and browsing to add documents one by one to the Cart and then proceed with the actions listed above. The Cart has to be configured by the administrator while determining the settings of the Asset Browser (the **Saved Search**).

1. In the Search Settings, click on **Show Result Layout Options** which will open the **Advanced Functions**.
2. Enable **Show Cart**.
3. Save the search.

The next time you access the Asset Browser, the Cart will appear within a few seconds. You can now add your selections to the cart.

Configure Project Creation from the Asset Browser

Your Packaging Projects often involve modification of existing packaging or creation of new packaging with recurring elements. You can use a project template for these recurring elements. Asset Browser will help you to browse for these templates and existing packaging projects while setting up new Projects. You can either collect the relevant items to the Cart and start a new Project directly or start Project creation from the action list menu. Follow the steps below to configure this feature.

1. In the Search Settings, click on Show Result Layout Options which will open the Advanced Functions.

2. Enable Show Project Creation Link.

This will add a link to the search results action list Create project from selected and to the Cart Cart > Create project from cart.

3. You can choose the template for the project creation from Asset Browser. For this, enable the Fixed Template option and select the template from the dropdown list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Template</td>
<td>Select the template from the dropdown list.</td>
</tr>
<tr>
<td>Option</td>
<td>Result</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Template from Characteristics Path</td>
<td>You have to specify the path. For example, projects\modificationTemplates. Note: Follow the correct spelling and letter case.</td>
</tr>
<tr>
<td></td>
<td>Note: Projects can have multiple characteristics. The same template can appear in multiple asset browsers together with other sets of templates.</td>
</tr>
<tr>
<td>No Template Specified</td>
<td>This will result in the standard project creation user interface.</td>
</tr>
</tbody>
</table>

4. Save the search under the same name.

You can either use **Create Project from Selected** link or **Create Project from Cart** to create projects from your selected assets (either from the selection or from the Cart). This will lead to project creation user interface depending on the template choice made in the steps.
8.3.5 Tips and Tricks

**Tip:** In certain cases you might want to have your assets attached with different Attribute Categories to be shown in your Asset Browser. For instance, when you have graphical designs attached to one Attribute Category and photographs attached to another Attribute Category. If you want your Asset Browser to show these two types of assets, you can create a third Attribute Category combining these two Attribute Categories. You can create your Asset Browser attached with this Attribute Category. You can refine your Search Results from the Browsing Tree or using Search Panel.

It is a good practise to name this combined Attribute Category with the name of the Asset Browser for future reference. However, this is not mandatory.

**Remarks**

- You might experience slow searching in Asset Browser if you use older versions of Internet Explorer. Consider upgrading or using quicker browsers like Google Chrome and Firefox on PC and Safari or Firefox on Mac.
- If the same value for an attribute exists in different Attribute Categories, the image label will be the same in the Asset Browser. For example if you have attribute named “lemon flavor” for Brand A and Brand B, you cannot have two different images for Brand A and Brand B.
- You cannot search for empty attributes. If you are doing a complex search with multiple checkboxes from the browsing tree with one of them without a value, the Asset browser does not give intuitive results.
- Attribute values or list names should not contain disallowed characters for the Windows Operating system file names when setting up a Graphical Asset Browsing. Avoid the double quote as well.
8.3.6 Troubleshooting

Problem: The asset browser works fine on one WebCenter Instance but not on another WebCenter Instance

- You need to copy all of the setup to each WebCenter Instance:
  - copy the Excel sheet containing the cascading attributes and the the lists.xml configuring the cascading attributes to `webinstance\custom\excel` folder.
  - copy the images to `webinstance\custom\AttributeValueImages`

Problem: You get a message box with “No Search Panel Exists for attribute xxx”

The chosen attribute is not set to **Available** or **Visible** in the **Search Panel Design**.

![Attributes...]

- Trademark
- Brand

You should set it to **Available** or **Visible**.

8.4 Setting Up Bulk Project Operations in Saved Searches

8.4.1 Updating Due date, Manager or Status

The Project Manager, Due date and Project status properties can be modified from Project search results or a saved Project search results.

**Note:**

All actions are restricted to current permissions on the individual projects involved.
1. In the main menu, go to **Search > Projects**.

2. Type the parameters you would like to use to filter the search results.

3. Enable the **Editable** check-boxes for **Project Status**, **Due** and/or **Project Manager**.

   Use the **Editable** column to enable bulk operations on projects. You can modify the following parameters of several projects at once:

   - **Due date**
   - **Project Manager**
   - **Project Status**
   - **Attribute Category or Project members/permissions**
   - **Project Role assignments**

   The bulk operations can be done from the **Search Results** page or from **Saved Search Results** page.

**Note:**

These bulk operations are always limited to current permissions on the projects involved.

When you enable the **Editable** items, you get an Edit button next to the selected items in the **View** List.

4. Now **Save** the Search or click **Search**.
8.4.2 Updating Attribute Category or Project Member / Permissions

You can setup Project Search Results to allow bulk updating of:

- the Project Attribute Category
- Project Members
- Project Permissions

1. In the main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Click Show Result Layout Options to see advanced search options.
4. Enable Allow Changing Attribute Category and / or Allow Changing Project Members.
5. Now Save the Search as Global.

8.4.3 Updating Roles

1. In the main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Add one or more Role Search Criteria by clicking the Add Role Search Criterion link.
4. Enable the Editable check-boxes for the role or roles that you want to make editable.
5. Save the Search as Global.

8.5 How Can you Set Up a Search with the Calendar View?

- As an administrator, Go to Search > Projects
- Make sure the Project status View checkbox is enabled
- Click Show Result Layout Options
- Select one of the calendar view options in the Project Status dropdown
- Specify width (in pixels) for the calendar column (minimum is 200px but you get better results with 500px)
- Decide whether to also show the project status icon (which will then appear at the left of the calendar)

Remark that the calendar is displayed in the column defined for the project status. By changing the column order for this column, you will move the calendar in the search result. In most cases the best result is obtained, if the calendar is the last column and if there are not too many preceding columns.
The 3 calendar options are:

- Show Calendar View: will show past statuses (history)
- Show Calendar View with Predictions: will show past statuses and predictions based on the tasks in the project
- Show Calendar View with Planning: will show past statuses, predictions based on the tasks and the originally planned timeline (in gray)

*Note: The last two options are available with the task management license only.

8.6 SmartNames in Search

Administrators can create **Saved Searches** with **SmartNames**. SmartNames are variables that will refer to a value when placed in the right context.

**Note:** These searches will resolve only in the context of the **Project / Document** and will not be useful as a general **search**.

When you plug in these searches into a project / document, these SmartNames will resolve with values retrieved from that context. For example, if you create a **saved search** for finding the related projects, your users will be able to view the search results within a project tab. Read more in: **Use Case: SmartName Search to find Related Projects**.

You can also use SmartName searches as the document sources in **Document Reference Attributes** and Project Creation.

These SmartName searches will display different results in different projects/documents as the context of the SmartName changes.

8.6.1 Using SmartNames in Saved Searches

A SmartName is a variable that will refer to a value when placed in the right context (For example, within a project or in the context of a document).

To create a SmartName powered search:

1. Go to **Search > Documents** or **Search > Projects** or **Search > Tasks**.
2. Enable SmartName.

All your search fields will display the SmartNames icon.

3. Click on the icon in the field where you want the SmartName configured.

   For example, Project Name can indicate the group of projects it belongs to. In this case click in the Project Name field.

4. In the SmartName dialog, choose the SmartName.

5. Save the search. Your SmartName search will appear in the list of Saved Searches.
You can plug these searches into the relevant projects where the SmartName will get resolved. Your search results will then list the results based on the context.

**Note:** If a SmartName gets resolved into multiple values (a multi-value Project Attribute), your search criteria will be all of those separated by the OR separator.

**Remember:** If you execute a SmartName search from the saved searches page, you will not get valid results.

**Save as Global when SmartName Context is enabled**

**Note:** SmartName enabled searches can be saved only as global searches. These searches will be visible only to the ADMINS group. You can change the visibility of the search by clicking on Edit visibility link. Read more in Creating Advanced Saved Searches on page 82.

### 8.6.2 Use Case: SmartName Search to find Related Projects

When you have a group of Projects under a Packaging Project / Program, your projects share attributes. You can use these common parameters (in the search) to display the related projects / documents. This is also useful when you have derived-projects created using the Create Project node.

Depending on your business needs, you can customize a SmartName powered search and plug this as a tab in the projects details page. For example, you can display all the derived-projects in one tab and all the related projects in another by plugging in SmartName saved searches in these custom tabs.

**Tip:** You can configure this as a dedicated menu item for the Project Details / Document Details page.
SmartName Searches in Project Details / Document Details

To use your SmartName powered searches as a dedicated tab of the Project / Document details page, create a custom menu item.

You can link this custom tab to a saved search with SmartNames. The SmartNames will resolve to values derived from the current Project (for Project Details Menu Items) or Project and Document (for Document Details Menu Items) context.

The user / group / company with this menu will have a custom tab displaying the search results based on the SmartName criteria.

8.6.3 Use a SmartName Saved Search as a Document Source

You can create custom Document Sources using dedicated SmartName searches. You can use these as sources in:

- Project Templates with Document Creation Settings on page 66.
- Documents or Projects assigned with Document Reference Attributes

When the user uses this source during Project creation or to add documents to a task within the Project, the Saved Search configured as the document source is executed from the current Project / Document context.

Setting up a SmartName Saved Search as a Document Source

1. Go to Search > Documents.
2. Enable SmartName.
   
   All your search fields will have a SmartNames icon next to it.
3. Click on the attributes link.
4. Click the icon next to the attribute from your attribute category.
As an example, if you want to setup a document source for a Customer, from the library of your CAD files:

- specify the customer related attributes as the SmartName search criteria.

**Tip:** Configure *Search Layout* options to get an advanced layout.

The selected attribute(s) will appear in the search form.

![SmartName search options](image)

**Tip:** The above example will work only in a document assigned with a document reference attribute (category). If you would use this as a document source in project creation, use the `[Box Brands (Project)]` as the SmartName.

5. **Save the search.**

**Tip:** If you want to limit the scope of the search within a library of documents (a repository project), specify the project name as another criteria.

You can add this search as a document source in:

- *Document Creation Settings* on page 66 of Projects / Templates.
- Document sources in *Document References* on page 199
When the user clicks a custom link to add a document as a document reference, the result will be a pop-up with the saved search results. You can configure the search result layout settings to configure the features in the document source pop-up.

8.7 Searching for Document References

You can search or create saved searches for Projects / Documents / Tasks with document reference attributes. For example, you can search for all the documents with a specific CAD reference linked to it.

You can search for:

- empty document reference attributes
- a specific document used as a reference either by name or its project and location

8.7.1 How to Search for Document Reference Attributes

1. To search for document references, click on:
   - the attributes link from the Search Projects / Search Documents page.
   - the task specifications link from the Search Tasks page.

   You will get the Search Attributes / Search Specifications page.

2. Choose your Attribute Category with the reference to the document you are looking for.
3. For each of your **document reference attributes**, you can specify the search criteria as:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Empty</strong></td>
<td>to search for projects / documents where the document reference attribute has no document attached to it.</td>
</tr>
<tr>
<td><strong>Matches</strong></td>
<td>to search for a specific document by its name.</td>
</tr>
<tr>
<td><strong>Select</strong></td>
<td>to select a specific Document from a specific Project folder.</td>
</tr>
<tr>
<td></td>
<td>This option gives you a <strong>Select Document Reference</strong> pop-up where you can specify:</td>
</tr>
<tr>
<td></td>
<td>• a Project</td>
</tr>
<tr>
<td></td>
<td>• the Folder</td>
</tr>
<tr>
<td></td>
<td>• the Document</td>
</tr>
<tr>
<td></td>
<td>• a single Version or a Revision. If you specify a revision, all the versions of this revision will become selected. The default is <strong>Any version</strong>.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can select the Project and Folder to specify the location of the document. But the search will locate all the versions of the same document located in different projects as well.</td>
</tr>
</tbody>
</table>
9. Managing Companies

Entering Company and Location information lets you further refine projects and users when they are created.

9.1 Create a New Company

1. Click Admin > Companies > New Company.
2. Enter the information about the new company (Company Short Name, Company Legal Name, Phone...).
   Fields with asterisks next to them are required to have information in them.
3. Do you want the users of this company to see custom menus instead of the default WebCenter menus?
   Custom menus allow you for example to simplify the user interface, so the users only see the menus they need to use. See Menus Preferences on page 28.
   Note: Users linked to a company will always see the menu assigned to the company, when the Default menu is assigned to them as a user.
   • If yes, choose the menu to assign to the company in Menu.
   • If no, leave Default in Menu.
4. Click Create.

A status message saying the company was created successfully appears at the bottom of the page. You can create an additional company by filling out the form again and pressing Create.

9.2 Edit a Company

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Click the name of the company to change.
   This opens the Edit Company page.
4. In the Name and Menu tab, you can change:
   • the Company Short Name,
   • the Company Legal Name,
   • the Menu that the users of this company will see (see Menus Preferences on page 28 for information about menus),
   Click Save to save your changes before switching to another tab.
5. In the Locations tab, you can edit the company’s location(s):
• click a location to edit its details (Location Name, City, Country...),
• to delete a location, select it and click Delete Location(s) in the actions menu,
• to add a location, click the New Location link and fill in the new location’s details.

6. In the My Work tab, you can change what the company users will see on their My Work page.
   • Select Use Default My Work Setup to use WebCenter’s predefined My Work page,
   • Select Use Custom My Work Setup to set up a custom My Work page for this company.
   Then pick the Sections you want to display on the Left Column and Right Column of the My Work page.
   Click Save when you are done.

9.3 Delete a Company

If the company you delete has users assigned to any of its locations, WebCenter issues a dependencies warning.

You must reassign the users to another location or delete the users before you can delete the company. There is no dependency check if there are no users assigned to any location.

If the company is only assigned as a customer, it will be deleted when you confirm the deletion.

Note: Attempting to delete multiple companies will stop on the first company that has dependencies. To delete the rest of the companies, reselect them and delete them.

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Select the checkbox of the company to delete.
4. Click Delete Company in the actions menu.
5. Click OK to confirm the deletion. The company is deleted.

9.4 Add Locations

1. Click Admin > Companies.
2. Either type in a Filter or click Go to see the list of companies.
3. Click the name of the company for which you want to add a location.
4. Click the Locations tab. The current locations for the company are displayed.
5. Click New Location at right.
6. Enter the appropriate information and click Add Location. The new location is created.

9.5 Edit a Location

1. Click Admin > Companies.
2. Either type in a **Filter** or click **Go** to see the list of companies. Click the name of the company for which you want to edit a location.

3. Click **Locations** on the menu. The current locations are displayed.

4. Click the name of the location to edit.

5. Change the information as desired and click **Change**. The information is changed and a confirmation message appears.

### 9.6 Delete a Location

If the location you delete still has users assigned to it, WebCenter issues a dependencies warning. You must reassign the users to another location or delete the users before you can delete the location.

Attempting to delete multiple locations will stop on the first location that has dependencies. To delete the rest of the locations, reselect them and delete them.

1. Click **Admin > Companies**.
2. Either type in a **Filter** or click **Go** to see the list of companies. Click the name of the company for which you want to edit a location.
3. Click **Locations** on the menu. The current locations are displayed.
4. Select the location(s) to delete by selecting the checkbox next to the name.
5. Click **Delete Location(s)** in the actions menu.
6. Click **OK** to confirm the deletion.
10. Managing Users

10.1 Create a User

1. Click Admin > Users > New User.
   
   **Step 1: User Info** in the Create New User wizard appears.

2. Type the basic user information into the appropriate fields (Username, First Name, Last Name...).

   **Note:** Required fields are indicated with an asterisk *.

3. Do you want to use LDAP authentication (single sign-on) for this user?

   - If yes: enable the **Use LDAP to Authenticate User** option. This will allow the user to use his regular Windows network user name and password to log on to WebCenter.
   - If no, provide the user's initial **Password** and confirm it.

   Enable the option **Require the user to change the password at first login** to force the user to choose a new password when they first log on to the system.

4. Do you want this user to see custom menus instead of the default WebCenter menus?

   Custom menus allow you for example to simplify the user interface, so the users only see the menus they need to use. See **Menus Preferences** on page 28.

   - If yes, choose the menu to assign to the user in **User Menu**.
   - If no, leave **Default** in **User Menu**.

5. Does the user need guaranteed access?

   - If yes, enable the option **User Has Guaranteed Access or is an ArtiosCAD Enterprise User**.

     **Note:** You can also use this option to make editor users, if you license allows it (see **Licensing and Users** on page 127).

   - If no, leave the option disabled and proceed to the next step.

   For more information on guaranteed access and its licensing implications, see **Licensing and Users** on page 127.

6. Does the user need multiple open sessions with guaranteed access?

   - If yes, enable the option **Allow Multiple Guaranteed Sessions**.

     **Note:** You can allow multiple open sessions (such as the SDK user or Automation Engine user) as guaranteed sessions for a User. However, every three such sessions will block a concurrent license reducing the number of available concurrent access. (see **Licensing and Users** on page 127).

7. Does the user need special permissions in WebCenter?

<table>
<thead>
<tr>
<th>If the user needs...</th>
<th>Select the option...</th>
</tr>
</thead>
<tbody>
<tr>
<td>no special permissions</td>
<td>Normal User</td>
</tr>
</tbody>
</table>
If the user needs... | Select the option...
---|---
Project Manager permissions, but only for projects and users belonging to his or her own company | Project Manager with Limited Visibility of Companies and Groups
Project Manager permissions on the complete system | Project Manager with Full Visibility

8. Does the user need the ability to create new task types in WebCenter? (only if the user is a Project Manager)
   - If yes, enable the option User Can Create Task Type.
   - If no, leave the option disabled and proceed to the next step.

9. Does the user need the ability to create new users? (only if the user is a Project Manager)
   - If yes, enable the option User Can Create User, then click Continue.
     
     Note: A Project Manager creating users will have less options than an Admin: for example he / she will not be able to give the new user LDAP (network) sign-on or guaranteed access.
   - If no, click Continue.

Tip: You can keep track of users created by other users: the Owner column of the Users page shows who created each user.

10. In Step 2: Assign to a Company, optionally select a company to which you want to assign the user. Note that this can be very important to filter the content and users the new user will be able to see.
11. If you:
    - are creating a Normal User or a Project Manager with Full Visibility, the wizard is complete. Click Finish to create the user.
    - are creating a Project Manager with Limited Visibility, click Continue and proceed to the next step.
12. In Step 3: Assign Visible Companies, select the companies that this user should be able to see, then click Continue.
    The selection you make here filters the list of users in the next step so that this Project Manager can never see users from the companies you did not select in this step. By default, only the company of the Project Manager himself (the one you selected in the previous step) will be selected.
13. In Step 4: Assign Visible Groups, select the groups the user should be able to see, then click Finish.
    Only groups containing members that belong to one of the companies you assigned in the previous step will show up in the list. In addition, some groups may be set to be visible to all users (such as the ADMINS group).
10.2 Licensing and Users

**Basic concepts**
Access to projects and documents is controlled by user and group permissions.

**User**
Everyone who logs in to WebCenter is a user. Users log in using a username and password assigned to them by an Administrator.

**Group**
A Group is a logical set of users connected by a common element of your choosing, such as function or location. You can assign tasks to groups, you can set up groups as approvers or even as project managers.

**Role**
A Role is a placeholder object that project managers can use in their projects or templates to set up approvals, assign tasks to, use in workflows, etc., without being forced to use specific users and groups just yet. Upon project creation, or even later in the process, the project manager can assign the role(s) to the actual user(s) and/or group(s). This provides more flexibility in setting up templates/projects.

**Default users**
One user, admin, and two groups, Admins and Users, are created by default in WebCenter. Members of the Admins group are WebCenter system administrators and can perform any function.

**Types of users**
You can create as many users as you want. The number of users who may use the system at the same time, which is called concurrent access, is determined by the licenses you have purchased. The licensing model distinguishes between three types of users: guaranteed users, concurrent users, and editor users.

**Guaranteed users**
A guaranteed user can always access WebCenter, regardless of how many concurrent users are logged on at the time.

**Concurrent users**
Any other user who does not have guaranteed access can log on to WebCenter as long as the maximum number of concurrent users is not exceeded.

**Note:**
For every three guaranteed users you create, one concurrent user license is blocked permanently. For example, if you have 25 concurrent licenses for 100 non-guaranteed (concurrent) users, 25 concurrent users can log in at any time.

If you give 25 users guaranteed access, these users will take up 8 concurrent licenses. This means that only 17 concurrent users (out of 100) can log in simultaneously, because 8 concurrent licenses would be permanently blocked by those 25 guaranteed users (25 x 0.333 = 8.333).

**Editor users**
These are ArtiosCAD Enterprise users. They have guaranteed access but do not take away concurrent licenses.

You will have a fixed number of editor users, determined by the license you have purchased. When that number is reached, you cannot set more users to be editor users.

Generally, your system will either have guaranteed and concurrent users, or editor users.

If you have editor and concurrent users, and all your concurrent access licenses are in use, a concurrent user will not be able to access WebCenter, even if you have editor licenses left (a concurrent user cannot use an editor license to log in).

**Multiple Guaranteed Sessions**

You can allow multiple open sessions (such as the SDK user or Automation Engine user) as guaranteed sessions for a User. However, every three such sessions will block a concurrent license reducing the number of available concurrent access.

**Workflow Connections**

Your workflow connections connected through tunnel clients will block one concurrent license each.

**What if the user limit is exceeded?**

When the limit of users with concurrent access is reached, no concurrent user may log in until another user logs out.

To prevent users from blocking access for others, there is a configurable time limit of 30 minutes of inactivity. After any users (guaranteed or not) have been inactive for that amount of time, they are logged out automatically, thereby allowing other users to log in.

**Note:** The Admin user can always log in, even if the user limit is reached.

### 10.2.1 Check the Licensing Status

1. Click **Admin**.

   The **Users** page opens by default.

   The Users page shows:

   - The **Total number of users in the database.** This is how many users you have created.

   - The number of **Purchased concurrent licenses.** This is how many users can be logged in at the same time with no users having guaranteed access (click **Explain License Model** or see **Licensing and Users** on page 127 for details).

   This number can be increased at any time by purchasing more licenses from Esko.
Note:
From WebCenter 14.0.2 onwards, the maximum number of regular concurrent licenses that can be installed is set to 50 instead of 30. If you install more than 50 regular licenses for concurrent usage, the licenses will be truncated to 50.

You will see a warning message informing you that the number of concurrent licenses exceeds the maximum and that the number of available licenses will be truncated to 50.

To install more than 50 concurrent licenses, you need a WebCenter Advanced License.

- The number of **Purchased editor licenses**. This is how many ArtiosCAD Enterprise users you have a license for. These users have guaranteed access.

- The number of **Concurrent licenses blocked for users with guaranteed access**. Every three guaranteed users block one concurrent user.
  
The number of guaranteed users is shown in parentheses.

- The number of **guaranteed** users **Currently logged in**.

- The **Remaining number of concurrent accesses**. This is how many non-guaranteed users can be logged in simultaneously.

- The number of **concurrent** users **Currently logged in**.

2. To see the users who are currently logged in, click **Show Users that are Currently Logged in**.

Users who simply close browser windows do not actually log off until their sessions expire due to inactivity (usually after 30 minutes). Users should always click **Log Off** when they are done using WebCenter.

3. To forcibly log off a non-guaranteed user to make more concurrent licenses available, click **Log user off** next to that user’s licensing status. Use this with caution as data loss may result. It would be prudent to try contacting the user in question before using this command.

### 10.3 Login Tracking

To get a simple overview of User Logins for a specified time period, click the **Admin > Users > Login Tracking** option.

- Specify the time units (**Detail Overview** in **days / hours / weeks**).
  
The overview table will display the time in the units you specified here.

- Select the **View** as **graph / table**.

- Select the time period by specifying the dates.

- Click **Search**.

You can use **Save to Excel** to export the login overview. You can view more details by clicking on **Switch to Advanced View**. Read in **Advanced Login Tracking** on page 130.
Read also Failed Logins on page 130 and License Usage on page 130

10.3.1 Failed Logins

Failed Logins column gives the count of the number of login attempts that were denied because of insufficient licenses. This count is measured during the period you specified.

10.3.2 License Usage

In the Login Tracking page, you can see the statistics regarding:

- used and free editor licenses
- used and free concurrent licenses

for the specified time period. You will see a warning next to the progress bar if there was at least one Failed Login due to shortage of licenses.

10.3.3 Advanced Login Tracking

The advanced page shows a list of individual User sessions (or Failed login attempts) that were active during the specified time period.

To view the successful login details, select Show Login Sessions. You can view the failed logins by opting to Show Failed Logins.

Use the custom filtering to limit the information to what you are looking for. For successful login sessions you can filter on:

- Single Sign-On Instance
- Login Method
- Logout Method
- User: You can type the
  - User Name
  - First Name
  - Last Name
  of the target User.
- Company
- Location: Use this filter to view the login statistics associated with one Company and in a specific location

Note: To show the system user sessions ("SYSTEM" and "CADX"), enable the option Show sessions from system users. This option is turned off by default.

If you are viewing Failed Logins, you can filter on:

- Single Sign-On Instance
• **Login Method**
• **Login Failure Cause**
• **User** Type any of the following:
  • User Name
  • First Name
  • Last Name

To see login attempts from unregistered users, enable *Show anonymous login attempts*.

**Tip:**
Use **Sort by** to sort the table based on the selected column.

To export the table as a .XLS file, click **Export to Excel** link.

### 10.4 Editing Users and their Preferences

#### 10.4.1 Edit a User

1. Click **Admin**.
2. On the **Users** page, filter the list of users if desired, and click the User Name of the user to edit.
   
   The **Profile** page appears.
3. Make the required changes:

<table>
<thead>
<tr>
<th>To edit the user's...</th>
<th>You should...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>user info (including authentication details)</strong></td>
<td>edit the fields on the <strong>Profile</strong> Page. Read also <em>Edit User Authentication Settings</em> on page 132.</td>
</tr>
<tr>
<td><strong>menu</strong></td>
<td>choose a different menu in the <strong>User Menu</strong> list.</td>
</tr>
<tr>
<td><strong>permissions</strong></td>
<td>select the appropriate role from the options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Normal User</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Project Manager with Limited Visibility</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Project Manager with Full Visibility</strong></td>
</tr>
<tr>
<td><strong>Privileges</strong></td>
<td>Also specify if :</td>
</tr>
<tr>
<td></td>
<td>• <strong>User can create Task Type</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>User Can Create User</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>User Has Guaranteed Access or is an ArtiosCAD Enterprise User</strong></td>
</tr>
</tbody>
</table>
### To edit the user’s...

<table>
<thead>
<tr>
<th>company or location</th>
<th>You should...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Click the <strong>Company/Location</strong> link at the bottom of the <strong>Profile</strong> page.</td>
</tr>
<tr>
<td></td>
<td>2. Select a new company and click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>visible companies or locations (only applies to Project Managers with Limited Visibility)</th>
<th>You should...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Click the <strong>Visible Companies</strong> or <strong>Visible Locations</strong> links.</td>
</tr>
<tr>
<td></td>
<td>2. Make a selection of visible locations and/or companies and click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

**Allow Multiple Sessions**

*The licensing and users overview* page will explicitly show the number of guaranteed sessions and the number of licenses blocked.

<table>
<thead>
<tr>
<th>Allow Multiple Sessions</th>
<th>You should...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable this option to allow the user to login concurrently multiple times.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong>: Use this if you have heavy SDK integration with simultaneous tasks.</td>
</tr>
<tr>
<td></td>
<td>This is also useful if you have a lot of shared users (e.g. for an external company).</td>
</tr>
<tr>
<td></td>
<td>• Specify the <strong>Maximum Open Sessions</strong> allowed for the user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This has an impact on your concurrent licenses. Every three such sessions take up one concurrent license. For example, if your integration user has 30 sessions, this will take up 10 concurrent licenses. Do not use this option for normal users. Since WebCenter 14.1, the <strong>admin</strong> users have the same number of multiple sessions as any other user. You can change this by setting a different <strong>Maximum Open Sessions</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Change** to confirm.

---

**Edit User Authentication Settings**

An Administrator or a Project manager with rights can manage the SSO authentication details at the user **profile** page.

Go to **Admin > Users**. Select the **User** and go to the **Profile** page.
Authentication:
This section lists the available and disabled authentication types. You can allow / deny the User authenticating with any of the Single Sign-On Instances.
Read also Configure Single Sign On User settings on page 245.

10.4.2 Change the Password for a User

1. Click Admin.
   The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Password tab.
4. Type a new Password and Confirm it.
5. Click Change to save the changes.

10.4.3 Change a User’s License Status

1. Click Admin.
   The Users page appears.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Select or deselect the User has guaranteed access option and click Change.

   Note: Changing users’ licensing is effective immediately.

Alternatively, to change many users’ licensing status in a single operation:

1. Select the users on the User page.
2. In the actions menu, click **Grant Guaranteed Access** or **Remove Guaranteed Access** as desired.

### 10.4.4 Set the Preferences for a User

1. Click **Admin**.
   
   The Users page appears.
2. On the **Users** page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the **Preferences** tab.
4. Configure the Preferences as needed. For more information on the settings and options, see **General Preferences** on page 17.

### 10.4.5 Copy Preferences to Users

Use this to quickly copy previously defined preferences to one or several users.

1. Click **Admin**.
   
   The Users page appears.
2. Select the user(s) whose preferences you want to change and select **Apply Preferences** in the actions menu.
3. In the **Apply Preferences** popup, select the preferences to change, and deselect the preferences to keep.
   
   **Other Preferences** are the user preferences not mentioned above (for example: show thumbnails or not, search results layout, etc.).
4. Select who you want to copy the preferences from: in **Take Preferences From**, select another user, or select **Default** to use the default settings for the preferences you selected.
5. Click **OK**.

### 10.4.6 Edit a User's Group Memberships

1. Click **Admin**.
2. On the **Users** page, filter the list of users if desired, and click the User Name of the user to edit.
   
   The **Profile** page appears.
3. Click the **Groups** tab.
4. To add the user to one or more groups, select those groups (use Ctrl+click to multiple-select) in the **Available Groups** list and click the **>>** button.
5. To remove the user from one or more groups, select those groups in the Current Groups list (use Ctrl+click to multiple-select) and click the **<<** button.
The changes are effective immediately.

### 10.4.7 Set Available Download Formats for a User

1. Click **Admin**.
   
The Users page appears.

2. On the **Users** page, filter the list of users if desired, and click the User Name of the user to edit.

3. Click the **Download** tab.

4. Select or deselect the download formats you want to enable.

   **Note:** User permissions for download formats take precedence over group permissions for download formats.

5. Click **Change**.

   **Note:** Alternatively, you can click **Use Group Permissions** to make the user inherit the download formats from his or her group membership(s).

### 10.5 Delete a User

When deleting a user, WebCenter checks for dependencies, such as being a Project Manager or being an Approval User on an ongoing Approval Cycle, before deleting the user.

If there are dependencies, WebCenter asks you whether you want to view them (with links so you can remedy the dependencies) or cancel the deletion.

**Note:** Attempting to delete multiple users will stop on the first user that has dependencies. To delete the rest of the users, reselect them and delete them.

1. Click **Admin**.

2. Select the checkbox next to the name of the user to be deleted. To delete more than one user at a time, select additional checkboxes of users to delete.

3. Click **Delete User(s)** in the actions menu.

4. Click **OK** to confirm the deletion.

5. If there is a Delete Dependency confirmation, choose the desired option and click **OK**.

   Users cannot be deleted until any dependency issues have been resolved.
10.6 Managing User Memberships in Projects

10.6.1 View a User’s Project Memberships

1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.

The projects for user ... page appears. You can filter the list of projects if needed, using the Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the filter criteria and click Go.

Note: This does not show Projects for which the user is the Project Manager or those Projects in which the user is a member by means of belonging to an invited Group.

4. You may uninvite the user from any of the Projects shown in this list by selecting the Project(s), and clicking Uninvite in the actions menu. The user must not be an Approver in an active Approval Cycle.

10.6.2 Invite a User to Multiple Projects

1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.
4. Click Invite to Projects.
5. Select the projects you want to invite the user to, and click Continue.
6. Select the permissions the user needs in the project and click Finish.

10.6.3 Uninvite Users from Multiple Projects

Note: If the user is an Approver in an ongoing Approval Cycle in a selected Project, the entire removal action is cancelled. You must stop the Approval Cycle and then perform the removal.

1. Click Admin.
2. On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.

The projects for user ... page appears. You can filter the list of projects if needed, using the Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the filter criteria and click Go.

4. Select the Projects you want to uninvite the user from.
5. Click Uninvite in the actions menu.
6. Click **OK** to confirm.
11. Managing Groups

11.1 Create a New Group

1. Click **Admin > Groups > New Group**.
2. Enter the name of the group.
3. Choose who will be able to see this group: **All Project Managers, Administrators Only**, or **Selected Project Managers**.
4. Click **Continue**.
5. In **Step 2: Select Group Members**, select the members of the group by checking the checkboxes to the left of their names.
6. Is this new group visible to every Project Manager or only to Administrators:
   - If yes, click **Finish**. The group is created.
   - If no, click **Continue**. The, in **Step 3: Assign group visibility to project manager(s)**, select the Project Managers that can see this group and click **Finish**.

Project Managers with Full Visibility are unavailable, as they can see all groups. By default, group members can see the group but you can still de-select the group members so that they don’t know this group exists.

11.2 Add Users to a Group

1. Click **Admin > Groups**.
2. Click the name of the group to edit. Click **Add Users**.

   **Attention:** Members of the Admins group can perform any task and are not bound by any security restrictions; be careful when adding users to this group.

   The list of users who are currently not members of the group is displayed.
3. Select the user(s) to add to the group.
4. Click **Finish**.

11.3 Remove Users from a Group

1. Click **Admin > Groups**.
2. Click the group to edit.
3. Select the user(s) to remove from the group.
4. Click **Remove** in the actions menu.
5. Click **OK**.
11.4 Copy or Move Users Between Groups

1. Click Admin > Groups.
2. Click the group to edit.
3. Select the users to copy from the group.
4. In the actions menu, click:
   - Copy users if you want to copy users from one group to another.
   - Move users if you want to move users from one group to another.
5. Either filter or click Go to show the list of groups.
6. Select the new group(s) into which the users will be copied or moved.
7. Click Finish.

11.5 Rename a Group

1. Click Admin > Groups.
2. Click the group to edit.
   - The ADMINS and USERS groups cannot be renamed.
3. Enter the new name of the group in the Group Name field and click anywhere else on the page.
4. Click OK.

11.6 Change the Group Visibility

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the Visibility tab.
4. Select the desired visibility choice: All Project Managers, Administrators Only, or Selected Project Managers.
5. Depending on your visibility choice, proceed as follows:
   - If you chose Selected Project Managers, you will be prompted to select the individual Project Managers who should be able to see this group. Click Change when you have made your selection.
   - If you chose one of the other options, go directly to the next step in this procedure.
6. Click OK.
11.7 Set Group Download Formats

Configure the available download formats in WebCenter Preferences (Admin > Preferences > Download Formats) before setting group download permissions.

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the Download tab.
4. Select or deselect the download formats you want to enable.
   
   **Note:** User permissions for download formats take precedence over group permissions for download formats.

5. Select or deselect checkboxes to grant or deny permissions as desired.
6. Click Change.

11.8 Setting Group Notifications

As an administrator or a Group manager, you can set up notifications individually for every group member or to a single group e-mail address.

1. Click Admin > Groups.
2. Click the group to edit.
3. Click the General tab.
4. Select your preferred way of sending notifications or disable them altogether.
   
   - **Send notifications to everyone in the group:** When this option is selected, a group event will trigger notifications to all of the group members’ e-mail addresses according to the individual language settings.
   
   - **Send notifications to a group e-mail address.** Specify also:
     
     - the Group e-mail address
     
     - Group-email language

     If this option is on, a single e-mail notification will be sent to the specified Group e-mail.

   - **Do not send notifications to this group:** Select this to deactivate email notifications altogether.

5. Click Save.
11.9 Managing Group Memberships in Projects

11.9.1 View a Group’s Project Memberships

1. Click Admin > Groups.
2. Click the group to edit.
3. Click Projects.

11.9.2 Invite a Group to Multiple Projects

1. Click Admin > Groups.
2. Click the name of the desired group.
3. Click Projects.
4. Click Invite to projects.
5. Either filter or click Go to show the list of all projects to which this group is not invited.
6. Select the projects to which the group is being invited.
7. Click Continue.
8. Set the project permissions that this group will have in the projects to which it is being invited.
   The same permissions will apply to each project.
9. Click Finish.

11.9.3 Uninvite Groups from Multiple Projects

If a user in the group is an Approver in an ongoing Approval Cycle in a selected Project, the entire removal action is cancelled. You must stop the Approval Cycle first, and then perform the removal.

1. Click Admin > Groups.
2. Click the name of the desired group.
3. Click Projects.
4. Either filter or click Go to show the list of all Projects to which this group is invited.
5. Select those Projects from which the group is to be uninvited.
6. Click Uninvite in the actions menu.
7. Click OK to confirm the removal.

11.10 Overview of My Group's Tasks

My Group’s Tasks lets the Group Manager quickly view the tasks assigned to their group or group members. It also allows to assign, re-assign, or distribute the tasks among the group members.
If a group member is ill or not available, the Group Manager can re-assign the task to an other group member. A Group Manager can also monitor the progress on a selected Group or Group Member. Using the filter options, the Group Manager can have a quick overview of the workload.

### 11.10.1 Group Task Manager

Every department has a Department Manager. In WebCenter Department Manager are referred to as **Group Manager**. A group can have any number of Group Managers including 0. Group Manager is always part of a group.

A Group Manager likes to view the tasks assigned to a selected group or group members, which will assist him in distributing the tasks and also get a quick view on the current status of a task.

The **My Group's Tasks** feature allows Group Managers to:

- View task assignments for a selected group and the workload overview.
- View tasks assigned to a group member and the workload overview.
- Re-assign any task assigned to a group member.
- Review the task overview filtering on status and due date.

### 11.10.2 Assigning a Group Manager

The **My Group's Task** page can only be accessed by a Group Manager. Only a member of ADMINS can turn a group member into a Group Manager.

1. Log in to WebCenter as an Admin user.
2. Click **Admin > Groups > Groups**.
3. Search for the required Group Name or click the Group Name from the list available.
4. Select the **Group Manager** check box for the desired group member.
   
   You can assign multiple Group Managers to one group. The same user can also be Group Manager to multiple groups.

### 11.10.3 Using My Group's Tasks

To access **My Group's Tasks** feature, log in as Group Manager. Click **My WebCenter > My Group's Tasks** to view the **Group Tasks for Group** page.

#### Viewing Task Assignments

You can view the tasks assigned to a selected group and also for a group member within the group.

1. The task list for assigned group appears.

   **Note:** If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of managed groups. You can only view the tasks for one group at a time.

2. In the **Tasks assigned to** drop-down list box, select the group or group member for whom you want view the task assigned.
3. A task list assigned to the selected group or group member appears. Also in the list are:

- Task Name
- Project Name
- Assigned to
- Status
- Lead Time
- Due Date
- Created Date
- Started Date
- Estimated Date
- Task Documents

Viewing a Workload Overview

During editing/re-assigning, the Group Manager can have an overview of number of tasks assigned and how many are overdue. The Task Count is the number of assignments assigned to a group member. The Task Count displayed is based on the filtering criteria and tasks with past due-date always appears. The non-active projects do not appear and are not counted.

1. The task list for assigned group appears.

   **Note:** If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of managed groups. You can only view the tasks for one group at a time.

2. The workload overview appears for the selected group.

<table>
<thead>
<tr>
<th>Members</th>
<th>Task Count</th>
</tr>
</thead>
</table>
| ADMIN/S | Before: 0 (0 overdue)  
After: 0 (0 overdue) |
| admin, admin  
(UL ADMIN) | Before: 2 (2 overdue)  
After: 2 (2 overdue) |
| ADMIN, ADMIN  
(ADMIN) | Before: 22 (23 overdue)  
After: 22 (23 overdue) |

If the task is past the due date, it appears in red.

Reassigning a Task

A Group Manager can re-assign a task to a group or a group member. A task can be re-assigned only to a group member within the same Group. In addition to this when the task is reassigned, the WebCenter UI displays the previous assignee in **Previous** column.

1. **Note:** Ensure to log in as **Group Manager**.

1. The task list for assigned group appears.

   **Note:** If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of managed groups. You can only view the tasks for one group at a time.
2. Select the new assignee in the **Assigned** to drop-down list box. This list contains group and group members name.

3. WebCenter shows changed tasks with a yellow background indicating the change.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Project Name</th>
<th>Assigned To</th>
<th>Previous</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace empty group 1</td>
<td>DEKE test copy without approval2</td>
<td>Shifu (SHIFU)</td>
<td></td>
</tr>
<tr>
<td>Simple Task 2</td>
<td>DEKE test notifications</td>
<td>GROUP_IMPORT_TEST_0001</td>
<td>Nadiger (SRNA)</td>
</tr>
</tbody>
</table>

**Note**: Even if a task is not initially assigned to a group, the Group Manager has all the rights to re-assign the task to a group member.

4. Click **Save** to commit the changes.

### Filtering Based on Task Status and Due Date

A Group Manager manages multiple tasks at a time and this might lead to delay. Using the **Search Tasks Status**, one can see tasks in a more specific status.

For example, you can filter the tasks which are in Completed or In Progress status. By filtering the task, a Group Manager need not re-assign completed tasks or tasks which cannot start because a predecessor is not complete.

Similarly the tasks can also be filtered by **Due Date**. This gives a Group Manager a quick view of the task for the required time line. Using this information Group Manager can view what is due this week or this month to make the required planning.

1. **Note**: Ensure to log in as **Group Manager**.

1. The task list for assigned group appears.

**Note**: If a Group Manager manages multiple groups, WebCenter displays the list of managed groups. You can only view the tasks for one group at a time.

2. In the **Search Tasks Status** drop-down list, select the desired task status.

3. In **Due Date**, select the required due date and then click **Go**.

**Note**: To set the Due Date filtering, setting a task status filter is not necessary. The Due Date changes to completion date, if the task status is filtered to completed.

The following are the default due dates settings available:

- All
- Today
- Next 3 days
- Next week
- Next 2 weeks
- Next month
- Next 3 months
- Overdue
- Week overdue, all the tasks which are overdue for less than five days.
Filtering Based on Sort by

Using **Sort by**, the Group Manager can view tasks for a selected group in ascending or descending order.

For example, in **Sort by**, if **Due Date** is selected then the tasks for the selected group appears with the earliest due date. Similarly if **Due Date Reversed** option is selected, then the tasks for the selected group appears with the latest due date.

1. **Note**: Ensure to log in as **Group Manager**.

   1. The task list for assigned group appears.

      **Note**: If a Group Manager manages multiple groups, WebCenter displays the list of managed groups. You can only view the tasks for one group at a time.

2. In the **Sort by** drop-down list, select the desired option.

3. The tasks list appears as per the option selected in **Sort by**.

   The **Sort by** option is indicated by an arrow. For example, if Due Date is selected then it would appear as:

   ![Due Date](image)

   Sep 2, 2011

   The size arrow can also be used for sorting.
12. Managing Roles

12.1 Roles

A Role is an assignment that you can create in WebCenter to be used later on in Projects. You can assign a Role to Project Templates, Projects, Tasks and Approvals. You can set up project permissions, approval settings and tasks for a Role within a project or template.

You can assign these Roles to real users and groups when needed. When you assign a Role to a real User or Group, you are assigning the Role's settings.

You can create versatile Project Templates using Roles which will help you to reduce the number of Project Templates.

Roles are created as global. This helps the Project Managers (or Selected Project Managers) to use the Roles effectively in individual projects and templates. You can invite these Roles as in the case of Users and Groups.

Roles are effective after real members (Groups, Users) are assigned into each of the Roles. A project Role assignee will be treated like a standard project member. Once you assign the Role to a project, these take over the role’s security setup, approval setup and task assignments.

• the notifications will be sent out correctly
• the task will be shown in the respective members’ to-do list
• the necessary access rights will be assigned to the members to perform the task (depending on the Role)
• the approval notifications will be sent out correctly.

You can employ multiple assignments of a single Role. For example, you can invite a "Designer" Role to all the Projects requiring a designer either after creating a Project or via the Project Template with assigned Roles.

You can use Roles:

• To combine with Workflows:

The tasks assigned to Roles will be picked up by the users or groups who are assigned to these Roles either at the beginning or later during the project execution. The project manager can decide who will get assigned to the Roles. Since WebCenter keeps track of Role assignments:

• the notifications will be sent out correctly
• the task will be shown in the respective members' to-do list
• the necessary access rights will be assigned to the members to perform the task (depending on the Role)
• the approval notifications will be sent out correctly.

• In Project Templates:
Features associated with Roles will be inherited from Project Templates during project creation. Adding Roles (instead of user Groups or individual Users) to your Project templates makes them more versatile.

Note:
Although the Roles are defined for entire WebCenter, the assignment of Roles is done per project and is independent of the User. Therefore, you can assign the same user or group to a "Designer" Role in one project and restrict the access for the same User/Group in other projects.

Read more in Creating a Role on page 147.

12.2 Creating a Role

1. Click Admin > Roles > New Role.
2. Specify the name of the Role
3. Determine the visibility of the Role by selecting from All Project Managers, Administrators, or Selected Project Managers. Click Continue

<table>
<thead>
<tr>
<th>Choice</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Project Managers</td>
<td>You should select which Project Managers are allowed to see the Role</td>
</tr>
<tr>
<td>All other</td>
<td>The New Role is created.</td>
</tr>
</tbody>
</table>

You can view these roles in the list of Project Members even after being resolved.

12.3 Renaming a Role

1. Go to Admin > Roles. This will lead you to the tab named General of Role Management page. You can see the list of available Roles in this tab.
2. Click on the name of the Role. Role names will be visible as links.
3. Enter the new name of the role in the Role Name field and click anywhere else on the page.

12.4 Changing the Role Visibility

1. Go to Admin > Roles. This will lead you to the tab named General of Role Management page. You can see the list of available Roles in this tab.
2. Click on the name of the Role (visible as a link) for which you want to change the Visibility.
3. Go to the Visibility tab and change the visibility.
You will have to choose from three Visibility choices: All Project Managers, Administrators Only and Selected Project Managers.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Project Managers</td>
<td>You will be prompted to select the individual Project Managers. Click Change when you have made your selection</td>
</tr>
<tr>
<td>All Project Managers and Administrators Only</td>
<td>You will be asked to confirm the selection. Click OK.</td>
</tr>
</tbody>
</table>

12.5 Deleting Roles

1. Go to Admin > Roles. This will lead you to the tab named General of Role Management page. You can see the list of available Roles in this tab.
2. Select the Roles from the list of Roles by toggling the respective check boxes.
3. Click on Actions > Delete Role(s) from the list header.

Note: You will be warned if this Role is associated with an existing Project or Approval cycle.

12.6 Converting Empty Groups to Roles

Previous versions of WebCenter made use of empty Groups to create roles. From WebCenter 12 onwards this is replaced by Roles. However, you can also convert any empty Group that serves as Role into a full fledged Role. This will ensure that any reference to such empty Groups will be retained and shifted to the new Role that is created during this process.

To convert an empty group to a role you need to follow these steps:

1. Go to Admin > Groups.
2. Select those Groups which you need to convert into Roles.
   You can use Show filter to filter out all the non-empty groups.
3. Go to Actions menu. Select Convert Group to Role action link in to execute the conversion into a Role.
   You will be re-directed to a page detailing how many of the selected empty groups were converted and how many were not.

Note: The conversion can fail when:

• a non-empty group is selected for conversion. Only empty groups can be converted into roles.
• a role with the same name as the selected empty group exists. Role names must be unique.
12.7 Delegating Roles: Setting up Roles to Assign Roles

Project Managers and Project members (with permissions) can assign a Role within their Projects. The Project Manager or Member can do this from the Manage Roles page.

1. Click Admin > Roles.
2. Select the Role you want to assign permissions to.
3. Click the General tab.

4. Click on the Roles can invite following roles link. This will open Manageable Roles page.
   Role can invite the following roles drop down will contain all the Roles present in the system.
Role can invite the following roles list depends on the visibility rules. See below.

<table>
<thead>
<tr>
<th>Role Type</th>
<th>Permission Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin and PM with full visibility</td>
<td>PM with limited visibility</td>
</tr>
<tr>
<td>All Users and Groups</td>
<td>Normal user</td>
</tr>
<tr>
<td></td>
<td>• Users from his own company (all locations).</td>
</tr>
<tr>
<td></td>
<td>• Users and Groups present in the same Project (through individual or role assignments).</td>
</tr>
<tr>
<td></td>
<td>• Groups the user is member of.</td>
</tr>
</tbody>
</table>

5. Save.

After setting up this configuration, the Project Member in that specific Role can invite other Roles. The same Project Member in different Roles can have individual configurations in Role can invite the following roles list. In this scenario, the list of Roles that this Member can assign will be the sum of these individual lists.
13. Project and Document Characteristics

Characteristics are descriptive tags that can be assigned to projects or documents to make them easier to find.

Characteristics are hierarchical. This means there can be different levels of characteristics for various product lines so that you can drill down through the information to find the exact characteristic desired when searching the database.

For example, you could create a master characteristic for Electronics, and then various sub-characteristics for types of appliances, entertainment equipment, or computers, and so forth. They are presented in a tree format - main categories with expandable branches. The characteristics tree configures the available characteristic names as well as how they are organized.

13.1 Create a Characteristic

1. Click Admin > Characteristics
2. Do you want to add a primary characteristic (a main category) or a secondary characteristic?
   - To add a primary characteristic, select the option button next to Root at the top of the tree and then click New Characteristic.
   - To add a secondary characteristic, select the option button for the characteristic under which to add the new one, and then click New Characteristic.

   There can be up to 17 levels of characteristics or at most 256 characters for the entire characteristics path from the root characteristic to the deepest-level characteristic.
3. Enter the name of the characteristic in the Name field.
4. Click Create. The new characteristic appears in the list.

13.2 Edit or Delete a Characteristic

When deleting a characteristic, WebCenter checks if the characteristic or any of its child characteristics are assigned to any Projects or documents. If such a dependency is found, you are prompted to remove the dependency and delete anyway, or cancel the deletion.

1. Click Admin > Characteristics
2. Do one of the following:
   - To edit a characteristic, click its name in the tree structure. Type a new name in the Edit Characteristic page and click Change to confirm.
   - To delete a characteristic, select it in the tree and click the Delete Characteristic link.

   If there are no dependencies, it is deleted immediately. Note that any sub-characteristics of the selected characteristic will also be deleted.
14. Project and Document Attributes

Basic concepts
Attributes are a way to assign user-configurable fields and their values to documents and projects. They can be:

- **Prompted** so that the user has to set a value each time it is used,
- **Calculated** from an ArtiosCAD formula,
- restricted to a group of preset values (a Restricted Set).

The Restricted Sets must exist before you can use them when creating an attribute.

Attribute Categories group attributes together for convenience. An attribute must be put into an attribute category before it can be used; however, the same attribute can be in multiple categories.

You must create an Attribute Category before adding attributes to it.

14.1 Restricted Sets

14.1.1 Create a Restricted Set

1. Click **Admin > Attributes > Restricted Sets > New Restricted Set**.
2. Enter information in the fields as appropriate:
   - **Name**: the name of the Restricted Set, up to 35 characters.
   - **Type**: the data type of the Restricted Set. There are six allowed types: **Area**, **Distance**, **Float**, **Integer**, **Text**, **Volume**, and **Weight**.

   A **Float** is a number containing a decimal point and an **Integer** is a whole number.

   The labels in parentheses after the name of the type indicate the units of measurement used in Imperial and Metric systems.

   - **Value**: an entry for the restricted set. Text values can be up to 255 characters long.

   Click **Add** to add the value to the set and clear the **Value** field. Enter as many values as desired, clicking **Add** after each one.

   **Tip:**
   You can sort the **Values** list using the , and , or click the **Sort** button to sort it alphabetically (for **Text Type** Restricted Sets).

   You can also select one or more values and click **Remove** to remove them.
3. Click **Create** to create the Restricted Set.

### 14.1.2 Edit a Restricted Set

1. Click **Admin > Attributes > Restricted Sets.**
2. Either filter or click **Go** to show the restricted sets.
3. Click the name of the restricted set to edit.
4. Change the name, or add and remove values as desired. You cannot change the type.

**Note:** If you remove a value, the next time you access a project using the deleted value, you will be prompted to change it.

5. Click **Change** to make the changes.

### 14.1.3 Delete a Restricted Set

WebCenter checks if a Restricted Set is being used before deleting it. If it is in use, you will be prompted to either clear the restricted set from the attribute using it, or to cancel the deletion.

1. Click **Admin > Attributes > Restricted Sets.**
2. Either filter or click **Go** to show the restricted sets.
3. Select the checkbox of the restricted set to delete and click **Delete Restricted Set(s)** in the actions menu.
4. Click **OK** when asked to confirm the deletion.
5. If the restricted set is not being used, it is deleted immediately.

### 14.1.4 Export / Import Restricted Sets

You can **Export** and **Import** restricted sets.

- **To export**, go to **Admin > Attributes > Restricted Sets**:
  a) Click on the **Import** link.
  b) Browse to a previously saved XML file.
  c) Select **Actions > Export**.
  
  This will start a download of an XML containing the Restricted Set.
  d) Save this on your computer.

- **To import**, go to **Admin > Attributes > Restricted Sets**:
  a) Select the **Restricted Set** to export.
  b) Select **Actions > Export**.
  c) Click the **Import** button.
  
  If the restricted set exists, it will be overwritten with the new values. If it does not exist, it will be created.
Note: This is similar to exporting / importing attribute categories and task types. The exported category will contain the exported restricted sets in the same XML file. While importing this in a new system, the restricted sets and attribute categories will be created.

14.2 Attributes

14.2.1 Create an Attribute

1. Click Admin > Attributes > New Attribute.
2. Enter information in the fields as appropriate:

<table>
<thead>
<tr>
<th>In the field...</th>
<th>Fill in the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name of the attribute (for example, Billable).</td>
</tr>
<tr>
<td>Description</td>
<td>description of the attribute contents (for example, Indicates whether work on this project should be billed by finance).</td>
</tr>
<tr>
<td>Type</td>
<td>the type of the attribute. You can select from the drop down.</td>
</tr>
</tbody>
</table>

Document References are attribute-links pointing to different document sources. When you select this option, you will have more options. Read more in Create a Document Reference Attribute on page 200.

Floats are numbers containing a decimal point (e.g. 3.1415) and integers are whole numbers (e.g. 42).

Rich Text attribute type allows you in entering long and/or rich text. You can:
- add set of least 16 different colors.
- set the text bold and italic.
### In the field... | Fill in the...

- use bulleted and numbered lists.
- Heading up to four levels and also add tables.

In the **Preview** you will see the Rich Text editor. Click the **Show Rich Text Controls** link to view the broad pallet of text options. The Project Managers with change properties rights can add content from a document to the Rich text editor window. Here, the text (also Chinese, special characters), font types, bullet types, color, tables and headings are preserved.

### Values

choose either:

- **Prompted** if you want to allow the user to enter any value.

- **Calculated** if you want to use an ArtiosCAD formula to calculate the attribute value (enter the ArtiosCAD formula in the field).

  **Note:** You should set **Calculated** attributes to **read-only** as their values are automatically updated from ArtiosCAD and should not be changed by WebCenter users.

- **Restricted Set** to limit the possible values.

  **Note:**
  To choose a Restricted Set, it must be created before defining the attribute (see **Create a Restricted Set** on page 152). Make sure that the **Type** of the Restricted Set is the same as the attribute type.

  **Note:** For **Document Reference** attributes, you will have only **Prompted** as the value.

### 3. Select **Attribute is also a task specification** if you want to be able to use the attribute as a task specification.

For more information about task specifications, see "Basic Concepts of Task Management" in the User Guide.
4. Click Create.

14.2.2 Edit an Attribute

1. Click Admin > Attributes
2. Click the attribute to edit.
3. Edit the attribute as desired (change the Name, Description...).
   
   Note: You cannot change the attribute type.

4. Click Change to make the changes.

14.2.3 Delete an Attribute

When deleting an attribute, WebCenter checks if the attribute or any of its child attributes are used in any projects. If it is, you are prompted to remove it from the project and delete anyway, or cancel the deletion.

1. Click Admin > Attributes
2. Select the attribute to delete and click Delete Attribute(s) in the actions menu.
   
   If the attribute is not being used, it is deleted immediately.

14.3 Attribute Categories

14.3.1 Create an Attribute Category

1. Click Admin > Attributes > Attribute Categories > New Category.
2. Enter the name of the Attribute Category to create, for example Shipping Instructions.
3. Click Create.

Once you have created the attribute category, you can add attributes to it, define views, etc.

To do this, click the Attribute category was created successfully. Edit ... link (see Add Attributes to an Attribute Category on page 157 for details).

14.3.2 Rename an Attribute Category

1. Click Admin > Attributes > Attribute Categories.
2. Click the attribute category to rename.
3. Type the new name in the Edit Category page.
4. Click Save.
Note: Click **Save As Copy** if you want to duplicate the attribute category under the new name, while keeping the original category as it was.

### 14.3.3 Add Attributes to an Attribute Category

1. Click **Admin > Attributes > Attribute Categories**.

   The **Edit Category** page shows two columns: the available attributes (that you can add to the category) at left, and the attributes that are already in the category at right.

2. To add attributes to a category or remove them from it, use the chevron (<< or >>) buttons to move them between the two columns.

   **Note:**

   Moving attributes between columns takes effect immediately.

   Attributes you have added to the category have an * in the left column.

   **Tip:** Use the search field to filter the available attributes list, and the and buttons to change the order of the attributes in the category.

   You can see a **Preview** of your attributes under the columns.

3. Click **Save** when you are done.

### Attributes Views

#### Default View

When adding attributes to a category, only the **Default View** of the category exists at first (you can add other views). The **Default View** is the view that will be shown in the project or document details (on the **Attributes** page).
Note:
Users can edit attributes in the default view if they have **Change Properties** right on the project (for project attributes) or on the folder containing the document (for document attributes).

When editing attributes, they **must** fill in attributes that are **required** (they have a red `*`).

They cannot edit attributes that the Admin made **Read Only**.

### Creation View

If you have added a **Creation View** of the attributes, users see it when they:

- create a project with attributes,
- create a document placeholder from a document template with attributes,
- upload one or multiple documents with attributes.

![Creation View](image)

Note:
- If you haven’t added a creation view, users will see the default view instead when performing those tasks.
- When editing attributes, users **must** fill in attributes that are **required** (they have a red `*`). They will not be able to create the project / document placeholder if they don’t!

Users cannot edit attributes that the Admin made **Read Only**.
Header View
If you have added a **Header View** of the attributes, users see it in the header of the project or document details page.

> **Note:**
> - If you haven’t added a header view, users will **not** see attributes in the project or document header.
> - Users cannot edit attributes in the header view.

Task Type View
If you have added a **Task Type View** of the attributes, users see it on the task details page for documents attached to a task of that specific task type.

Viewer View
You can create dedicated **views** to allow your users to view the active document’s **attribute category** in the Viewer.

If you have configured your **attribute category** with such Views, your users can view this in the **Attributes widget**.

For example, you can create **attribute category** based checklists for different **roles** / **groups**. When a **user** from that **role** or **group** views the documents with that **category**, this attribute checklist will be visible in the viewer. Read more about this use case in: [https://wiki.esko.com/pages/viewpage.action?pageId=170047115](https://wiki.esko.com/pages/viewpage.action?pageId=170047115).

As another example, you can use this to view your document references in the Viewer. If you have more than one CAD document references associated with your graphics file, you can create a Viewer view for these attributes with specific **source** and **rendering** configurations. Your user will then be able to change a reference from the Viewer and save this configuration.

> **Note:** Only the users with **Project** / **Folder** level **Change Properties** permissions can change and save attributes from the **attributes** widget.

Read also: **Add Viewer Views** on page 160.

Add Attributes Views
- To add a creation view:
  a) Click **Add Creation View** in the **Edit Category** page.

    The attributes in the category are copied from the default view to the creation view.
  
  b) Use << to remove any attributes you don’t want to show in the creation view.
Add Viewer Views

You can create dedicated views to allow your users to view the active document’s attribute category in the Viewer.

If you have configured your attribute category with such Views, your users can view this in the Attributes widget.

For example, you can create attribute category based checklists for different roles / groups. When a user from that role or group views the documents with that category, this attribute checklist will be visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?pageId=170047115.

As another example, you can use this to view your document references in the Viewer. If you have more than one CAD document references associated with your graphics file, you can create a Viewer view for these attributes with specific source and rendering configurations. Your user will then be able to change a reference from the Viewer and save this configuration.

Note: Only the users with Project / Folder level Change Properties permissions can change and save attributes from the attributes widget.

To create a Viewer View:

- Click Add View in the Edit Category page.
  You will get a pop-up to type in the view name.
- Type the name of the View. You can create a general Viewer view for all users or views dedicated to a particular role / group.
  You can create the following views:
  - Viewer for a general Viewer view of the attributes.
• **Viewer [Role]** with the specific **role** name as a suffix. This view will be visible in the **Attributes** widget of the Viewer when a member of that **role** opens the document.

• **Viewer [Group]** with the specific **group** name as a suffix. This view will be visible when a member of that **group** opens the document.

**Note:** It is important that you name your **views** exactly as above

You will be switched to the newly created **view**. All your attributes from the **default view** will be copied into the new one.

• Use << to remove any attributes you don’t want to show in the **Viewer** view.

**Note:**

You cannot add attributes to these views if they are not already in the default view. If you need more attributes in the Viewer view:

1. Select the **Default** view in the **Current View** drop down.
2. Add attributes.
3. Switch to the **Viewer** view in the **Current View** drop down.

The attributes added to **Viewer, Viewer [Role]** or **Viewer [Group]** will be visible in the Viewer.

• If your Viewer view is for **document reference attributes**, create specific **source** and **rendering** configurations.

• **Save.**

<table>
<thead>
<tr>
<th>If your Attribute Category</th>
<th>and your User Role / Group is... The Viewer will have...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only Default Viewer, Viewer Designer Legal</td>
<td>Any None Designer Legal</td>
</tr>
</tbody>
</table>

**Viewing Attributes**

**Edit the Terminology for Project Creation**

It is possible to change the terminology used for project creation so that the Project Creation page talks about "Designs" instead of "Documents", or "Roles" instead of "Placeholder Groups", for example...

You can achieve this by customizing the terminology in the attribute category of the project or template used as a basis for project creation.
You need to:

1. Click the attribute category to use on the Attribute Categories page.
2. Add a Creation or Header view to your attribute category and click Save.
3. Click Edit Terminology.
4. In the Edit Terminology pop-up, fill in the custom terms you want use instead of the default project creation terms.

   For example, fill in Designs in the Documents field if you want to show "Designs" instead of "Documents" on the project creation page.

   Any field left blank will still use the default term.

![Edit Terminology](image)

**Attention:** Your custom terms will not be automatically translated, and will show as you enter them for all languages in which you run WebCenter.

### 14.3.4 Delete an Attribute Category

WebCenter checks if an Attribute Category is being used before deleting it. If it is in use, you will be prompted to either clear the category from the projects or documents using it and delete the category, or to cancel the deletion.

1. Click Admin > Attributes > Attribute Categories.
2. Select the attribute category to delete and click Delete Category in the actions menu.
If the attribute category is not being used, it is deleted immediately.

### 14.3.5 Use a Grid Layout

Adding a grid layout to your attribute category allows you to customize the way your attributes will be shown to users.

It also provides more advanced features, like making an attribute required (users have to fill it in) or read only.

1. **Click** **Use Grid Layout** in the **Edit Category** page.

   This shows extra options and buttons on top of your attributes column, and a **Details** table at right, containing information and extra options for the selected attribute.

2. **Select** **Alternating background** if you want your rows to have an alternating background color.

3. **Select** **Show also attribute types and restricted set types** if you want the types of the attributes / attributes restricted sets to be displayed after each attribute (like **Business Unit** in the example above).

   When checked, pages having this attribute category or task specification layout will not keep the session alive. This allows you to fill out long forms without having to log in repeatedly.

4. **Optionally enable** **Keep Session Alive** to avoid getting timed out.

   You need to check this during the creation of the attribute category so that, the users do not get timed out during filling in the request forms (attribute category) in the projects. If you did not check this option, your users will get timed out after 30 minutes.

5. **Add or remove columns and rows as desired:**

   - Click **add** to add a row at the bottom of the table.
   - Select a row and click **add** to insert another row before it.
   - Select a row and click **remove** to remove it.
   - Click **add** to add a column at the right of the table.
   - Select a column and click **add** to insert another column before it.
• Select a column and click to remove it.

6. If you want an attribute to be displayed across several columns, select it and enter the desired number of columns in Span Columns in the Details table.

7. Format your grid as desired:
   • To add a Title row, click then fill in the Title, choose the number of Columns to span and the title Style in the pop-up that opens.
   • To add a Spacer bar, click then fill in the bar’s Height and Color in the pop-up that opens.

Note:
• You can use color names or hexadecimal codes.
• If you don’t enter a Height, the bar will have a default height.
• If you don’t enter a Color, the bar will be white.

• To add a Ruler, click then choose the number of Columns to span and fill in the Height and Color in the pop-up that opens.
• To add a Header Bar, click .
The example below has a **Header Bar** on top (showing **Name**, **Value** and **Type**), then a **Title** (Packaging information), a blue **Spacer** bar, and a black **Ruler** after two attributes.

![Preview](image)

**Note:** You can edit the formatting (color, height...) in the **Details** table at right when you select the cell.

8. You can change how an attribute will appear to the user by giving it a **Label** (in the **Details** table). For example, you could use a label to show Manufacturer in: instead of Country. This is particularly useful if the users are not familiar with your attributes, or if you are using generic attributes for different purposes.

If you set the labels on top for at least an entire column, you will have a nice form layout.

9. Select the **Position** of the Label as either **Left** or **Top**.

By default, the **Label** will be placed on the left side in the grid. But you can place it on top of the value to modify the form appearance.

A single cell will contain both the Label and the Value. Within this cell, you can manage alignment via the style options.

![Component Type](image)

10. You can also format individual attribute cells using **Styles** (see *Define Styles* on page 166).

11. If desired, change the visibility of individual attributes: select a cell and choose the **Visibility** parameter to use:

   - Choose **Editable** if you want the users (with the right permissions) to be able to edit this attribute.
   - Choose **Required** if you want to make it mandatory for users (with the right permissions) to fill in this attribute.

   If a user doesn’t fill in a **Required** attribute during project creation for example, he / she will not be able to save the project.

   - Choose **Read Only** if you don’t want **any** user to be able to edit this attribute.
   - Choose **Hidden** if you don’t want to show this attribute to users. The values will be deleted in this case.
• Choose **Hidden (Keep Values)** if you don’t want to show this attribute to users but keep the value.

**Note:** You can also use visibility **Rules** to determine when an attribute will be hidden / required / read only... See **Add Rules** on page 167.

12. Click **Save** when you are done.

**Define Styles**

Define styles to further customize your attributes layout.

1. Select the cell of the attribute to customize.
   
   This show the **Details** table at right.

2. Click **Add Style** to define a custom style.

   **Note:** You can also use one of the predefined styles (**WebCenter Attribute** or **WebCenter Title**) if you want your attributes to have the default WebCenter look.

3. Define your style: enter a **Style Name**, a **Background Color** (use the color name or the hexadecimal code), choose a **Font Family**...

You can fix the **Column width** of the first column to keep the titles aligned.

Set the **Column width** lower than what you want as there is some margin for the columns. The total table takes the full width of the allowed/available space (depending on the browser). Therefore fixing the width of one column has an effect on the other columns.

**Tip:** Do not fix the width of all columns as it will lead to unpredictable results.

Click **OK** when you are done.

You can see your style applied to the attribute cell in the **Preview**.

To apply it to another attribute cell, select the cell then select the style in the **Details** table.
You can edit or delete the style using the links in the Details table.

Note: Once you have defined a style in the Default view, you can use it in the Creation view, and vice-versa.

Add Rules

If you want an attribute to be hidden / required / read only... depending on a condition, you should define a visibility rule for this attribute.

A rule makes the visibility of an attribute depend on one or more other attributes.

1. Select the cell of the attribute for which you need a visibility rule.

   This show the Details table at right.

2. Click Add Rule to define a visibility rule.

3. In the Edit Rule pop-up that opens, give your rule a name (choose a name that indicates what the rule does).

4. Define your rule.

   For example, you want the attribute Number of samples to only be visible (and filled in) if the Sample Needed attribute is set to Yes.

   a) You need to first define the condition: If The value of attribute Samples Needed = Yes.
   b) Then define what happens when this condition is fulfilled: The cell is: Required.
   c) Then define what happens when it is not fulfilled: Else, the cell is Hidden.

5. Click OK when you are done defining your rule.

   The Preview is updated to reflect the result of your rule.
Note:
The Preview is interactive: in the example above, you can choose Yes for the Samples Needed attributes in the Preview, and see the Number of samples attribute displayed.
You can choose No (or nothing at all) and have that attribute hidden.

To apply the rule to another attribute cell, select the cell then select the rule in the Details table.
You can edit or delete the rule using the links in the Details table.

Note: Once you have defined a rule in the Default view, you can use it in the Creation view, and vice-versa.
Note:
You can create more complex rules by clicking the And link to add more conditions. Choose AND if both conditions should be fulfilled, or OR if at least one of them should.

You can define very complex rules if necessary.
In the example below, a warning message is made visible (but read only) when somebody requests more than 10000 samples or asks for more than 4 spot colors.
The warning message itself can be a title or an attribute (that you can use in several attribute categories).

14.3.6 Enhancing Attributes with Advanced Features from Grid Layout
You can enhance the attributes from the Grid layout view. You can restrict values to available cascading attributes, create multi-value attributes, add label images and add HTML help to the attributes.

- Click Use Grid Layout in the Edit Category page.
- You can add LookUp Attributes on page 170 button next to your Attributes in your form.
- Click on any of the attributes. Its details will appear on the right side.
• **Label Image:** You can add a representative image as a label image. Read more in *Create Image Label for an Attribute* on page 174.

• **Restrict Values:** You can restrict values to list containing *Cascading Dropdowns* as columns and select their rendering.
  
  You can also create check boxes, radio buttons and image selectors for text type list attributes.

• **Allow Multiple Values:** You can allow more than one value to an attribute. Read more in *Create a Multi-Value Attribute* on page 175.

• **Info Page:** You can provide additional information in an HTML page. Read more in *Create HTML Information for an Attribute* on page 177.

**LookUp Attributes**

You can use *LookUpAttributes* button to fill multiple attribute fields based on one or more input attributes without a cascading dropdown. You can configure the list in the details of this button. You do not have to restrict individual attribute values to a list when using this button.

You can create a better user experience with this feature if a lot of properties must be loaded for something already well-known / unique. The typical example is loading product details or component details when you enter the product code. In this case, when you type the code and click the button, you will get all its details filled.

When you have partial / non-unique information, use *Cascading Dropdowns*.

1. **Create and add attributes to an Attribute Category.**
2. **Select your attribute** in the *Grid Layout*.
3. **Click on the LookUpAttributes button to add it next to the selected attribute.**
   
   You will see the *Button details* in the *Details of selected cell* table.
4. Modify the button’s details.
   - You can specify the **Label** text you want to display next to your button.
   - Pick a **Style** for the button to change its look.

   **Note:** If you choose **Hidden**, you can **Execute** the button:
   - **On Save**
   - **On Load**
   - **On Change of Attribute** where you need to specify the attribute

   - Select a list.

   **Note:** You can use the **lists created on the WebCenter database. Cascading dropdowns placed on Web Server are not supported.**

   - Set **Function** to **LookUpAttributes**.
   - Add one or more **Input Attributes**. Select the attribute from a list of attributes in your category and match it to the right **list Column**. Click on **Add Input Attribute** to add more.
   - Enable **Exact** to only allow exact matches. For example, if the input attribute is country name and if you type Belg, you can get Belgium if the **Exact** is off. If this is on, you will find country details only if you type Belgium entirely.
   - Add all the **Output Attributes**. Select the attribute from a list of attributes in your category and match it to the right **list Column**. Click on **Add Output Attribute** to add more. This will correct your (typed) input attributes to the official value. If you type Belg and click the button, the entry value will be Belgium. This will also add the other details associated with this attribute.

5. You can now test the button and **save**.

**Check Unique Values**

This feature allows you to create a unique name for a component. It helps to create names which are different from existing names.

However, this is not useful if you are creating pure numbers (where you expect auto-numbering). Use auto-numbering in such cases.

**Note:**

This function does not guarantee that the values are unique throughout the system.
1. Create and add attributes to an Attribute Category.

2. Select your attribute cell in the Grid Layout.

   **Note:** This function does not work for date attributes or rich text attributes. You will be warned if you use any of these types.

3. Click on the Add button icon to add it next to the selected attribute. You will see the Button details in the Details of selected cell table.

4. Modify the button's details.
   - You can specify the Label text you want to display next to your attribute.
   - Pick a Style for the button to change its look.
   - Set Function to CheckUniqueValue.

5. Now save.

   **Note:** This function is difficult to test via the preview because the checks are done based on the current project, document or task. In the preview, you have no document, project or task.

   In a project attribute category, it checks whether the filled out value already exists for another project in the system. If yes, you will be warned that it is not unique. The function will force you to choose another value before you can save the attributes or create the project (during project creation).

   In a document attribute category, it checks whether the filled out value already exists for another document in the system.

   **Note:** This function does not check the versions of the current document. So multiple versions of the same document may share the same attribute value.

   In a task type, it checks whether the filled out value already exists for another task of any task type.
Note:
This verification happens when you click the button or when you save the checked attribute. This check will not happen if you change the attribute in any of following ways:

- via a system integration (WebCenter SDK)
- via Automation Engine
- when changing a group of attribute values via the project saved search operations
- when setting the attribute via a workflow
- when setting the attribute via ArtiosCAD

The check button must be in the visible view. This way you can have a check which only happens during creation or in a task type view.

Note: A unique value for a task does not guarantee that this value does not exist for a project. So this function is not of use while using automatically set project attribute values from task specifications.

Create JavaScript Button

A JavaScript button allows you to create a powerful additional functionality within a WebCenter form.

⚠️ Warning: This is an advanced feature and we recommend that only Esko solution architects and advanced administrators use this.

Use this to:

- execute a calculation within the form
- copy information from a project to a document created in the project
- automatically fill out values for attributes (which are specified as read-only)

Note:
The JavaScript operation is done within the form. However, this may not be automatic in all cases. For example, when you copy project attribute values to documents, the JavaScript execution happens once. When the project attribute is changed, the document attribute will not be synchronised until the button is clicked again. This avoids issues related to full synchronization.

Read JavaScript examples in the Esko Knowledge Base Article..

In the screen shot, you can see a simple calculation in the **JavaScript Code** field. An attribute with name **Price Estimation** is automatically set based on the value of attributes 'L', 'W' and 'Price_per_m2'.
Note:

- Do not return a value but set the value of att[‘MyAttribute’]
- All attribute names must be surrounded by single quotes
- All attribute names are case sensitive
- Use the attribute name. This can be different from the attribute label visible in the form
- The property att is case sensitive.

- Technical info: att is an associative JavaScript array containing a copy of the current values for all placed attributes. At the end of the execution, (only) the changed values are copied back into the form.

- Use this only if you know JavaScript and its use. Consult your Esko Solution Architect in case you need JavaScript operations.
- The function is protected against misuse by only allowing to change attributes contained in the current attribute category. This also shows message boxes. The function cannot change any other data in WebCenter (for example it cannot execute web calls).

Create Image Label for an Attribute

You can create Project request forms or Order forms with graphical labels by setting image labels for specific Attributes in an Attribute Category. You can use this feature to make the form visually attractive and user friendly. In addition, you can add graphical (packaging) symbols and warnings to aid the user while filling in the forms.

1. Add the label images to the following folder on the WebServer: WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom\AttributeLabelImages.
   
   Create a new folder custom if it does not exist yet and create a folder named AttributeLabelImages under this folder.

Note:

- For the best user experience, use .jpg images. It does recognize .gif, jpeg and .png.

2. Open your Attribute Category and select the Attribute for which you want to give an image label.
3. In the cell details, enter the correct image name including the extension in the Label Image field and save your attribute category.
Note: The image name is case sensitive.

You can see image labels appearing instead of attribute names in the forms.

Tip: In case you wish to display a check box for the attribute, make sure you use an attribute with a restricted set containing only the values Yes and No.

Note: You can either have a text label or an image label, but not both.

Create a Multi-Value Attribute

There are situations when you are creating a new Project or filling in a Form, more than one value needs to be added as an attribute. For example, if you are producing a packaging that is intended
for more than one market, you need to specify those markets as values in the respective attribute field. You can use a multi-value attribute for this purpose.

- Open your Attribute Category and select the Attribute for which you want to give more than one values.
- In the Details for the selected cell table (in the Grid layout), enable Allow Multiple values.

In your Project (as a form), you will have the particular attribute with an option to select more than one (or all) values in its response field. See an example below.
Note:
Simple text attributes were limited to 255 characters until WebCenter 14. There is no character limitation from WebCenter 14 onwards. This allows for unlimited attribute values for a single multi-value attribute.

Create HTML Information for an Attribute

When you design Project request forms or new Order forms, you might want to provide additional information to the user who is filling in the information.

From WebCenter 12 onwards you can provide additional information as HTML help or information. This is especially useful when technical fields need to be supported with extended HTML help.

There will be an information icon that is added next to the attribute name or attribute image label. When the user clicks on this icon, a pop-up HTML page with the information will appear.

1. Create an HTML file with the additional information you want to provide along with the attribute. You can create textual information as well as images to explain the attribute.
2. Place this HTML file in the AttributeHelp folder (WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom\AttributesHelp).
3. Open the Attribute category and select the attribute for which you want to provide HTML help or information.
4. In the cell details, enter the correct file name (of the HTML file) in the Info Page field and save your Attribute Category.

If you have an HTML information page linked to an attribute, you can see an information icon next to the attribute in the form that you created. When you click on the information icon, you can see a pop-up window with the information to help the User.
Check box, Radio button and Image selector in your Attribute Category

You can decide the rendering of choices for a restricted set (text) and for list attributes (text). The default rendering is a drop down with the options. You can show the options as:

- simple radio buttons or check boxes
- radio buttons or check boxes with images

This allows your users to see the options more clearly than in the case of a drop down.
Create Radio buttons and Check boxes

When you have a few options as the value for an attribute, you can present the options via radio buttons or check boxes instead of a drop down.

**Note:** Avoid doing this when you have a lot of options to select from. The form will load slow.

1. Create and add attributes to an Attribute Category.
2. Select your attribute in the Grid Layout.
   - An item **Restrict Values** will be visible in the Details section.
3. Select the Rendering as Radio / Checkboxes.

In the Attribute Category Preview, you will see a set of checkboxes or radio buttons depending on the items in the restricted set or valid items in the list column.

You will get Radio buttons for a single-value attribute.

```
Product Details
```

You will have check boxes for a multi-value attribute. Select the **Allow Multiple Values** option for this.
Note:
This is optimized for non-cascading type of restricted sets. You may also use them for cascading dropdowns with limited values. Avoid using it when more than two attributes cascade.
Do not use this option for lists with thousands of rows.

4. Select the Column numbers, Alignment and the Label position.
   You get the best user experience when the number of columns equals the number of allowed values or one of its dividers. If you restrict it to one column, you will get a vertical array.

Create Image Selectors
You can use images just like Radio/Check boxes.

1. Create and add attributes to an Attribute Category.
2. Select your attribute in the Grid Layout.
   An item Restrict Values will be visible in the Details section.

3. Select the Rendering as Images.
- The images must be placed on `webinstance\custom\AttributeValueImages`. You can use the same images used in the Asset Browser as selectors.

  **Note:** The image names are case sensitive.

  **Tip:** You can create Push Through Configurations to access the `AttributeValueImages`, `AttributeLabelImages` and `AttributesHelp` on the Web Server. This way your users do not have to access the web server to customize the attributes.

- **Height of Images:**
  You can resize the images by adjusting the height. By default, resizing is always done proportionally and to 100 pixels. You can get high quality images when you create images with the sizing specified here.

- **Height of Cell:**
  The grid of images can take a lot of screen space. If you want to limit the space use and use a scroll bar, limit the height of the cell. In this setting, the cell will have a fixed height and a scrollbar when the needed size to show all images extends to given height.

- **Image Type:**
  You can choose the Image Type as automatic to display any of the image types. However, we recommend that you select an Image Type in this field.

![Image examples]

**Troubleshooting**

- **When you do not see any images at all:** Verify the path where the images are located. If you have multiple web server instances, you must have the images on each instance (or at least on the instance where you try).

  **Note:** Do not put your images for image selectors in the `AttributeLabelImages` folder.

  Check the extension of the images.

  **Note:** The name and the extension are case sensitive.

- **When some images are missing:**
  Verify if there are any special characters. Avoid all the special characters (comma, %, …etc) except space.
Check leading and trailing spaces and number of spaces in the names.

14.3.7 Restrict Attribute Values to Previously Selected Values

To setup a practical way to make a final selection from a previously made/calculated list of candidates, a new function has been introduced.

It applies to attribute categories or task specifications with a grid-layout having a first multi-value attribute (attribute A) and a second simple text, non-restricted set attribute (attribute B).

The result is Attribute B is restricted to the selected values of attribute A

This can be set up only by administrators and used by all users who can edit attributes.

Usage:

Select Attribute B in the grid layout. In the cell details, set the Restrict Values selector on Attribute. This will display a dropdown with candidates for attribute B (this list is all plain-text multi-value attributes).

Select one of the candidates. This results in a behavior as shown in the below example: Final Country (which is attribute B) is restricted to the selected values for Possible Country.

Details/Limitations:

- This function only works in grid layout
- Attribute A and B must both be plain text attributes. Attribute A can be a restricted set or a plain text attribute (typically linked to a cascading dropdown).
- Attribute A must be multi-select
- Attribute B cannot be a restricted set or linked to a cascading dropdown
- Attribute B can still be multi-value, so you can select multiple values from the selected values of attribute A
- In search, attribute B is NOT shown as a dropdown, so it behaves as a simple text
• The dropdown only appears when the attribute is editable, else the selected value(s) is/are simply displayed as for a plain text attribute
• Auto-select: When attribute A has only 1 value selected, this value is automatically selected for attribute B.
• Auto-deselect: When attribute B has a value and attribute A's values are changed so that the value for attribute B is no longer a selected value for attribute A, the value for attribute B will be deselected. In case attribute B is multi-value, this logic is applied to each value separately.
• It is allowed that attribute A is itself restricted by yet another attribute.
• This function works identically for task specifications
• It is allowed to set visibility rules on both attribute A and attribute B
• When attribute A is taken away from the attribute category or if it is deleted from the system, attribute B becomes a plain text attribute. All set values are however remembered (even if they are multi-value, they will be displayed in their base form “value 1 | value 2”).
• When no values are selected for attribute A, nothing is displayed for attribute B (no empty dropdown either).

14.4 Cascading Dropdowns

Cascading Dropdowns contain a set of dependent attributes. The choice of one attribute limits the choice of other attributes in these Dropdowns. These attributes will be visible as a drop down while building your forms and projects. This allows you to customize and build intelligent forms. Using these, you can:
• retrieve relationships among values (for example, brand-sub brand roles).
• auto-fill the values depending on the relationship (if you select a brand, a brand description will be filled in).
• do smart filtering (if you select a brand, you can filter the products that are available under the brand).
• use in advanced searching (Asset Browsing). Read more in Asset Browser on page 95.
• Look Up attribute values buttons in attribute categories and task type specification forms.

You can create Cascading dropdowns as:
• Lists on page 183 based on WebCenter Database.
• Cascading Dropdowns based on Excel sheets placed on the web server.

**Note:** We recommend that you reconfigure the attribute categories and task types to use the database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

14.4.1 Lists

Lists contain a set of dependant attributes imported into WebCenter. The Lists data is added to the WebCenter database and maintained in a WebCenter Project or Template. Therefore, you can modify this data from WebCenter interface.

Also, you can control the access to this data by setting project permissions.
Note: This works in the same way as the List Data imported from Excel sheets. However, you can use larger data sets with these Database Lists. Read more about Lists from Excel sheets in Cascading Dropdowns from Excel Sheet on page 190

Adding a new List

- Upload your Excel (either .xls or .xlsx) or XML document to a project or template named ListManager. If this project does not exist yet, create a new project named ListManager.

  In this project, you can create folders for different departments, setup approval cycles to approve your lists before it is fully configured.

Note: If you are uploading your lists to the ListManager template, only your administrators can see the lists.

- Go to the Admin > Attributes > Lists page.
- Click New List.
  You will see the New List configuration page.
- General List Information: Specify the List Name and a Description
- Input Source Properties:
  - Specify the Input Source Type. It can be either Excel or XML document. The Select Document drop down will list the Excel or XML files uploaded to the ListManager project.
    - Excel: Select the input Excel file from the Input Source Type drop down. Specify the Sheet Name of the Excel sheet containing the List data.
    - XML: Select the input XML from the drop down and specify the XML Main Node.
  a) You may enable the Flush existing list data before updating the list option to clear the old data from the List before updating with new data.
    With this option on, whenever you upload a new version of the Excel / XML input document, the data from the List will get deleted before the List data gets updated.
  b) You can enable the Database user name and password are required when deleting data from list as a security measure.
    If you have enabled this, you have to specify a database user who has the permission to change the database schema. The database SA (System Administrator) user can also change the schema.

Important: We recommend that you enable this option to avoid accidental deletion of Lists and List Data.

- Log File Folder: Select this from the drop down listing the folders in the ListManager project.
  This folder will contain the log files associated with individual Lists. The respective log files gets updated when you add or modify List data. You can also set permissions for this folder so that only your administrators can access the logs.
- Database info:
  - Create new database table for storing the data: Select this when you want a new database table for your list.
When this is selected, a WebCenter database table is created whenever you create a new List. You need to specify the database user credentials to be able create new database tables.

Note:
If you check the **Use the built-in 'webcenter' database user account to create the database table**, the SA user has to give the database Create Table rights to the default 'webcenter' user account. In this case, you do not have to specify the database SA user credentials for creating new list tables.

- **Use an existing database table for storing the data:**
  Specify an existing table in the WebCenter database for storing the List data. The columns in this database table and your List need to match. You do not have to specify database user credentials to use an existing table for creating lists.

- **List Properties:** You can configure your **Input Columns** in the **List Properties** table.
  - Specify the columns relevant for the List here by selecting or deselecting.
    By default, the column names of the database table will be the same as the input column names. You may also change the Column names.
    
    **Note:** The List column names should be unique.

- You can select a particular column as **Unique Identifier**. When you enable this, each value in this List column has to be unique (for example, Product Names). It is possible to select more columns as **Unique Identifiers** (for example, Product Name-Product Variant combination).
  
  **Tip:**
  If you have selected more than one **Unique Identifier** columns, the combination of the values in these columns have to be unique. For example, in the case of Product-Variant combinations, you can have the same Product name repeated for each of its Variants.

  **Note:** When you are updating the list, make sure that the new data matches the **Unique Identifier** column. If the new data does not match the identifier values, new rows will be created. This does not apply if you have enabled the **Flush existing list data before updating the list** option.

- **Click** Create List.

  The Lists are displayed in the Lists overview page.Clicking on a specific List will lead to the **List Details** page. You can **inspect your List data** here.

  **Note:** If you update the source XML or Excel document, the List Data will get updated.

**Inspecting List Data**

- Go to the **Admin > Attributes > Lists** page. The Lists overview page displays all the existing Lists. The source document and the creator’s name is also listed in this page.
- **Click on the name of the List you want to inspect.**
• In the List Details on page 186 page, click Show List Data to see all of your list data.
  You can filter on a list column with a specific value to make the inspection easier.
• Click Return to List Overview to return to the general Lists overview page.

List Details
The List Details page contains an overview of the following:
• General List information
• Input source properties:
  Use the Excel/XML Document link to view the document’s action history.
  You can also access the Log file from the respective link.
• List properties
You can:
  • inspect a list's data by clicking on Show List Data
  • delete a list or its data

Unique Identifier
You can select a particular column as Unique Identifier. When you enable this, each value in this
List column has to be unique (for example, Product Names). It is possible to select more columns as
Unique Identifiers (for example, Product Name-Product Variant combination).

Tip:
If you have selected more than one Unique Identifier columns, the combination of the values in
these columns have to be unique. For example, in the case of Product-Variant combinations, you
can have the same Product name repeated for each of its Variants.

Note: When you are updating the list, make sure that the new data matches the Unique Identifier
column. If the new data does not match the identifier values, new rows will be created. This does not
apply if you have enabled the Flush existing list data before updating the list option.

Deleting a List or List Data
You can remove an existing List completely from the system or remove only the List data.
1. Go to the Admin > Attributes > Lists page.
2. Click on the List Name from the Lists table.
   This will lead you to the List configuration page.
3. Choose either the Delete List Data option or Delete List option.
4. Enter the Database User name and Password if required.
   If you are deleting one of the Lists, you always have to enter the database user credentials.

Note: If you are deleting the List Data, you have to enter the credentials only if the Database
user name and password are required when deleting data from list option was enabled while
creating the List.
5. Click **Delete List** or **Delete List Data** to confirm.

**Note:**
The deletion does not check if the List being deleted is in use by any of the attribute categories. This will result in malfunctioning of the features using that attribute category.

To restore the affected attribute category, create a List with the same name as the deleted List.

To restore your deleted List Data, update the corresponding input file in the Listmanager project with a new version.

---

**Using Lists as Cascading Dropdowns**

You can use **Lists** in the same way as the *cascading dropdowns from Excel sheets*.

1. **Add and configure your List.**
   
   Go to **Attributes > Attribute Categories** or Task type specification form and click on any text attribute field.

   **Note:**
   
   - Make sure you are in **Grid Layout**.
   
   - Bring a text attribute into one of the cells.
   
   - Make sure that it is not a **restricted set**. You cannot view the lists of cascading attributes in the **restricted sets** category.

   An item **Restrict Values** will be visible in the **Details** section. You can see the cascading attribute lists based on the web server (if any) and the database lists as lists. These are now available for use in your **Projects** and **Forms**.

   **Note:** You cannot re-use a column of a list in more than one attributes belonging to one attribute category. *You can replicate the list temporarily to add the same column to another attribute of the same attribute category.*

2. Do this for multiple attributes that are required and you will see the cascading behavior.
   
   When you select a value for one attribute, the other attribute values are restricted to what is allowed according to the List data.

---

**Replicate List Data in an Attribute Category**

If you have to use the same list data multiple times for multiple attributes, you can copy the list to these attributes. If you need two bar code selectors for your packaging component, you will need two fields in the form with the same drop down.

1. **Add and configure your List.**

2. In the Admin mode, go to **Attributes > Attribute Categories** or Task type specification form and click on any text attribute field.

   An item **Restrict Values** will be visible in the **Details** section. You can see the cascading attribute lists based on the web server (if any) and the database lists as lists. These are now available for use in your **Projects** and **Forms**.
3. Select the List from the Lists drop down. Click Copy List.

This way, you will get a second cascading drop down configuration without duplicating the data on the database. You will get a new entry in the list drop down with the same list name with (2) as suffix. You can do this multiple times and the suffix changes accordingly.

4. Add more attributes to the category and select values from the replicated Lists.

Note:
These copies are only available in the attribute categories where the List was replicated. If you save the attribute category without linking any attributes to the copied Lists, they will be removed.

Configuring List Columns in an Attribute Category

You can customize the list columns in an attribute without changing the database list. You can:

• change the order of the columns in the cascading drop down. You can create cascading drop downs with different column ordering using the same database lists.
• allow other values in the list.

1. Add and configure your List.

Go to Attributes > Attribute Categories or Task type specification form and click on any text attribute field.

Note:
• Make sure you are in Grid Layout.
• Bring a text attribute into one of the cells.
• Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute lists here.
2. Click on the **Configure List** link.

3. In the resulting dialog, you can use the arrows to change the order of the columns in the cascading drop downs.

   **Tip:** You can configure the list column order to create a cascading tree in search results for your asset browser. In the example above, you can change the **Region** to a higher level using the arrow to move up.

4. By default, the cascading attribute values are corrected when one of the corresponding values change. Disable the **Correct the previous entries when a selection is not valid** option if you do not want your cascade to correct entries automatically. This allows you to select combinations that are not present in the referenced list.
5. You can also specify whether the attribute values restricted to a list column should be allowed to have non-list values. Enable **Allow Other Values** to do so.

- If you have turned the **Allow Other Values** option off, only the list column values can be selected as a value. This means that if you have an empty field, you cannot type anything there.

- If the **Allow Other Values** option is on, you can type in an attribute value. The other attributes in the the same cascade will not be filtered to the new value until you save the attributes.

  **Note:** This configuration is **attribute category** specific. So the column in the database list remain the same.

- If the **Allow Other Values** option is on for a multi-value attribute, you can click on the **Other Value** link on the top to enter a non-list value. As a result, you will get an additional row to enter the new value. You can create multiple rows this way.

14.4.2 Cascading Dropdowns from Excel Sheet

Installing Cascading Dropdowns from Excel Sheet

Cascading dropdowns can be installed in WebCenter version 10.2 and later versions. You can create Cascading Dropdowns by following the steps below.
Note: We recommend that you reconfigure the attribute categories and task types to use the database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

1. Go to WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom. Create a folder named excel under the custom folder if it is not present.
   Only for WebCenter 10.2 users: go to webapp\javascript\cascading dropdowns and copy the two javascript files to webapp\javascript. We recommend that these two files are backed up.

2. You need to place an XML file named lists.xml and the excel file (with your attributes to be imported) in the excel folder.
   From WebCenter 12 onwards, you will find an example XML file called lists.xml and excel sheets in the excel folder under webapp\custom_example.

3. Adapt lists.xml according to your requirements, within the structure given in the example file.
   See an example below:

```xml
<lists>
  <list>
    <name>Countries and Managers</name>
    <file>CountryList.xls</file>
    <type>Excel</type>
    <sheet>Country</sheet>
    <column><columnName>CountryName</columnName></column>
    <column><columnName>CountryCode</columnName></column>
    <column><columnName>Region</columnName></column>
    <column><columnName>CountryManager</columnName></column>
    <column><columnName>RegionManager</columnName></column>
  </list>
  <list>
    <name>Countries</name>
    <file>CountryList.xls</file>
    <type>Excel</type>
    <sheet>Country</sheet>
    <column><columnName>CountryName</columnName></column>
    <column><columnName>CountryCode</columnName></column>
  </list>
</lists>
```
Note:

- `<lists>`: This tag is obligatory in this code. You can specify the rest of the details regarding the importing attribute list under `<list>` tag. In the above example, two attribute lists are being imported.

- `<name>`: You can specify the name of the list which should appear among the WebCenter attribute lists after this tag. There are two lists in the above example. The lists are named Countries and Managers and Countries. These names appear in as List names in the Restrict Values option.

- `<file>`: You should indicate the file name (including the .xls extension) after this tag. In the above example, it is CountryList.xls and this file is placed along with lists.xml in the custom folder.

- `<type>`: This should be Excel.

- `<sheet>`: Here you should specify the name of the work sheet in the excel file. Please avoid special characters and spaces in the sheet name. The sheet name in the above example is Country. You can make more than one lists from one sheet.

**Remember:**

You cannot make one list from the columns placed in different sheets.

As shown in the example, you can make two lists from the same excel sheet or from different sheets in the same excel file.

- `<column>`: Each column in the excel sheet should be specified separately under the `<column>` tag for each of the lists. In the example, five columns are specified under the list named Countries and Managers and two columns under the list named Countries. The data from the specified columns will be imported into WebCenter attribute categories.

- `<columnName>`: You should indicate name of the column here. Excel files get column names from the values placed in the first row. Please avoid special characters in the column names.

4. Save and close the lists.xml file. Make sure that your XML is XML-compliant and in the right folder (excel).

5. Login to WebCenter as an admin. In the attribute category definition (Attributes > Attribute Categories and in Grid Layout), click on a text attribute (not on a restricted set).

A Restrict Values item will be visible in the Details section. This shows a dropdown with the lists you have configured in lists.xml.

These lists will have the values from the columns of the excel sheet.
Note: If you are uninstalling WebCenter, the custom folder should be backed up and placed back in the same location as before to restore the Cascading Dropdown functionality in the new installation. If this folder or one of the files is missing, you will lose the installed Cascading Dropdowns.

Using Excel based Cascading Dropdowns

The cascading attributes that have been imported will be visible in the attribute category definition. You can see a dropdown with the lists you have configured in lists.xml here. These dropdowns are filtered to the row combinations from Excel worksheets.

An example use case is when you want to use all your brands and sub-brands and the respective managers to be filled in to the project or for when you choose a product. If you have an excel file with the information that needs to be imported into WebCenter, you can import this by following the steps described in Installing Cascading Dropdowns from Excel Sheet on page 190.

1. Create an Excel file with Column Names in the first row and fill the columns with your brand related information that needs to be in the WebCenter Cascading Attributes.

   Note:
   - Please note that the columns that should be part of one list should be placed in one Excel Sheet. It is not possible to make one list out of the data placed in different sheets.
   - The Cascading Dropdowns are filtered to the row combinations from the specified worksheet. The linking of row combinations is currently only possible for the columns placed in one Excel sheet.
   - We recommend you delete the first empty lines at the bottom of the Excel sheet to avoid the Excel driver picking up completely empty lines and producing them as valid combinations.
   - Make sure you save the Excel file as a .xls and not as a .xlsx file.
   - The current driver for Excel sheets does not support Asian characters. Installing another driver can help solving this problem, but Esko does not have an out-of-the-box recommendation at this time.

2. Adapt lists.xml according to the information from the Excel file. Save and close the file.

   The Excel file and the XML file should be placed in the folder named excel. See the location of the folder below.
<lists>

<list>
  <name>Esko Brands and Managers</name>
  <file>ESKO_Records.xls</file>
  <type>Excel</type>
  <sheet>Esko</sheet>
  <column><columnName>Brand</columnName></column>
  <column><columnName>Category</columnName></column>
  <column><columnName>ProductManager</columnName></column>
  <column><columnName>Director</columnName></column>
  <column><columnName>SeniorVP</columnName></column>
</list>

<list>
  <name>Esko Group</name>
  <file>ESKO_Records.xls</file>
  <type>Excel</type>
  <sheet>Esko</sheet>
  <column><columnName>Group</columnName></column>
  <column><columnName>Ecosystem</columnName></column>
</list>

</lists>

See more on installation of this feature in Installing Cascading Dropdowns from Excel Sheet on page 190

Note: You can define more than one lists using columns from a single Excel sheet.

In the Admin mode, go to Attributes > Attribute Categories and click on any text attribute field.
Note:

- Make sure you are in Grid Layout.
- Bring a text attribute into one of the cells.
- Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute lists Esko Brands and Managers and Esko Group as lists. These are now available for use in your Projects and Forms.

3. Create attribute categories which contains the product and brand specific information and save it.
   a) Create specific attributes. Select the type as text if you want to have Cascading Dropdowns in the Details. Read more about creating attributes in Create an Attribute on page 154.

Attribute Details

Define attribute's Name, Description, Type then click Finish.

Name: Esko Group
Description:

Type:
- Text
- Boolean
- Textbox
- Dropdown
- Cascading Dropdown
- Link
- Integer
- Float
- Time
- Date
- DateTime
- Long text
- Code
- Code List
- Number
- List
- File
- Video
- Image
- Table
- Calculated
- Calculation
- Subscription

Specification
b) Create/edit **attribute category**. Bring these attributes to this category in the **Grid layout**. In this example, an attribute category is created with Esko brand related attributes. See the screenshot below.

c) **Select the List** and **Column** in the **Restrict Values** Section for each of the attributes that needs to contain Cascading Dropdowns. **List** indicates the list names given in the **lists.xml** file and **Column** indicates the column names in the Excel sheets associated with that list.

d) **You can have more than one values in the attribute fields by enabling Allow Multiple Values.** In the above example when a product has to be associated with more than one Ecosystems, you can enable **Allow Multiple Values** with more than one Ecosystems.

When you have defined attribute category with lists and columns, you will have Dropdowns available in each of the fields and it will respect the row combinations of Excel values. Therefore, when you select one value in a specific attribute field, the related information will be smartly filtered and automatically filled in if there is only one possible value left for those attribute fields.

The dropdowns interact in such a way that only those values are shown which are linked to the already chosen values for other columns. This will be a very handy feature when complicated forms have to be filled in.

In the example here, you can see that when WebCenter is selected, all the associated information is filled in from the same list. The associated data come from the columns of the list **Esko Brands and Managers**.

**Note:**

If you would like smart filtering and automatic fill in, the columns have to be specified in the same list in **lists.xml**.

If you want independent columns with all values irrespective of the selection, define separate lists.
Note:

You can apply rules to these lists to induce advanced customization. For example, you can set one attribute (Brand description) to be read-only. As a consequence when you select the attribute Brand (editable), the brand description (read-only) will be automatically filled in.

4. Apply the attribute category with embedded lists containing imported information to any related project or documents. You can also use these attributes to build Asset Browsers. Read more in Cascading Dropdowns on page 183

Note: Cascading dropdowns are used in setting up an Asset Browser. Read more in

Troubleshooting

When a column contains lots of numbers, non-numbers are no longer appearing in the dropdown and the numbers are displayed with .0 after them

This is caused by the excel reader (which is a piece of Microsoft code) trying to figure out the data type in the column. It does not work according to the formatting type and therefore changing the formatting would not solve the problem. So if half (approximately) of the values are numbers, it interprets them as numbers and dumps all the rest. We are looking for a solution by enforcing the numbers to be interpreted as text.

To work around this problem, you can do add space to each value to make it pure text. The procedure to do this automatically is detailed below.

- Make a new column.
- Copy the header from the original column to this new column.
- Change the original column name.
- In the new column, set the value for the first (non-header) row to CONCATENATE(" ",X2). Here, X is the new column with the original data.
- Copy this to all rows (select the cells from the just entered cell all the way down and do a Ctrl-D).
- Save your file and close it.
The Restrict values choice does not appear in the cell details while selecting a cell in the Attribute Category layout

You need to make sure that you:

- are in the **Grid layout**
- choose the right **attribute type** for the selected cell. It should be text (simple, not rich text) type.
- did not choose a **restricted set**.

If all the above settings are correct and you do not have the **restrict values** option, you have to check the configuration of the lists.xml. If WebCenter fails to find a lists.xml, it assumes that there are no lists and therefore does not show the **restrict values** option. The most likely cause is that lists.xml is not at the right location. It should be placed **under** `WebCenter\WebServer\tomcat\webapps\WebCenter_Inst\custom|custom`.

Check also the access rights to see if the access to read the xml is given.

The problem could arise if your lists.xml is not well-formed (not a valid xml). To check this, open the file with Internet Explorer. If you get a message "The XML page cannot be displayed", it indicates that your XML is not valid. Internet Explorer also points to other errors.

**I get an error message in the Attribute Category layout**

You will get an indication about what is going wrong by reading the error message. Most errors look like below:

- **Cannot read list Project Code**
- **error:**
  
  java.sql.SQLException: [Microsoft][ODBC Excel Driver] Cannot open database '(unknown)'. It may not be a database that your application recognizes, or the file may be corrupt. xxx\custom\excel\Products.xls

Check whether:

- the Excel file is open. You can check it by opening it yourself. If it is opened by someone else, Excel warns you about it.

  **Note:** You need to close it after you open the Excel file. If you leave it open, it might result in the error described above.

- Check the location of the Excel file.
- Cross check the name of the Excel file with the one from the error message.
- Check for any typing errors in lists.xml.

**I get an error message “List xxx is no longer configured”**.

This means that the **attribute category** points to a list which is no longer configured correctly in XML file (lists.xml). In this situation, all dropdowns will be replaced by simple text fields.

**The dropdowns do not appear during project creation, document upload or attribute editing**

Open the **Attribute category layout** as admin and see whether you get an error message. This situation points to the removal of lists.xml or one of its items.

**After a re-install my Cascading dropdowns no longer appear.**

If you are uninstalling WebCenter, the custom folder should be backed up and placed back in the same location as before to restore the Cascading Dropdown functionality in the new installation. If this folder or one of the files is missing, you will lose the installed Cascading Dropdowns.
14.4.3 Why Use Database Lists instead of Web Server Lists?

<table>
<thead>
<tr>
<th>Database Lists</th>
<th>Web Server Lists</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Higher Security</strong></td>
<td>These are maintained in the protected WebCenter database.</td>
</tr>
<tr>
<td></td>
<td>You need advanced setup through IIS configuration to prevent security breach.</td>
</tr>
<tr>
<td><strong>Reliability</strong></td>
<td>Existing database drivers are reliable.</td>
</tr>
<tr>
<td></td>
<td>The Excel reading driver is system dependent.</td>
</tr>
<tr>
<td></td>
<td>This limits access to one reader at a time.</td>
</tr>
<tr>
<td><strong>Scalable</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The scalability is poor.</td>
</tr>
<tr>
<td><strong>Easy Update</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Difficult to update configurations. When you update, you have to save your custom Lists folder separately</td>
</tr>
<tr>
<td><strong>Easy administration</strong></td>
<td>You can manage these via the WebCenter interface. Even non-administrators can update the master data if the administrators allow this.</td>
</tr>
<tr>
<td></td>
<td>Administration only via the web server.</td>
</tr>
<tr>
<td><strong>Faster data loading</strong></td>
<td>The attribute category loads information bit by bit ensuring a better user experience.</td>
</tr>
<tr>
<td></td>
<td>Excel based lists are loaded entirely when the form is loaded. This slows down the form data loading.</td>
</tr>
<tr>
<td><strong>Unlimited List Size</strong></td>
<td>We have tested the Lists with up to 200,000 rows of data.</td>
</tr>
<tr>
<td></td>
<td>There is also a limitation to the size of the data (maximum of 15000 rows in the Excel sheet). The driver used is limited to 64K rows which would make a product list with 100,000 products non-practical.</td>
</tr>
<tr>
<td><strong>Support for .xlsx files</strong></td>
<td>Only .xls files are supported.</td>
</tr>
</tbody>
</table>

Important:
WebCenter 14 is a 64-bit system using only 64-bit drivers. In order to continue using the web server based cascading dropdowns, you have to install this 64-bit driver. Read more info on 

Esko Knowledge Base.

14.5 Document References

You can make use of [Document References](#) to specify product and its components or master-child relationships. Using this feature, you can create an attribute link to refer to a document that is located within another project or a document library.

The document reference attribute behaves like a normal attribute which can be added into any attribute categories. However, you can configure them to provide document sources for your projects. For example, when you are re-using your existing marketing statements or claims for individual packaging projects, you can store them in a library and use document references in your future projects to link to them.
Both Projects and Documents can have document references. You can also create and use document reference task specifications.

You can:

- configure the document reference links to access specific projects designed as document libraries, or to access saved searches or asset browsers.
- store your text statements in a library project. Using document references, you can link to relevant text statements from each of your individual packaging projects.
- configure the file types of documents for these links. You can link a 3D file to one or more CAD files as document references where the reference links are configured to add only .ARD files.
- configure a document reference attribute to point to multiple documents.

It is possible to specify attributes specific to the document reference attribute links. For example, your packaging project for a box can have a document reference link to an artwork PDF. The specific barcode can be linked to this document reference via a reference category.

**Note:** You will see warnings when deleting a document that is referenced elsewhere in WebCenter.

### 14.5.1 Create a Document Reference Attribute

Creating a document reference attribute is similar to creating an attribute.

1. Click Admin > Attributes > New Attribute.
2. Enter information in the fields as appropriate:
<table>
<thead>
<tr>
<th>In the field...</th>
<th>Fill in the...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>name of the document reference attribute</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>description of the attribute contents (for example, link to the CAD shape document).</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>select document reference as the type.</td>
</tr>
</tbody>
</table>

Document References are attribute-links pointing to different document sources. When you select this option, you will have additional options.

| Values         | will be set to Prompted by default. |

<table>
<thead>
<tr>
<th><strong>Versions and Revisions</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this field to point to the exact version of the document you need as the document reference link. This is especially useful when you want to point to an approved version. By default, it points to the latest version, but you can set this to:</td>
<td></td>
</tr>
</tbody>
</table>

- **Latest Version**: When you select this, the document reference link will be updated to the latest version of the document.

**Note**: When you update the referred document, the document link will point to the latest version regardless of the Change Properties permissions in the Project > Security tab.

- **Selected Version**: Use this setting if your document reference link should point to a certain version always. In this case, the document reference will not be updated to point to the latest version when a new version of the reference document is uploaded.
In the field... | Fill in the...
---|---
• **Selected Revision**: When you choose this, the document reference will always point to the latest version of the selected revision.

Note: When you update the referred document, the link will source the latest version of the selected revision regardless of the Change Properties permissions in the Security tab.

**Reference Category**

To apply a reference category to the document reference, select from the drop-down listing all the attribute categories.

Note: Rich text attributes and document reference attributes cannot be used as reference attributes.

You can use a reference category (which is an attribute category) to assign certain attributes to the document reference link. This is very useful when the property is not linked to the product or the component specifically. You can use reference categories to specify properties of the reference links.

3. Select **Attribute is also a task specification** if you want to be able to use the attribute as a task specification.

For more information about task specifications, see "Basic Concepts of Task Management" in the User Guide.

4. Click **Create**.

**Document Versions and Revisions**

Use this field to point to the exact version of the document you need as the document reference link. This is especially useful when you want to point to an approved version. By default, it points to the latest version, but you can set this to:

• **Latest Version**: When you select this, the document reference link will be updated to the latest version of the document.

Note: When you update the referred document, the document link will point to the latest version regardless of the Change Properties permissions in the Project > Security tab.

• **Selected Version**: Use this setting if your document reference link should point to a certain version always. In this case, the document reference will not be updated to point to the latest version when a new version of the reference document is uploaded.

• **Selected Revision**: When you choose this, the document reference will always point to the latest version of the selected revision.
Note: When you update the referred document, the link will source the latest version of the selected revision regardless of the Change Properties permissions in the Security tab.

Note: When you upload a new version or revision of the reference document, your Preferences > Security settings will over-write the above settings.

- When the Allow changing attributes of approved documents option is turned off, the document references (as project attributes or task specifications) will not be updated to point to the latest versions.
- If the setting Allow changing attributes of inactive projects is turned off, the document references of such projects will not get updated to the latest revision / version.

Reference Category

You can use a reference category (which is an attribute category) to assign certain attributes to the document reference link. This is very useful when the property is not linked to the product or the component specifically. You can use reference categories to specify properties of the reference links.

For example, you can:

- define the position of a text fragment (document reference link) in an artwork.
- size of a barcode on a box. The barcode is the document referenced in the box and the size of the barcode is an attribute of the document reference link.

Note: This feature is only available with the Lifecycle Management License.

To apply a reference category to the document reference, select from the drop down listing all the attribute categories.

Note: Rich text attributes and document reference attributes cannot be used as reference attributes.

Deleting Documents used as Document References

- When you try to delete documents (or document versions) being used as references elsewhere, you will get a warning message with a list of projects / documents / tasks where it is being used as a reference.

When you confirm the deletion, the documents / version will be deleted.
14.5.2 Edit a Document Reference Attribute

1. Click Admin > Attributes
2. Click the attribute to edit.
3. Edit the attribute as desired. You can change the Name, Description, Versions and Revisions, Reference Category and Attribute is also a task specification.

4. Click Change to make the changes.
14.5.3 Delete a Document Reference Attribute

1. Click Admin > Attributes

2. Select the attribute to delete and click Delete Attribute(s) in the actions menu.
   
   If the attribute is not being used, it is deleted immediately.

3. If the document reference is being used elsewhere, you will be asked to confirm the deletion.
   Choose from:
   
   • clear the attribute from the Project(s), Document(s), Document Reference Attribute(s) or Category(s): When you select this option, your document reference attributes and its values are deleted from the projects / documents / where it is being used. However, the original document or its attributes are not deleted.
   
   • Cancel deletion.

14.5.4 Document References in an Attribute Category

You can set up the document references with advanced options in the attribute category grid layout page.

Document reference attributes appear just like the other attributes in this page.

Read Configure a Document Reference Attribute in a Category on page 205.

Document References in One Column

Note: You need the Life cycle management license to place and edit the document references with its advanced features. If you do not have this, the list layout is the only available option. In the list layout, you will have a simple preview:

• multiple values are always supported
• default style
• drop down rendering when multiple values are added (when editable)
• document references are always rendered as a set of hyperlink read-only.

Configure a Document Reference Attribute in a Category

You need to use the Grid Layout for the advanced features associated with the document reference attributes within the cell of an attribute category.

• To add document reference attributes to a category or remove them from it, use the chevron (<< or >>) buttons to move them between the two columns.

You can see a Preview of your attributes under the columns.
When you add a document reference attribute, you can setup advanced options in the details table:

- Check **Allow Multiple values** to allow the reference to multiple documents. This feature is detailed in *Create a Multi-Value Attribute* on page 175.
- **Reference Category** is a read only field which refers to properties specific to this document reference link. This field is set during the creation of the document reference attribute. You can specify an attribute category for each document reference attribute to define the properies of the reference / link. Read more in *Reference Category* on page 203.
- **Version Mode** refers to the document version you are referencing to. This field is also set during the creation of the document reference attribute. Read *Document Versions and Revisions* on page 202.
- **Document Source**: You can configure different types of document sources for a customized document reference link.
  a) Click **Edit Configuration**.
     You can configure *your document sources* in the *Edit Document Source Configuration* pop-up.
  b) Click **Add document source** to add more document sources for this document reference attribute.
  c) If you have different attribute views, you can setup different source configurations.
     Read more in:
     - *Adding Document Sources for a Document Reference Attribute* on page 207.
     - *Document Sources for Different Attribute Views* on page 208.
- **Rendering**: You can setup a **Simple** or advanced **Table** display of the document reference links in a Project / Template / Forms.

<table>
<thead>
<tr>
<th>If you select your rendering as:</th>
<th>The result will be...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>The document references will have:</td>
</tr>
<tr>
<td></td>
<td>the document name as a hyperlink. Click this link to open the document in a new tab.</td>
</tr>
</tbody>
</table>
If you select your rendering as: | The result will be...
---|---
• a thumbnail. Click on the thumbnail to open the document in the Viewer.  
• a delete button  
• up/down arrow to re-order the document list.  

Table  
An advanced table depending on your configuration. For example, you can configure editable attributes into your table.  
Read more details in: *Create an Advanced Table Rendering* on page 209

• **Save** the attribute category.

A user with attribute update permissions can:

• delete a document from the list of document references.
• add a document. The **document sources** as configured will be available as a header to the simple / table rendering.

**Note:**

1. If **allow multiple values** is turned off, document source links will appear next to the added document in the same row.
2. Without the necessary upload rights to the folders of the project, a user cannot add documents to them.

• change the order of the referenced document.

**Adding Document Sources for a Document Reference Attribute**

You can configure your **document sources** (such as a Project/template which serves as a library of assets, a Saved search of your assets, or your document templates) in the **Grid layout**. Your configured sources will appear in the places (such as templates or forms you have designed) where you set the document reference categories.

You can configure:
- a simple **Browse** link for the user to upload a document.
- **Document Templates** from the template library. This will serve as a place holder with pre-configured settings such as attribute categories. Read more about templates in *Document Templates* on page 63.
- **Current Project**
- **Saved Search**: Use this option to allow the user to select a file from a saved search. When the user clicks the document reference as a link (with a custom **label**), saved search results will appear in a pop-up with all the configured options.

You can specify settings for your users:

- the **Label**
- the **Details** such as:
  - the **document template** library
  - the name of the **saved search**
  - allowed file extensions
- the type of **operation** depending on the document source. You can allow the users to:
  - copy
  - link
  - move
  - use by reference
- the destination folder

Options are similar to the *Project / Template document creation settings*.

**Tip:** You can setup different configurations for different attribute views.

### Document Sources for Different Attribute Views

There is always one document source configuration assigned to a document reference attribute in a category depending upon the **view**. In the **default view**, the name of this configuration will be "AttributeName" _Default.

You can create dedicated document sources for custom **attribute views**. When you are in a custom **view**, click **Create Configuration for the Current View** to create a custom document source.

You will get an **Edit Document Sources Configuration** pop-up with a copy of the default setup.

Create a new setup for the current **view** and click **OK**. To revert to the default, click **Return to Default View Configuration**.

**Note:** **Return to Default View Configuration** will delete the current configuration and restore the default.
In other views, the configuration name can be:

- "AttributeName" _Default if the configuration in the current view is inherited from the default view.
- "AttributeName" _ViewName if the view has its own configuration. If the configuration is shared with another view, ViewName can be from the other view.

Create an Advanced Table Rendering

Adding an advanced table of document references allows you to customize the way your document will be shown to users when they are applied (For example, in a template).

It also allows you to configure advanced features such as making an attribute of the document required or read only.

*Note:* The document reference attributes will inherit the style specified in the attribute category. This style is further expanded to the individual document’s attributes as well.

- Click Use Grid Layout in the Edit Category page. Add your document reference attributes.

- Select the Rendering as Table in the grid layout.

In the Edit Render Configuration dialog, you can set up the advanced rendering.

*Note:* You can create custom tables for your different views.

- Enable Hide Header if you do not want a header row in the document references table. The labels will be displayed in line for each document.

- Click Add Column to add more columns to the table.

The rows in the Edit Render Configuration pop-up correspond to your document reference columns.
• Select **Type** as **Document Name** which is a mandatory field:
  
  Your rendering will have a clickable link to the document depending on the user permissions.

  ![Document Name](box_sprint2.ord)

  The name will not be clickable for users without document view permissions.

• Depending on how your **document properties** should be rendered, configure the table columns. You can create custom **Labels** for your selections. The properties will be displayed as **read-only**.

<table>
<thead>
<tr>
<th>Choose Document PropertyDetails as...</th>
<th>The result in the rendering table will be...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Description</td>
<td>The selected document properties will appear in the table header with the custom <strong>label</strong>. For example:</td>
</tr>
<tr>
<td>• VersionRevision</td>
<td>• the current Approval Stage of the document. The user can click to access the approval pop-up.</td>
</tr>
<tr>
<td>• VersionAuthor</td>
<td>• Clickable thumbnail of the document with the default (50x50) or specified pixels.</td>
</tr>
</tbody>
</table>
| • Project                             | ![Version](version.png)  
  
  | estado de aprobación | etapa de aprobación |
  
  | 1 |  
  
  |  
  
  | Stages 2 |
| • ApprovalStatus                      |  
  
  | ApprovalStage                       |  
  
  | 1 |  
  
  | Etape 3 |
Choose Document Property Details as...

The result in the rendering table will be...

<table>
<thead>
<tr>
<th>Tip:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Create custom <em>labels</em></td>
</tr>
<tr>
<td>• Specify the pixels for your <em>thumbnail</em>.</td>
</tr>
<tr>
<td>• Check the box <em>Allow uploading a new Version</em> button</td>
</tr>
</tbody>
</table>

• *Upload New Version* button if you have the rights to upload will be available in the *Version* column.

You can configure *document actions* in the table rendering of the document references. The actions will appear next to the documents listed in the table only when it is relevant.

Choose Document Actions as...

The result in the rendering table will be...

| • View                                                                 |
| • Open in 3D                                                           |
| • Open in ArtiosCAD                                                   |
| • Download                                                           |
| • Upload New Version                                                  |

• A 3D button will be available only when there is an existing 3D perspective.

• *Open in ArtiosCAD* option will be available for CAD files. Clicking on it will open the CAD document as set up in the *preferences*.

• *Download* option will be available when the user has download permission.

• *Upload New Version*: This is available when the user has the rights to upload new version.

Note: The *Upload New Version* button can also be placed in the Version column by checking the *Allow uploading a new version* check box.
Note:

- If you change the attribute values during the upload of a new version, these are only applied on the new version of the document. The previous version will have the old attribute values.
- If a document version is linked in multiple projects, all linked projects will get the new document version.
- Configure how your document attributes should be displayed. Select the relevant attribute from the drop down as a specific column (with a custom label) in your table.

<table>
<thead>
<tr>
<th>Components</th>
<th>▼</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Code</td>
<td>▲</td>
</tr>
<tr>
<td>Component Name</td>
<td></td>
</tr>
<tr>
<td>Component Number</td>
<td></td>
</tr>
<tr>
<td>Concepts</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>ConnectArea(sq ft, sq m)</td>
<td></td>
</tr>
<tr>
<td>Construction of Pack Efficient?</td>
<td></td>
</tr>
<tr>
<td>Consumer Insight</td>
<td></td>
</tr>
<tr>
<td>Contact Name</td>
<td></td>
</tr>
</tbody>
</table>

Specify the Visibility of the attribute as...

- **Editable** if you want the users (with the right permissions) to be able to edit this attribute.
- **Required** if you want to make it mandatory

The result in the rendering table will be...

- The selected document attributes will be displayed in the table header and its values in the respective columns.
Specify the Visibility of the attribute as...

- for users (with the right permissions) to fill in this attribute.
  
  • **Read Only** if you don’t want any user to be able to edit this attribute.

The result in the rendering table will be...

- The users can type in the values for the editable attributes.

<table>
<thead>
<tr>
<th>Weight</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1g</td>
<td>May 26, 2015</td>
</tr>
</tbody>
</table>

**Note:** You can configure the Visibility also at the attribute level. If your settings differ, the most restrictive setting will be applied.

**Tip:** Click **add column** and select another attribute to have more attributes listed in your table.

**Tip:**
You can configure a project’s document reference attributes to be non-editable and still allow the user to edit the attributes of the documents referenced.

Your user can do this from the project’s attribute category tab.

**Tip:**
Optionally, you can setup the Project > Notifications > Project Attribute/Category change to receive notifications about document references.

Reference category changes will be notified according to the Project > Notifications > Document Attribute/Category change settings.

- Configure Expand Attributes / Collapse Attributes button for your document references. This allows you to expand or collapse the document attributes of your references.

**Tip:** You can configure different expand attributes settings for different views. Specify the view name here.

**Edit the Visibility as...**

<table>
<thead>
<tr>
<th>The result in the rendering table will be...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>read-only</strong></td>
</tr>
<tr>
<td>• <strong>editable</strong></td>
</tr>
</tbody>
</table>

**Note:** The user needs Change properties right to edit attribute values.

Click to expand the document attributes (which may also be document references):

**Tip:** Keep this editable, if your users have to edit the document reference’s attributes.

When the document attributes are expanded, you can use to collapse them.
• Select the relevant reference properties and specify if you want it to be editable / required / read-only.

Reference properties are attributes (reference category) of the document reference link. You can select one of them from the attribute drop down in the Details cell.

Note: Reference Property field is only available when a reference category is specified for the document reference.

<table>
<thead>
<tr>
<th>Specify the Visibility of the reference category attribute as...</th>
<th>The result in the rendering table will be...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Editable if you want the users (with the right permissions) to be able to edit this attribute.</td>
<td>• The reference attributes will be displayed in the table header and its values in the respective columns.</td>
</tr>
<tr>
<td>• Required if you want to make it mandatory for users (with the right permissions) to fill in this attribute.</td>
<td>• The users can type in the values for the editable attributes.</td>
</tr>
<tr>
<td>• Read Only if you don't want any user to be able to edit this attribute.</td>
<td></td>
</tr>
</tbody>
</table>
• You can allow the users to move a referenced document into the current project. To set this up, create a column with Local / Remote setting. Specify the visibility as editable or read-only.

If the setting is Editable, the user can click to move the document to a local folder. The users need Change Properties and Add permissions to move a document to local folder. The document reference will point to the local copies.

The user will be able to specify:
• a new name and description
• document template
• target folder

If the setting is Read-only, the user will see indicating remote project.

• Optionally, add:
  a) a Numbering column.
  b) Up / Down arrows to let the users change the sequence.
  c) a Delete Button to let the users delete the document references from the table.
• Save the configuration by clicking OK. To revert from this configuration, click Revert to WebCenter Default Configuration.
• Save the attribute category.
If the logged in user does not have permissions to view the document, the document table will have (based on the configuration):

1. **Document name** with !. The user will see a warning message.
2. Editable **reference properties** displayed in the specified columns
3. **Up /Down** arrows
4. **Delete** button
5. **Numbering** ("#")

**Note:** If the settings are not editable, the document table will have the document name and its sequence number.
Advanced Table Rendering for Custom Views

Note:
You can create dedicated table (of document references) for custom attribute views. When you are in a custom view, click Create Configuration for the Current View to create a custom table. You will get an Edit Render Configuration pop-up with a copy of the default setup.

Create a new setup for the current view and click OK. To revert to the default, click Return to WebCenter Default Configuration.

Note: Return to WebCenter Default Configuration will delete the current configuration and restore the default.

In other views, the configuration name can be:
- "AttributeName"_Default if the configuration in the current view is inherited from the default view.
- "AttributeName"_ViewName if the view has its own configuration. If the configuration is shared with another view, ViewName can be from the other view.

14.5.5 How to Create a Functioning Document Reference System

You can make use of Document References to specify product and its components or master-child relationships. Using this feature, you can create an attribute link to refer to a document that is located within another project or a document library.
This advanced feature allows you to create a system of references (like a "hanger" for your related assets) to keep a product and its parts together even when they are not located together. For example, the CAD file, the artwork, the die and its leaflet. For a display, its language variants, parts and artwork together.

To create such document reference system, you need:

- Reusable components stored in the form of libraries
- Document Templates
- Version / Revision aware Document Reference Attributes and other Attributes
- Attribute Categories with your document reference attributes and other types of attributes

Follow the steps below to create an advanced document reference system.

1. **Create WebCenter Projects as Libraries and organize your assets in them.**
   
   Examples for your libraries
   
   - Structural design files for your packaging shapes
• Graphical design files from the creative agency
• Standard design elements such as your brand logo, company logo etc.
• Symbols such as recycle symbols, warning symbols, Quality Symbols etc.

• Copy sheets as Word or Excel files with text statements for the Artwork
• Barcodes
To organize further, you can create advanced saved searches or SmartName searches.

2. Create your Attributes and Attribute Categories for the specification / packaging request.
For example, Production quantities, count, budget, material type, ink coverage, color, language variants, Barcode etc. Read:

• Create a Document Reference Attribute on page 200

• Reference Category on page 203

3. Create Document Templates with Attributes.
Your Project Managers can use Document Templates on page 63 as document placeholders for future project documents.

   a) Select document reference as the attribute type. reference category attribute (such as count) of the link. Read: Create a Document Reference Attribute on page 200.

   Examples:
   • Specify the version / revision of the document it should refer to.
   • Specify a reference category if you have properties that are specific to a document reference link. For example, count.

   b) Add the document reference attribute to an attribute category.
   • You can make the attribute read-only / editable / required by setting the visibility.
   • You can create a document reference where the user can add multiple documents by enabling allow multiple values.
   • You can use all the advanced features available in the grid layout.

Note: Link to the document templates in document creation settings of the Project Template.
c) Configure the **document sources** for the references. Choose the operation (copy, link, move, or use by reference). Read more in: *Adding Document Sources for a Document Reference Attribute* on page 207

The document references will be shown as links in the final rendering as per the **document sources** settings you configure here.
Create a custom label such as Select CAD from Library.

Specify the source of the document. For example, a saved search.

Specify the type of operation you would like your user to do. You can configure copy, link, move or use by reference.

d) Configure how the documents should be listed and whether the users can modify some of the document properties. To do this, create an advanced table rendering.

5. Create Project Templates and apply the document reference attributes and other attributes in an attribute category.
1. CAD documents are rendered in a **Table** configuration. The header contains custom labelled **document sources**. You have editable reference properties such as offsets configured in the table.

2. The customized **add ink** link will take you to the inks library to choose your inks for the current project.

3. The configured **Add icons** link will take you to a saved search. This document reference attribute is rendered as **Simple**. Therefore, the references appear as a list.

You can have documents stored in the local folder or referred in document reference links. However, the user gets the view of both the local and referenced documents together.
15. WebCenter Configuration

The Configuration menu contains entries for configuring e-mail notifications, LDAP authentication, push-through folders, BackStage / Automation Engine Approval clients, the System Info page, etc.

15.1 Configure E-Mail

You can set up e-mail configuration using the Admin module. All changes to the setup are effective immediately.

1. Click **Admin > Configuration > E-Mail Environment Setup**.

2. Provide the required e-mail settings:

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail Service Protocol</td>
<td>Set to the SMTP protocol.</td>
</tr>
<tr>
<td>E-Mail functionality enabled</td>
<td>To enable/disable e-mail functionality.</td>
</tr>
<tr>
<td>E-Mail debugging output in log</td>
<td>To enable/disable e-mail debugging output in log files.</td>
</tr>
<tr>
<td>E-Mail Service Host</td>
<td>Address for the preferred mail server that will act as the server for dispatching e-mail notifications.</td>
</tr>
<tr>
<td>E-Mail Service Port Number</td>
<td>Port number on which the e-mail server is listening for incoming e-mails.</td>
</tr>
<tr>
<td>Outgoing E-Mail Notifications &quot;FROM&quot; Address</td>
<td>Supply a valid e-mail address. This will be used as the &quot;From&quot; e-mail header for every e-mail sent by the system. This information is important for returning undelivered mail</td>
</tr>
<tr>
<td>Configuration Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(the filled-in address should belong to the administrator, since he will most likely be addressed with undelivered mail for troubleshooting).</td>
<td></td>
</tr>
<tr>
<td>E-Mail Session Authentication</td>
<td>Select this option if the mail server connection session should be authenticated using a username and password.</td>
</tr>
<tr>
<td>E-Mail Service Username</td>
<td>Mail account user name when authentication is required.</td>
</tr>
<tr>
<td>E-Mail Service Password</td>
<td>Mail account password when authentication is required. The password is stored in encrypted format.</td>
</tr>
</tbody>
</table>

3. Click **Send Testing E-Mail**.
4. Edit the contents of the test e-mail if required.
5. Click **Send E-Mail**.

A response will appear stating whether or not the e-mail could be sent successfully. There are 3 possible outcomes of the e-mail environment testing page:

- **Test E-Mail Sent**: The environment is set up correctly.
- **JMS System Error**: Communication with the JBoss proprietary messaging framework failed. An administrator should check the JBoss server configuration and/or log files for possible causes.
- **Mail Server Connection Error**: The connection to the specified mail server did not succeed. Either the data the administrator supplied on the e-mail environment setup page was incorrect, or the mail server is currently down. An administrator should either check the e-mail environment settings for possible misspellings or contact the mail provider as to the status of the mail server.

6. If necessary, return to the configuration page and correct the settings.

### 15.2 Configure Search Crawler Setup

You can change the **Search Crawler Setup** from the WebCenter Admin section.

1. Go to the Admin section and choose: **Configuration > Search Crawler Setup** from the main menu (default is enabled).
2. Use the **Search Enabled** option to enable or disable search.
3. Use the **Rebuild Index on Search Crawler Restart** to allow or disallow rebuilding the index upon search crawler restart (default is enabled).
4. Enable **Index Document Revisions** to index all the **Document Revisions**. If this is not enabled, the **Latest Version** for every Document is indexed.

**Note:** If this is enabled, your users can search for **revisions** on the Document Search page.
5. **Last crawl activity** shows the date and time of the last search crawl activity.

### 15.3 Configure External Web Connections

An external web connection is a connection to some data in an external system (usually a MIS system). The MIS system calculates the data (for example the cost/price information for an order) and WebCenter retrieves this data through the external web connection and displays it on a WebCenter page.

After configuring the external web connection, you can choose to add a link to it in a WebCenter top-level menu, project menu or a My Work section. See the Customization Guide for more details.

#### 15.3.1 Create an External Web Connection

1. Go to Admin > Configuration > External Web Connections.
2. Click the New External Web Connection link in the External Web Connections page.
3. Enter the Name to give your external web connection.
4. Enter the URL of the data you want to retrieve in your external system. This needs to be accessible by either the WebCenter Application Server or Web Server.
   
   You can use **SmartNames** in the URL. The supported SmartNames are:

   - all basic project properties (see List of Available SmartNames on page 268),
   - all project attributes,
   - Requestor SmartNames ([Requestor UserName], [Requestor Location], etc...). Here, Requestor indicates the user who is logged in.

   These SmartNames will be resolved when activating the connection, depending on the context. This means that for example:

   - if you are using the [Requestor UserName] SmartName, it will be resolved to the name of the user currently logged in to WebCenter (the one clicking the link to the external web connection).

   - if you are using the [Project Name] SmartName, it will be resolved to the name of the current project.

   So if you are using an order ID as project name and you want to connect to an external system containing information about that order ID, whose URL is http://ExternalSystem/OrderInformation.jsp, then you can use http://ExternalSystem/OrderInformation.jsp?orderID=[Project Name] as URL here.

   This will be resolved to for example: http://ExternalSystem/OrderInformation.jsp?orderID=Order_83289.
When using SmartNames, you should take into account where the connection will be used from (where in WebCenter it will be integrated).

- You can use user-related SmartNames (such as [Requestor UserName]) if the connection is to be added to a top-level menu or a My Work section.
- You can use user-related and project-related SmartNames (such as [Project Name]) if the connection is to be added to a project menu.

See the Customization Guide for information about integrating a link to an external web connection into the WebCenter user interface.

5. In **Type**, select if your external system outputs **HTML** or **XML**.

**Note:** If your external system outputs **XML**, you will need an XSL (eXtensible Stylesheet Language) file to transform this to HTML and display it in WebCenter. Your WebCenter installation comes with an example XSL file, that you can customize.

See the Customization Guide for more details.

6. Click the **Test** button to test the connection to your external system.

You should see a green check mark ✔ if the connection is successful.

**Note:** The test button will only check whether or not the main URL is reachable. It will not take into account any SmartName used to pass on parameters, as SmartNames have to be resolved from a specific context in WebCenter.

In the example above, the test will try to connect to **http://ExternalSystem/OrderInformation.jsp**, and not to **http://ExternalSystem/OrderInformation.jsp?orderID=[Project Name]**.

### 15.3.2 Edit an External Web Connection

- To edit an external web connection, click its name in the **External Web Connections** page.

**Attention:** If you change the name of a connection here, you will also need to change it in the customization files used to integrate a link to this connection into the WebCenter user interface!

See the Customization Guide for more details.

### 15.3.3 Delete an External Web Connection

- To delete one or more external web connections, select it/them on the **External Web Connections** page and select **Delete External Web Connection(s)** in the action menu.

**Attention:** Deleting a connection that is in use will break the pages that use that connection. The system will show an error message on these pages.
15.4 Configure Workflow Connections

With a workflow connection, creating a project in WebCenter can automatically create a linked job in Automation Engine or any JDF-enabled workflow.

This way, the project files can automatically be copied into the workflow job (if desired), and the job parameters can be defined from WebCenter, based on project information and attributes.

This means that:

• WebCenter can act as the single interface for your customers, CSR and sales,
• all the data collected through WebCenter is available for workflow automation.

You can also define when the project will synchronize with the workflow job automatically, and if the WebCenter Project Manager can synchronize them manually.

You can also use a workflow connection to save documents (only approved documents or all documents) and the XML metadata about the documents and project to a network folder. This allows you to archive your documents and metadata externally.

**To Configure a Workflow Connection**

1. Create a connection.
2. Add that connection in a project template.
3. Define when the workflow jobs created will be automatically synchronized to the linked WebCenter projects.

15.4.1 Workflow Connections

Use **Workflow Connections** to synchronise your WebCenter Projects/Documents information with Automation Engine and other third party workflow systems. You can send a JDF file containing information about WebCenter project/document to Automation Engine or other systems. In Automation Engine, this will result in an updated Job or a new Job.

In addition, you can use **Workflow Connections** to submit external workflows. For example, using this connection, the **Submit Workflow** node can execute external workflows on your workflow systems.

You can also use **Push Through Folders** to integrate with such systems. However, these folders copy the WebCenter documents to the specified destination.

When syncing with Automation Engine Jobs, the **Workflow Connections** map:

• Project / Document attributes to Automation Engine **Job Setup** parameters including the customer details.
• Documents to Automation Engine job documents.

**JDF Service**

Use **JDF Service** connection to export your projects as JDF files and automatically create jobs in your Automation Engine. In this case, projects and documents will be communicated to Automation Engine using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.
ZIP Folder

Use ZIP Folder

Enter the address of the network folder to use for archiving your documents and metadata. This must be in an accessible network share, in UNC format.

**Note:** The ZIP file generated will contain:

- `[documentversion_id].[extension]`: the archived document,
- `[documentversion_id].[extension].xml`: the XML file containing the metadata of the archived document,

where `[documentversion_id]` is a unique number corresponding to that version of the document and `[extension]` is the file extension of the original document.

JMF Service

A JMF Service is a service to which the JDF tickets can be posted encapsulated in JMF messages.

**Setting up a JMF Service:**

JDF Hot Folder

When your WebCenter drops a JDF file into the Hot Folder that is shared between WebCenter and Automation Engine, the Automation engine processes it. When processing is finished, it writes the result into the output folder associated with the JDF Hot Folder.

**Note:** This must be in an accessible network share, in UNC format (for example `\MyWorkflowServer\MyJobContainer\HotFolder`).

**Attention:** The JDF hotfolder does not support the execution of external workflows. The Submit Workflow node in WebCenter workflows will fail when a Hot Folder is chosen for the connection.

15.4.2 Create a Workflow Connection

- Click **Admin > Configuration > Workflow Connections**.
  
  The **Workflow Connections** page appears, listing the workflow connections already created (if any).
- Click **New Workflow Connection**.
- Enter a **Configuration Name**.
- Select your **Connection type**. Here you can choose **JDF Service / Zip Folder** or **both**.
### Options

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>To export your projects as JDF files (and automatically create jobs in your workflow system from your projects)...</td>
<td><strong>To export your projects as JDF files (and automatically create jobs in your workflow system from your projects)...</strong> Use JDF Service connection to export your projects as JDF files and automatically create jobs in your Automation Engine. In this case, projects and documents will be communicated to Automation Engine using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup. <a href="#">Read more.</a></td>
</tr>
</tbody>
</table>
| To automatically archive your documents and metadata (as a ZIP file) in a network folder... | **To automatically archive your documents and metadata (as a ZIP file) in a network folder...** Use ZIP Folder Enter the address of the network folder to use for archiving your documents and metadata. This must be in an accessible network share, in UNC format.  

**Note:** The ZIP file generated will contain:  
- `[documentversion_id].[extension]`: the archived document,  
- `[documentversion_id].[extension].xml`: the XML file containing the metadata of the archived document,  

where `[documentversion_id]` is a unique number corresponding to that version of the document and `[extension]` is the file extension of the original document. |

### JDF Service:

Use JDF Service connection to export your projects as JDF files and automatically create jobs in your Automation Engine. In this case, projects and documents will be communicated to Automation Engine using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.

**If your JDF Service is...** | **Follow this procedure...**
| JMF Service | **Note:** You need JMF Service to connect to Automation Engine if it is not in the same LAN or not publicly available. |
If your JDF Service is... | Follow this procedure...
---|---

<table>
<thead>
<tr>
<th><strong>JDF Service</strong></th>
<th><strong>Follow this procedure...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="WebCenter" /></td>
<td><img src="image" alt="WebCenter" /></td>
</tr>
</tbody>
</table>

You can setup a **JMF** connection following the steps below:

1. Select whether your Automation Engine is:
   - in the same LAN or publicly available.
   - connected through the **Approval and Tunnel Client**. Read in [Configure Workflow Approval and Tunnel Clients](#) on page 236
2. If your Automation Engine connection is:
   - in the same LAN / public, specify either the host address (e.g.: 192.168.1.1.1) or the host name (aeserver.brand.com).
   - via an **Approval and Tunnel Client**, select the client from the drop-down.
3. Click **Generate URL**. The URL field above will be filled in automatically.

**Warning:** A **Workflow Connection** connected through an **Approval and Tunnel Client** will block one concurrent license.

<table>
<thead>
<tr>
<th><strong>JDF HotFolder</strong></th>
<th><strong>Select this option if your JDF tickets should be placed in a shared Hot folder.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="WebCenter" /></td>
<td><img src="image" alt="WebCenter" /></td>
</tr>
</tbody>
</table>

1. In the UNC field that appears, enter the address of your workflow’s JDF hot folders (in which to place the JDF file).
   - This must be in an accessible network share, in UNC format (for example: `\MyWorkflowServer\MyJobContainer\HotFolder`).
If your JDF Service is...

<table>
<thead>
<tr>
<th>Follow this procedure...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="JDF Service" /></td>
</tr>
<tr>
<td><img src="image" alt="ZIP Folder" /></td>
</tr>
</tbody>
</table>

2. Click Test.

- Enable the **Active Connection** option to activate this workflow connection.

**Note:**

If you disable this option, there will be no synchronization between WebCenter and your workflow system, but the connection data will be saved, so you can reactivate it later.

- Click **Create**.

### 15.4.3 Edit a Workflow Connection

1. On the **Workflow Connections** page, click the name of a workflow connection.
2. Change the workflow connection’s **settings** as desired.
3. Click **Save**.

### 15.4.4 Delete a Workflow Connection

1. On the **Workflow Connections** page, select the workflow connection(s) to delete.
2. Click **Delete Configuration(s)** in the actions menu.

### 15.4.5 Add a Workflow Connection to a Project / Template

Once you have created a workflow connection, you need to add it to project templates that Projects Managers will use to create projects. You can also add the connection to individual projects if desired.

1. On the Project Details page of the project or template, go to **Configure > Workflow Connection**.
2. Select **Connect this project to a workflow**.
   This shows extra options.
3. In the **Workflow Connection** list, choose the workflow connection you defined.
4. Select **Allow manual synchronization by the Project Manager** if you want Project Managers to be able to synchronize the workflow job to the project on demand.
   If you select this, Project Managers will have an extra action on the Project Details page: **synchronize with workflow**.
Note: Whether you enable manual synchronization by Project Managers or not, the workflow job will be automatically synchronized with the project when certain events occur (see Define When the Project and Workflow Synchronize on page 234).

5. Define when to automatically synchronize the workflow job to the project:
   • select Synchronize on all statuses to synchronize whenever the project status changes,
   • select Only synchronize on a completed status to only synchronize when the project has a completed status.

   Note: There can be more than one completed project status defined in the system.

Note: Make sure you have selected Project status change as event that will trigger an automatic synchronization (see Define When the Project and Workflow Synchronize on page 234).

6. Select Copy documents when synchronizing if you want the project’s documents to be copied to the workflow job.

   Note: When you are using a workflow connection that automatically archives your documents and metadata in a network folder (see Create a Workflow Connection on page 229), Copy documents when synchronizing is always selected.

   You can also choose to copy Only approved documents, or Only documents in (a certain) folder (select the project folder containing the documents to copy). This will work even you rename the folder later. If you try to delete the folder, you will get a warning.

7. Define Additional Settings for the workflow job.

   In Automation Engine, you can see these settings in the Job Setup. See the Automation Engine documentation for more information.

   Note:
   You can use SmartNames to define those Additional Settings.

   Click the Insert SmartName +[ ] button and select a SmartName in the list that appears next to the button. SmartNames are shown between brackets, like [Project Name].

   This list contains general project information ([Project Name], [Customer Name], [due date]...), and all the attributes defined in WebCenter. The attributes don’t need to have been added to the project to be available here.

   You can use several SmartNames if desired, or a combination of SmartNames and text, for example WebCenter_[Project Name]_ [Customer Name].

   a) Fill in the job's Order ID. This is mandatory as it allows WebCenter and Automation Engine to identify the job.

      We recommend you use the [AE_OrderID] SmartName (corresponding to the WebCenter AE_OrderID attribute created automatically when you created the workflow connection) for the job Order ID.

   b) Fill in the job’s Suborder ID if needed (this is optional).
We recommend you use the [AE_SubOrderID] SmartName (corresponding to the WebCenter AE_SubOrderID attribute created automatically when creating the workflow connection) for this.

c) If you want to use a Automation Engine job template when creating the job (so that some of the Job Setup information is already defined), define the template to use in Template Name.

Attention:
If using SmartNames, make sure that they resolve to an existing Automation Engine job name.
SmartNames are resolved when the job is created via the JDF Hot Folder.

8. Click Save.

15.4.6 Define When the Project and Workflow Synchronize

Once you have created a workflow connection and added it to project templates, you need to define what events will trigger an automatic synchronization between the workflow job(s)/network folders and the WebCenter project(s).

You can set this for your whole WebCenter system, but you can also overrule in specific projects or templates.

System-Wide

1. Go to Admin > Preferences > Notifications.

   The Notifications page has a column called Synchronize with Workflow.

2. Select the events that will trigger an automatic synchronization.

   This means that when one of the events you selected occurs in a project, and the project is connected to another system, the synchronization will take place.

   For example, if you select Upload new document, the workflow job created will be synchronized to reflect the project when a user uploads a new document into the project.

3. Click Save.

At the Project/Template Level

1. Go to the project or template’s Notifications tab.

   You can only do this as an Admin user.

2. Select the events that will trigger an automatic synchronization in the Synchronize with Workflow column.

   When one of the events you selected occurs in a project, and the project is connected to another system, the synchronization will take place.

3. Click Save.
15.5 Configure Push-Through Configurations for Workflow Folders

15.5.1 About Workflow Folders

What is a workflow folder?

When creating a folder the Project Manager can define it as a workflow folder, using a push-through configuration defined by the Admin.

Any file that is uploaded into this folder will be automatically copied to a location defined in the configuration. For this reason, workflow folders are sometimes also referred to as “push-through folders”.

Workflow folders are particularly useful when that other location is a hot folder of a workflow system such as Nexus, Automation Engine or Odystar, so that the file will automatically be processed by the workflow system.

Note:
The Configuration for workflow folders needs to be defined by an Administrator.
Project Managers can then select one of the defined configurations when they create a new folder.

Recognizing workflow folders

Workflow folders have a yellow icon with an arrow on it.

The files in a workflow folder have two extra icons:

- The first shows whether the copy of the file was successful or not.
- The second is a button to copy the file again to the location defined in the configuration.

15.5.2 Create a Push-Through Configuration


The Push Through Configurations page appears, listing the push through configurations already created (if any).

2. Click New Push Through Configuration to add a new configuration.

3. Enter a Configuration Name.
4. In the Destination UNC field, type the path to the target folder in UNC format (for example \MyWorkflowServer\Container_Data\WebCenter).

5. Choose a File Naming option:
   - **Document name**: documents copied to the destination folder will keep their original WebCenter name.
   - **[Project_name]_[Document_name]**: the copied documents will get a file name consisting of the project name, an underscore and the original document name.
   - **[Customer_name]_[Project_name]_[Document_name]**: the copied documents will get a file name consisting of the Customer name, an underscore, the project name, another underscore and finally the original document name.

6. Choose the Workflow Type to enable additional integration functionality:
   - Automation Engine,
   - Nexus,
   - Odystar.

7. Enable the Active Configuration option to activate the push-through mechanism for this configuration.

   If you disable this option, files will no longer be copied, but the configuration data will be saved, so you can reactivate it later.

8. Click Create.

### 15.5.3 Delete Push-Through Configurations

1. Click Admin > Configuration > Push Through Configurations.
2. Select the configuration you want to delete.
3. Click Delete Configuration in the actions menu.
4. Click OK to confirm.

### 15.6 Configure Workflow Approval and Tunnel Clients

When WebCenter and Automation Engine are not on the same LAN, this workflow approval and tunnel client will establish a bi-directional communication.

**Note:** The Automation Engine Pilot needs to have the workflow approval client credentials to send messages to WebCenter.

This is configured through Admin > Configuration > Workflow Approval Clients in WebCenter, and, in the case of Automation Engine, in Tools > Configuration > Web Sites in the Automation Engine Pilot.

**Attention:**

Configure the WebCenter account first so that it can be tested from within the workflow approval server.

WebCenter and the workflow approval server must use the same user name and password!
This is completely separate from a normal WebCenter user. Workflow approval clients may not log in to WebCenter.

Two manual configuration steps must also be performed outside of WebCenter to ensure proper communication between the workflow approval client and WebCenter systems that are not on the same LAN.

15.6.1 Create a Workflow Approval and Tunnel Client

1. Click **Admin > Configuration > Workflow Approval and Tunnel Clients**.
2. Click **New Workflow Approval and Tunnel Client**.
3. Enter the **User Name** and **Password** for the workflow approval client user.
4. Click **Create**.

**Note:** If you have several Automation Engine, Nexus, or Odystar sites communicating with WebCenter, you need to create a separate Workflow Approval Client for each site.

15.6.2 Change the Password for a Workflow Approval and Tunnel Client

1. Click **Admin > Configuration > Workflow Approval Clients**.
2. Click **Change Password** link next to the name of the client user.
3. Change the password and click **Change**.

15.6.3 Delete a Workflow Approval and Tunnel Client

1. Click **Admin > Configuration > Workflow Approval Clients**.
2. Select the client.
3. Click **Delete Client(s)** in the actions menu.
4. Click **OK** to confirm.

15.6.4 Configure the Workflow Approval and Tunnel Client Software

Configure the access to WebCenter in the client application for your workflow server. For instructions, please consult the documentation of your workflow server (Automation Engine, Nexus or Odystar).

15.7 Upload Saved Search Results Template

You can upload an Excel file (.xls) to be used as template when users download search results to Excel files.
Note: This will only be used when downloading the results of global saved searches (you can upload one template per global saved search).

1. Go to Admin > Configuration > Upload Saved Search Results Template.
2. Browse to the Excel file to use as a template for a saved search.

Note: Name it exactly as the saved search you want to use it for (ignoring the extension)!

3. If you want to update an existing template file (uploaded with the same name), select Overwrite if template file already exists.
4. Click Upload.

When downloading search results using that template, you will find the results data in a sheet called “Search Results”.

Note:
You can upload a template containing charts and additional sheets referencing the main “Search Results” data sheet (for example through Pivot tables).
In this case, remember to put referencing elements to “auto-update on open” to update the sheet automatically when the Excel document is opened.

15.8 View System Information

The System Info page lists various system statistics. Click Admin > Configuration > System Info to view the system statistics and properties.
## System Info

### WebCenter usage info
- **Number of projects**: 11

### Number of documents per type
- Graphic file: 7
- ArtiosCAD: 1
- Digital Film: 1
- Cape: 0
- **Other**: 6

### User management info
- **Number of licences**: 5
- **Number of users**: 13
- **Number of guaranteed access users**: 5

### Filestore usage info
- **MB used**: 905
- **MB free**: 51730
15.9 Troubleshooting Tool

If you experience some problems with WebCenter, or if you want some real-time information on your WebCenter system, you can run the Troubleshooting Tool. To do this, you can either:

- Go to Admin > Configuration > Troubleshooting Tool in the WebCenter user interface.
- Go to http(s)://<server>/<instance>/tstools/index.html in your web browser.

**Note:**
- You can run the tool from this web page even if your WebCenter server is not running (some tests will fail if WebCenter is not running).
- When running this tool as a non-Admin user, you can only execute simple tests (advanced tests require Admin access).

The tool starts automatically. For each test, the tool gives a status and some extra information. You can use this information to troubleshoot your WebCenter installation and, if you cannot solve the problem, to call Esko customer support.

<table>
<thead>
<tr>
<th>Test status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>The test was executed and everything works as expected.</td>
</tr>
<tr>
<td>BAD</td>
<td>The test was executed, it could be working, but something requires attention.</td>
</tr>
<tr>
<td>FAILED</td>
<td>The test failed. Is is very likely that there is something wrong with the system.</td>
</tr>
<tr>
<td>SKIPPED</td>
<td>The test wasn’t executed due to a lack of rights (you didn’t log in as an Admin user) or because a previous (related) test failed.</td>
</tr>
</tbody>
</table>

15.9.1 Workflow Troubleshooting

If you run the test on the Workflow Engine at the Troubleshooting Tools page, it will result in:

- **OK** if the Workflow Engine is running
- **Bad** if the Workflow Engine is still starting up
- **Failed** if the Workflow Engine is not running.

You can also see the Workflow Database states such as:

- The total number of running workflows in the Workflow Engine
- The total number of tokens in these workflows
- The total number of triggers in these workflows
- The total number of wait triggers in these workflows
When you have a problem workflow, click on the Details section to know more about the specific tasks and projects creating issues. You will also see a tip describing how to resolve the problem. Read [https://wiki.esko.com/pages/viewpage.action?pageId=170037353](https://wiki.esko.com/pages/viewpage.action?pageId=170037353).

### 15.10 Workflow Engine

Use the WebCenter Workflow Engine page when the workflows get stuck, fail to complete or when a workflow loops cause the system to crash. This is a convenient way to troubleshoot workflows.

**Note:** Since version 14, this component runs as a background process of JBoss running the workflows in WebCenter. For versions before WebCenter 14, the Workflow Engine runs along with the JBoss. Because of this, you have to restart the JBoss to restart the Workflow Engine.

To see the status of the Workflow Engine, go to Admin > Configuration > Workflow Engine.

- **Started** when the Workflow Engine is running (green)
- **Starting** when the Workflow Engine is still starting up (orange)
- **Stopped** when the Workflow Engine is not running (red)

To change the status, use the following controls:

- Restart
- Start
- Stop

This page also displays the data on:

- The total number of running workflows in the Workflow Engine
- The total number of tokens in these workflows
- The total number of triggers in these workflows
- The total number of wait triggers in these workflows
- The number of workflow events per second: This is the average number of Workflow Events per second generated by the Workflow Engine within the past 20 seconds.

- The workflow engine queues (Queue Name) and their sizes:
  - Internal Event Processing Queue
  - Workflow Step Processing Queue
  - Trigger Processing Queue

### 15.11 Site Service
15.11.1 View Log Files

Go to **Admin > Configuration > Site Service** to:

- see system settings (click **Show Site Defaults**),
- set the maximum number of days to retain log files:
  
  You can specify the **Max Age of JBoss Log Files** field as the number of **days** you want to retain the logs.

  **Important:** If you set a very high number of days, it will affect your hard drive disk space over time. You have to watch the disk space and delete the log files manually.

- download **JBoss** and **Tomcat** log files.

15.12 Single Sign-On

Single Sign-on allows you to use a centralized system for authentication. For instance, you can use a single credential on many systems including WebCenter.

You can configure:

- a single set of credentials for all systems (like LDAP)
- free access to WebCenter without a separate login page.

The two previously existing authentication mechanisms (**LDAP** and simple password authentication) have been modified adding extra flexibility. You can either make all users authenticate with LDAP by default or configure multiple LDAP servers.

**Note:**

You need a WebCenter Advanced License to configure more than a simple password authentication and one LDAP server.

Table: Single Sign On Definitions

<table>
<thead>
<tr>
<th>Single Sign-On System</th>
<th>The system providing authentication, (e.g. yammer, SAML, LDAP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>The administrator who deals with WebCenter from both an application point view and from an IT (operating system and database) point of view.</td>
</tr>
<tr>
<td>Administrator</td>
<td>WebCenter Administrator</td>
</tr>
<tr>
<td>SSO plug-in (SSOP)</td>
<td>The full deployment of an integration with a Single Sign-On system. Will also be used as synonym for the implementation of the Java 'ServiceProvider' concept. The Service Provider is in fact part of the deployment of the plug-in.</td>
</tr>
<tr>
<td>Single Sign-On Instance configuration</td>
<td>Defines an Instance and its place (priority and availability) in the system.</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plug-in specific Instance configuration</td>
<td>Part of the instance configuration that may differ depending on the plug-in.</td>
</tr>
<tr>
<td>Single Sign-On Instance</td>
<td>A plug-in can have multiple instances. Its behavior is determined by the plug-in and the instance configuration.</td>
</tr>
<tr>
<td>User Configuration</td>
<td>Configuration information for a specific user</td>
</tr>
<tr>
<td>Instance Specific User Configuration</td>
<td>The user configuration dependent on the SSO instance.</td>
</tr>
<tr>
<td>Note: This configuration is dependent on the instance and not the plug-in.</td>
<td></td>
</tr>
<tr>
<td>Standard Login Page Instance</td>
<td>The standard login page.</td>
</tr>
<tr>
<td>Custom Login Behavior Instance</td>
<td>The alternate page (or dialog) when a user is not authenticated.</td>
</tr>
<tr>
<td>Default Single Sign-On Instance</td>
<td>The instance that will be selected by default.</td>
</tr>
<tr>
<td>User</td>
<td>Has access to WebCenter after login.</td>
</tr>
<tr>
<td>Database</td>
<td>Relational database. The primary location for persisting data in WebCenter.</td>
</tr>
</tbody>
</table>

**15.12.1 Add a plug-in to the system**

You can add plug-ins that are not WebCenter standard by placing a set of .jar files in `<installation_root>/ApplicationServer/JBoss/sso-plugins` folder.

These files contain the plug-in implementation and the associated libraries.

**Note:**

You do not have to restart any of the WebCenter servers after installing a new plug-in.

To remove a plug-in, you have to stop the application server. Restart the application server after replacing the .jar files.

**15.12.2 Manage Instances**

Go to **Configuration > Authentication (SSO)** to get an overview of the configured **Single Sign-On Instances**.

Enabling the **Allow Project Managers to change their users' access to SSO instances** option will allow the Project Managers to modify their users' authentication settings at the user's profile page.

When this is disabled, Project Managers will be prevented from changing their user's access to SSO instances. The PMs will not be able to see the **Authentication** drop downs T the user's profile. In addition, the disabled instances will be hidden.
**Name**: name of the Single Sign-On Instance. Will be used for display in multiple places.

**Plug-in**: the name of the plug-in to which the Single Sign On Instance belong.

**Password Recheck**: whether a particular instance supports password re-entry (upon submitting approval) or not.
- **Yes**: if the system setting to re-enter password is enabled.
- **No**: if the re-entering of password is disabled.
- **N/A**: indicates that the information is currently not available. For example, if the instance is not enabled or fails to load.

**ID**: the internal ID. As an administrator, you can use this while addressing an SSO provider directly. For example, when redirecting from an external system.

**Priority**: determines the order in which the Instances are attempted for authentication. Also determines the display order in several places (user settings and log-in page).

**Enabled**: indicates whether the instance is operational. You have to enable an instance to use it for authentication. The options to change Instance specific user settings is only available for the enabled Instances.

**Listed**: indicates that an explicit log-in button will be available when the Instance is enabled.

**Try Next**: when this is enabled, the next Instance will be tried after the default log-in fails. The log-in attempts will stop at the first enabled Single Sign-On Instance when the **Try Next** option is disabled.

**Configure**: displays the **Edit** links to configure the plug-in specific instance configuration.

**Default**: you can configure whether a user is allowed to or denied from using an Instance. You can allow some users to authenticate at a specific Instance. The default can be changed in the user specific configuration.

**Delete**: use the **Delete** link to delete an Instance.

### 15.12.3 Add a Single Sign-On Instance

1. From the **Configuration > Authentication (SSO)** page, click on the **New SSO Instance** link.

   **Note**: You cannot have more than one **basic** authentication.

2. Give the new Instance a **Name**.

3. Select the **Plug-in** from the drop down.
   The **Plug-in** drop down will display all the SSO Plug-ins available in that particular WebCenter.
4. Click Create.

When the instance is created successfully, you will return to the Single Sign-On Instances list. The new instance is also displayed as the last instance.

15.12.4 Configure a Single Sign On Instance

To access the Single Sign On Instance configuration page, click the configure link from the instances row.

1. Go to the Configuration > Authentication (SSO) page. You will see the overview table of the configured Single Sign-On Instances.

2. Click Edit link in the row corresponding to the Instance to be configured. This opens a plug-in specific configuration of an existing Single Sign On Instance.

   Note: You cannot edit the Basic Password configuration.

3. Modify the configuration details.

4. Save. To make it active, you need to check the enabled option. To make it listed on the login page, enable listed. When you create a new User, the login options are determined by the status in the default column.

   If an instance is in the denied status for a user, he/she will not get that option listed on the login page.

15.12.5 Configure Single Sign On User settings

You can view the Single Sign On settings specific to your User account in the My WebCenter > My Password page. This page will display the Single Sign On Instances that are enabled for your User account.

You may modify configuration details of the Single Sign On Instance depending on your permissions to do so. If you have permission to modify, all your values will be saved.

   Note: User specific settings are possible when the Single Sign On Instance supports user specific configuration.

15.12.6 Configure LDAP(S)

LDAP

LDAP (Lightweight Directory Access Protocol) is an application protocol for querying and modifying directory services running over TCP/IP.

In the context of WebCenter, it allows you to let users sign on to WebCenter with the same user name and password they use to log on to the corporate network.

LDAPS
LDAPS is the more secure variant of the protocol, and it uses SSL connections instead of plain (i.e. Unprotected) connections. It requires you to install certificates on the server, as described in Install Certificates for LDAPS on the Application Server.

While logged in to the WebCenter web interface as an administrator:

1. From the Configuration > Authentication (SSO) page, click on the New SSO Instance link.
2. Give the new Instance a Name and select the Plug-in as LDAP password authentication.
3. Click Create.
   A new LDAP instance will be created.
4. In the overview table of the configured Single Sign-On Instances, click Edit link corresponding to the LDAP instance.
5. Modify the configuration details.
6. Enter the name or IP address of the LDAP Server.
   Example: esko.com.
7. Type the User Distinguished Name (DN).
   Example:
   ```
   CN=BG
   System,OU=Users,OU=Gent,OU=Belgium,OU=Locations,DC=esko,DC=com
   ```
8. Provide the Password for the user you specified in the User Distinguished Name field in the previous step, and confirm it.
9. Enable the option Use secure connection (LDAPS) to encrypt all communication between WebCenter and the LDAP server.
10. You can specify additional elements in the Advanced settings field. For example, you can change the default port that is used in the case of LDAP over SSL. Use the various lookup keys to match the LDAP field against the WebCenter properties and then change the default LDAP keys. See below:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ssl.port</td>
<td>Default LDAP secure connection port</td>
</tr>
<tr>
<td>lookup.userinitials</td>
<td>AD path used for LDAP login name lockup.</td>
</tr>
<tr>
<td>lookup.firstname</td>
<td>First name key</td>
</tr>
<tr>
<td>lookup.lastname</td>
<td>Last name key</td>
</tr>
<tr>
<td>lookup.mailid</td>
<td>Mail id key</td>
</tr>
<tr>
<td>lookup.phonenumber</td>
<td>Phone Number key</td>
</tr>
<tr>
<td>lookup.mobilenumber</td>
<td>Mobile Number key</td>
</tr>
</tbody>
</table>
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lookup.title</td>
<td>Maps to the Function in WebCenter title (default)</td>
</tr>
<tr>
<td>autoupdate</td>
<td>Enable this to look up user info and to update during log in (values: 0 or 1). Specify the value as 1. The default is 0.</td>
</tr>
<tr>
<td>enforce</td>
<td>Enable this to make the user info read only for the user (values: 0 or 1). The default is 0.</td>
</tr>
</tbody>
</table>

11. Click **Save** to save the setup.

**Note:** Every time you change a setting on the LDAP Setup page, you must re-enter the full LDAP credentials.

### 15.12.7 Single Sign On Log-in types

You will have different SSO login behavior depending upon the configuration and priority of the Single Sign On Instances.

- **Standard Login Page Instance (SLPI):**
  This will show the login page when not logged in. LDAP and plain password authentication are examples.

- **Custom Login Behavior Instance (CLBI):**
  CLBI might redirect you to a portal or show a dialog. SAML is an example of the CLBI type.

WebCenter 14.0.1 supports the SAML plug-in. Using this plug-in, WebCenter can communicate over the SAML 2.0 protocol with Shibboleth, PingFederate and Active Directory Federation Services (ADFS). WebCenter users can authenticate using their company-wide account. This will provide seamless access to WebCenter.

**Note:**
You need WebCenter advanced license to enable this feature.

The plug-in supports the following SAML 2.0 profiles:

- **SP POST – IdP POST**
- **Unsolicited SSO (SP POST – IdP HTTP Redirect)**

**Note:** SAML Artifact binding is not yet supported

**Important:** We recommend that you contact Esko solution architects for configuring the SAML plug-in.

You can also access the login page by directly navigating to login.jsp. The different login behaviors can again be triggered if the buttons for the wanted instances are listed on the login page.
A plug-in may override the logout behavior. For example, logging out may lead you to a portal.

15.12.8 Single Sign on Passwords on Approval

When the Require password for approvals/rejections setting is enabled, your user is required to provide his password during approval. This depends on the Single Sign On Instance used by the user. When the Instance supports this setting, the password is the same as the one required for the Single Sign On authentication.

**Note:**
LDAP and basic password authentication support this setting. It is not expected to be supported by SAML.

15.12.9 How to Login to WebCenter when the Single Sign On is broken

You can access WebCenter overriding the Single Sign On configuration in emergency situations. This can happen when the configured external system is down or when a mistake occurs leading to a broken configuration.

Use basic password authentication locally from the web server to gain access to WebCenter.

**Note:**
- You need direct access to the web server operating system to execute this.
- You have to remember a basic authentication password of a WebCenter Admin user. Or you should have enabled **Forgot Password** feature.
16. Connecting to Automation Engine

You can connect to your or a client’s Automation Engine from WebCenter. Using this connection, you can:

- send files
- push metadata
- launch a workflow

To establish a successful connection, you need to configure both the Automation Engine and the WebCenter settings.

Read about configuring the Automation Engine [here](#).

You can connect to Automation Engine:

- in the same LAN or publicly available through an **Automation Engine Host Address**

  **Tip:** The Host Address may look like ‘192.168.1.1’ or ‘aeserver.brand.com’.

- via a tunnel when not publicly available or not in the same LAN. Read in: Create a Tunnel between WebCenter and Automation Engine on page 249

16.1 Create a Tunnel between WebCenter and Automation Engine

When the Automation Engine is not situated in the same LAN and not available publicly, you need a tunnel to send exchange workflow commands and data between WebCenter and Automation Engine. To create such a tunnel, follow the steps below:

Web

1. **Create a Workflow approval and tunnel client.**

   When WebCenter and Automation Engine are not on the same LAN, this [workflow approval and tunnel client](#) will establish a bi-directional communication.

   **Note:** The Automation Engine Pilot needs to have the workflow approval client credentials to send messages to WebCenter.

2. Enter the **Workflow approval and tunnel client** credentials in the Automation Engine configure tool.

   Fill out the client Name and Password and click the Check Connection button. This will check if the user can log on successfully.

3. **Save** this configuration.

   **Tip:** After configuring a new WebCenter site, it is recommended to close your Pilot and start it again in order to see the updated list of WebCenter sites in your tickets.
4. Optionally, you can check the connection between Automation Engine and WebCenter from the admin > configurations > workflow and tunnel clients page. Click the Start Monitoring link to see if the connection is active.

5. Click Admin > Configuration > Workflow Connections.

   The Workflow Connections page appears, listing the workflow connections already created (if any).

6. Click New Workflow Connection.

7. Enter a Configuration Name.

8. Select the Connection type as JDF Service.

9. Now, specify the JDF Service as JMF service.

   **Note:** You need JMF Service to connect to Automation Engine if it is not in the same LAN or not publicly available.

10. Specify that your Automation Engine is connected via the Approval and Tunnel Client created in step 2. Select the Approval and Tunnel Client from the drop-down and click Generate URL.

   **Warning:** A Workflow Connection connected through an Approval and Tunnel Client will block one concurrent license.

11. Enable the Active Connection option to activate this workflow connection.

   **Note:**

   If you disable this option, there will be no synchronization between WebCenter and your workflow system, but the connection data will be saved, so you can reactivate it later.

12. Click Create.
17. Bill of Materials

17.1 What is a Bill of Materials?

A Bill of Materials (or “BOM”) is a list of all parts and assemblies required to build a complete shippable product. It shows what will be created and delivered during a project.

In WebCenter, this is a list of documents representing the deliverables. The documents can be actual production files or placeholder documents.

17.2 Enabling the Bill of Materials Feature

By default, the Bill of Materials functionality is disabled for the entire WebCenter system. This means that Bill of Materials features will not be visible.

To enable it, do the following:

1. Go to Admin > Preferences > General.
2. Under Bill of Materials, select the Use Bill of Materials option.
3. Click Save.

17.3 Viewing a Project’s Bill of Materials

Every project has a Bill of Materials, which is by default empty.

If the Bill of Materials feature is enabled, you will see a Bill of Materials tab on your Project Details page. The tab header indicates how many documents are linked to the Bill of Materials.

Note:
You will only see the document(s) in the Bill of Materials (and their attributes) if you are either:
• an Administrator,
• the Project Manager,
• invited to the Project, with view permissions on all documents in the Bill of Materials.

Otherwise, you will see a message stating that you don’t have permissions to view the document(s) in the Bill of Materials.
When clicking this tab, you see the documents in the Bill of Materials, with information about the documents (folder, version, approval cycle, tasks...) and their **Count**. This indicates how many copies of that document are required for that project’s Bill of Materials.

**Note:** The count is specific for a document within a project. This means that the same document can be linked in multiple projects with a different count.

If a document has an attribute category assigned, you will see a + button. Click it to show its attributes (in list view), and click - to hide them again. To show/hide the attributes of all documents in the BOM, click + or - in the header of the table.

**Tip:** By default, the “Default” view for the attribute category is displayed, but if the attribute category has a view called “BOM”, this view is shown.
17.4 Editing the Bill of Materials

17.4.1 Who Can Edit the Bill of Materials?

Administrators and the Project Manager can always change the Bill of Materials. Other members can be allowed to change it, if they have the Change BOM permission. This permission can be set on the project’s Security page (see Project and Document Security in the User Guide).

Note: You can only set the Change BOM permission at the Project level, not at the folder level.

If a user can change the attributes on the attributes page, he/she can also change them on the Bill of Materials page.

Table: Permissions on Bill of Materials Documents

<table>
<thead>
<tr>
<th></th>
<th>Administrators</th>
<th>Project Managers</th>
<th>Users with Change BOM Permission</th>
<th>Users without Change BOM Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can add/remove documents to/from the BOM in active projects</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>Can add/remove documents to/from the BOM in inactive projects</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>Can change the count of BOM documents</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
</tr>
</tbody>
</table>

17.4.2 Adding Documents to the Bill of Materials

You can only add documents to the Bill of Materials if:

- you are an Administrator,
- you are the Project Manager,
- you have Add and Change BOM permissions on the Project.

Adding Documents to the Bill of Materials at Project Creation

If you want Project Managers to be able to already add documents to the Bill of Materials when creating a Project, do the following:
1. As an Administrator, go to the Project or Template that Project Managers will use to create Projects, and click the Configure tab then Project Creation.

Tip: Use a Project or Template that contains a Bill of Materials with documents if you want Project Managers to have the option to copy these documents into their new Project’s Bill of Materials.

2. Select the Show check box for the Change Bill of Materials option.

If you want Project Managers to have to add at least one document to the BOM when creating the Project, also select the Required check box.

Click Change.

3. When a Project Manager creates a Project from that Project or Template, he/she will see a Bill Of Materials section on the Project creation page.

• when creating the Project from a Template, that section will contain the documents in the Template’s Bill of Materials.
• when creating the Project from a Project, he/she will have to choose whether to copy the documents from that Project’s Bill of Materials into the new Project’s Bill of Materials.

To copy them, the Project Manager should select including BOM in the Copy setup from an existing project pop-up.

Note: A Project Manager will not see a Bill Of Materials section on the Project creation page when creating a blank Project.

4. The Project Manager can still edit the Bill of Materials while creating the Project. He/she can:

• add documents using the Upload, Copy and New links,
• remove documents by clicking the - buttons in their rows,
• change the Count of Bill of Materials documents,
• edit the documents’ attributes (by clicking + and filling them in).

Add Documents from the Bill of Materials Tab

From the Project’s Bill of Materials tab, you can:

• Upload a new document from your computer or network.
• Copy a document from another Project.
• Create a placeholder document from a document template.
• Add a document already in the Project to the Bill of Materials.

Upload a Document from your Computer or Network

To upload a document into your Project’s Bill of Materials:

1. Click Upload at the bottom of the Bill of Materials tab.
2. Click the Browse button and browse to your document.
3. If desired, select a document template to use for your document.

Note: This is only available if the Project has been created from a Project/template containing document templates, or if the Project itself has document templates configured.
The template you choose will determine what attributes are associated with the document.
If you don’t select a document template, the document will have the attribute category associated with its document type in the Configure > Document Creation tab of the Project (see Document Types on page 69).

4. Fill in the attributes associated with the document (at least the required ones).

5. If desired, enter a new Name and a Description for your document.

**Note:** If Automatic Document Naming is set up for document creation in the Project, the Name will be created automatically (you cannot enter it).

6. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.

7. Choose where to upload the document (in the Project’s Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you selected.

8. Click Save.

Copy a Document from Another Project

To copy a document from another project into your Project’s Bill of Materials:

1. Click Copy at the bottom of the Bill of Materials tab.

2. Select a Project (or start typing a Project name) in the second drop-down list.

3. Select a document in that Project (or start typing a document name) in the third drop-down list.

4. If desired, select a document template to use for your document.

**Note:** This is only available if the Project has been created from a Project/template containing document templates, or if the Project itself has document templates configured.

The template you choose will determine what attributes are associated with the document.
If you don’t select a document template, the document will have the attribute category associated with its document type in the Configure > Document Creation tab of the Project (see Document Types on page 69).

5. Fill in the attributes associated with the document (at least the required ones).

6. If desired, enter a new Name and a Description for your document.

**Note:** If Automatic Document Naming is set up for document creation in the Project, the Name will be created automatically (you cannot enter it).

7. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.

8. Choose where to upload the document (in the Project’s Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you selected.

9. Click Save.
Create a Placeholder Document from a Document Template

To create a placeholder document from a document template:

**Note**: This is only available if the project has been created from a project/template containing document templates.

1. Click **New** at the bottom of the **Bill of Materials** tab.
2. In the pop-up that opens, select the document template to use and click **OK**.

   The template you choose will determine what attributes are associated with the document.

3. Fill in the attributes associated with the document (at least the required ones).
4. If desired, enter a new **Name** and a **Description** for your document.

   **Note**: If **Automatic Document Naming** is set up for document creation in the Project, the **Name** will be created automatically (you cannot enter it).

5. Enter the **Count** of this document (how many copies are needed for the Bill of Materials).
   
   This can be a fraction or a decimal number.

6. Choose where to upload the document (in the Project’s **Root Folder** or one of its sub folders).
   
   Choose **Default (Template)** if you want to use the folder defined in the document template you selected.

7. Click **Save**.

Add a Document Already in the Project to the Bill of Materials

To add a document already in the Project to the Bill of Materials:

1. Click **Add to Bill of Materials** at the bottom of the **Bill of Materials** tab.
2. Select the Project document to add to the Bill of Materials.
3. Enter the **Count** of this document (how many copies are needed for the Bill of Materials).

   This can be a fraction or a decimal number.

4. Click **Save**.

   **Tip**: In the Project’s **Documents** tab, documents that are in the Bill of Materials have a BOM icon. You can click this icon to see the Bill of Materials.

Add Documents from the Documents Tab

You can add documents that are already in the Project to the Project’s Bill of Materials.

To do this, select the document(s) to add and click **Actions > Add to Bill of Materials**. This adds the document to the Bill of Materials with a count of 1.
Add Documents from the Upload Page

You can also add a document to a Project’s Bill of Materials while uploading a document using the Upload button. You just need to select Add to Bill of Materials and specify a Count (see Upload via Upload Document).

Note:
You can only do this if:
• you are an Administrator,
• you are the Project Manager,
• you have the Change BOM permission.

Add Documents from a Workflow

You can add documents to the Bill of Materials automatically using the workflow’s Add to Bill of Materials task.

In the task’s Parameters, you can set the documents’ Count.

Tip: You can use a SmartName (for example a document or project attribute) to set the count.

Here is an example workflow using the Add to Bill of Materials task:
Tip: You can use the **Select Document** task to select all the documents in the BOM (select the **Documents in the Bill of Materials** option in the **Parameters**).

---

**Add Documents from Automation Engine**

You can add documents to a WebCenter Project's Bill of Materials using the Automation Engine **Publish on WebCenter** task (from Automation Engine 12.1).

When you publish an Automation Engine **Product** to WebCenter, the **Product Properties** and **Product/Product Part Parameters** will be taken as WebCenter attributes.

If there are existing WebCenter attributes with corresponding names, their values will be updated during publishing.

The following Product (Part) properties and Product (Part) Parameters are synchronized with WebCenter attributes:

<table>
<thead>
<tr>
<th>Automation Engine Properties/Parameter</th>
<th>WebCenter Attribute (Internal name)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Customer Reference</td>
<td>ae.p.cusref</td>
</tr>
<tr>
<td>Product Custom Field 1</td>
<td>ae.p.category1</td>
</tr>
<tr>
<td>Product Custom Field 2</td>
<td>ae.p.category2</td>
</tr>
<tr>
<td>Product Custom Field 3</td>
<td>ae.p.category3</td>
</tr>
<tr>
<td>Product Internal ID</td>
<td>ae.p.id</td>
</tr>
<tr>
<td>Product ID</td>
<td>ae.p.prodid</td>
</tr>
<tr>
<td>Product Name</td>
<td>ae.p.name</td>
</tr>
<tr>
<td>Product Description</td>
<td>ae.p.desc</td>
</tr>
<tr>
<td>Product Part Internal ID</td>
<td>ae.pp.id</td>
</tr>
<tr>
<td>Part Default Angle</td>
<td>ae.pp.defaultangle</td>
</tr>
<tr>
<td>Part Default Dotshape</td>
<td>ae.pp.defaultdotshape</td>
</tr>
<tr>
<td>Part URL</td>
<td>ae.pp.url</td>
</tr>
<tr>
<td>Part Default Ruling</td>
<td>ae.pp.defaultruling</td>
</tr>
<tr>
<td>Part Preferred InkBook</td>
<td>ae.pp.preferredinkbook</td>
</tr>
<tr>
<td>Part Preferred InkBook UI</td>
<td>ae.pp.preferredinkbookui</td>
</tr>
<tr>
<td>Part Internal ID</td>
<td>ae.pp.id</td>
</tr>
<tr>
<td>Part Custom Field 3</td>
<td>ae.pp.category3</td>
</tr>
<tr>
<td>Part Custom Field 2</td>
<td>ae.pp.category2</td>
</tr>
<tr>
<td>Part File</td>
<td>ae.pp.file</td>
</tr>
<tr>
<td>Part Status</td>
<td>ae.pp.status</td>
</tr>
<tr>
<td>Part Status Nickname</td>
<td>ae.pp.statusNickname</td>
</tr>
<tr>
<td>Part Status User</td>
<td>ae.pp.status_user</td>
</tr>
<tr>
<td>Part Status Notes</td>
<td>ae.pp.status_notes</td>
</tr>
<tr>
<td>Part Status Date</td>
<td>ae.pp.status_date</td>
</tr>
<tr>
<td>Part Folder</td>
<td>ae.pp.folder</td>
</tr>
<tr>
<td>Part Custom Field 1</td>
<td>ae.pp.category1</td>
</tr>
<tr>
<td>Part Name</td>
<td>ae.pp.name</td>
</tr>
<tr>
<td>Part Inks</td>
<td>ae.pp.inks</td>
</tr>
<tr>
<td>Part Barcodes</td>
<td>ae.pp.barcodes</td>
</tr>
<tr>
<td>Product Customer Name</td>
<td>ae.c.name</td>
</tr>
<tr>
<td>Product Customer Description</td>
<td>ae.c.desc</td>
</tr>
<tr>
<td>Product Customer ID</td>
<td>ae.c.id</td>
</tr>
</tbody>
</table>
### 17.4.3 Removing Documents from the Bill of Materials

To remove a document from the Bill of Materials, select it in the **Bill of Materials** tab and click **Actions > Delete from Bill of Materials**.

**Note:** Removing a document from a Project (or moving it outside that Project) removes it from the Project's Bill of Materials as well.

### 17.5 How to Search for a Bill of Materials

#### 17.5.1 Search for Projects that have a Bill of Materials

When searching for Projects using the *normal search*, you can specify that you only want to see Projects that have a Bill of Materials. To do this, select **Only Projects with Bill of Materials** in the **Bill of Materials** option.

#### 17.5.2 Viewing the Bill of Materials in a Project Search

When searching for Projects, you can view a summary of the Bill of Materials documents per approval status for each Project found.

To do this, just select the **View (List)** option for **Bill of Materials** on the **Search For Projects** page. See *Search Result Options* in the User Guide for more information about displaying search results.

---

**Automation Engine Properties/Parameter** | **WebCenter Attribute (Internal name)**
---|---
MyProductParameter1 | ae.p.par.MyProductParameter1

When a **Product** or **Product Part** is published, corresponding WebCenter documents are automatically added to the **Bill Of Materials** of the Project.

The **Product Amount** for the Job (if given) becomes the **Count** property of the **Bill of Materials**.
In the **Bill of Materials** column on the **Search Results** page, you can view the number of:

- approved documents,
- force approved documents,
- rejected documents,
- force rejected documents,
- documents waiting for approval,
- documents with a paused approval setup,
- documents without an approval setup,
- (all) documents,

... in each Project’s Bill of Materials.

**Tip:** Click one of the approval statuses’ icons (for example pending 🔄) to show the BOM documents with this status.

---

### 17.6 How to See if a Document is Part of a Bill of Materials

In the Project’s **Documents** tab, documents that are part of the Bill of Materials have a BOM icon 📋. You can click that icon to go to the Project’s Bill of Materials page.

On the **Document Details** page, the BOM icon 📋 indicates whether the document is a part of a Bill of Materials. You can also click that icon to go to the Project’s Bill of Materials page.

**Note:** A document can be part of more than one Project’s Bill of Materials (if it is linked into multiple Projects).

---

### 17.7 Bill of Materials History

You can see all changes made to your Project’s Bill of Materials in the **Project History**.
You can see for example:

- new documents added to the Bill of Materials,
- documents removed from the Bill of Materials,
- changes to a document’s count.

17.8 Email Notifications for Bill of Materials Changes

To send email notifications when something has changed in your Bill of Materials:

1. In your Project, go to the Notifications tab and select who to Notify by E-Mail in the Bill of Materials Changed row.
2. Click Save.

The recipients will get emails when:

- a document is added to the Bill of Materials,
- a document is removed from the Bill of Materials,
- a document’s count is changed.

17.9 Working on the Bill of Materials from ArtiosCAD Enterprise

With ArtiosCAD Enterprise, you can see all your Projects and (ArtiosCAD) documents from WebCenter.

If you open a document in ArtiosCAD Enterprise, you can go to the Project’s Bill of Materials and see a list of all the Bill of Materials documents.

**Note:** You need ArtiosCAD Enterprise 12.1 to work with WebCenter Bills of Materials.

In ArtiosCAD Enterprise, you can:

- change the count of ArtiosCAD files in the Bill of Materials,
- add a document revision (A, B, C...) to an ArtiosCAD file (this is shown in the Version column of the Bill Of Materials tab, and in the document’s Action History).

**Note:** When you work with revisions on a Bill of Materials document, the latest version within a revision is the version in the Bill of Materials.
• add a print item to an ArtiosCAD file (this is shown in a separate column in the Bill Of Materials tab),

• change the order of the Bill of Materials documents.

Once you click OK, this is updated in WebCenter.

**Note:** You cannot add a document revision or a print item to an ArtiosCAD file, or change the order of the Bill of Materials documents from WebCenter.
18. Autoname Generation

Autoname Generation is a way of generating project and document names automatically in the WebCenter application. The administrator or a member of ADMINS group sets the rules for both project and document autoname generation. By default, this feature is not in use.

18.1 Structure of Autoname Generation

The structure of Autoname Generation consists of a Prefix, Suffix and Counter Length. A Counter keeps track of the count when a new project is created or when a new document is uploaded. The length defines the fixed length of the Counter.

For example: If the Prefix is begin_, Suffix is _end and the Counter Length is set to 4, then the Autoname will be generated as begin_0001_end and the next document or project name will be begin_0002_end.

Note:
The Project Autoname Generation happens at “transaction time”, meaning until the project or document is uploaded or submitted the autoname cannot be set or predicted.

The prefix and suffix parts can be defined using SmartNames. Here are few examples as below:

Example 1: If the Prefix is [Customer Location], Suffix is [EditField] and the Counter Length is set to 4. Here, the [Customer Location] and [Project Name] are selected using SmartNames, then the Autoname will be generated as Gent_0001_WebCenter_printpromotion and the next document or project name will be Gent_0002_WebCenter_printpromotion.
Example 2: If the Prefix is [Customer Location] [Creation Date:dd.MM.yy], Suffix is [Customer ShortName] and the Counter Length is set to 4. Here, the [Customer Location] [Creation Date:dd.MM.yy] and [Customer ShortName] are selected using SmartNames, then the Autoname will be generated as Gent_02.05.12_0001_BBC and the next document or project name will be Gent_02.05.12_0002_BBC.

18.1.1 Types of Autoname Generation

The following are the types of Autoname Generation in WebCenter.

- **System-wide project autonaming**: The System-wide project autonaming settings are set by an administrator to enable/disable project auto naming. The administrator can enter values for the Prefix, Suffix and also apply a Counter Length. The option Use Automatic Naming for Creation of Blank Projects allows to setup the autoname generation for blank projects also. If default is selected in the template/project configuration settings, then all the projects created will be using the System-wide Project Autoname settings setup.

  ![Project Autoname Generation](image)

  Note: Blank projects are projects created without using a template.

- **Template-based Project Autonaming**: The administrator can use the Template-based project autonaming settings for projects created from a specific template or another project in the Project Creation page. Only the new projects from this template will follow the naming convention. Select Use Automatic Naming check box to use autonaming. The options available are Use Default Automatic Naming or Use Custom Automatic Naming. The Default Auto Naming will take effect if an autonaming already exists in System-wide Project Autoname settings setup.

  ![Project Creation](image)

  - **System-wide document autonaming**: The administrator can set up the document autonaming settings per document type on the Document Types page. The options available are None or Custom Automatic Naming options. The Custom option allows you to customize the required autoname setup. The option Apply Automatic Naming to Documents in Blank Projects allows
you to setup autoname generation for blank documents also. The **Apply Default Attribute Categories to Documents in Blank Project** option allows you to add the default attribute category to documents which exits in blank projects.

For example: If you upload abc.ard file and the Prefix is `[DirectoryName]` the Counter Length is set to 4 and the Suffix is empty, then the autoname will generated as **DESIGN_0001.ard**.

Using the **Scope of the Counter** option the administrator can specify whether the counter will continue counting system wide, or whether it will reset for every project.

If the option **Reset per Project** is selected then, autoname will be generated as `begin_0001_end` and next document will be `begin_0002_end` and so on.

If **System wide Counter** is selected and files already exists, autoname will be generated as `begin_0098_end` and next can be `begin_0112_end`. The counter here depends on the number of files which are uploaded to the system and not on each of the project.

- **Template/Project-based document autonaming**: The administrator can set up the document auto name settings per document type on the Document Types page. The Document Types page allows to enable/disable specific document types and is extended to also have a section for setting auto naming details per document type. The administrator can specify Prefix, Suffix and Length for each of the Document Types available.

**Note:**

Only newly uploaded documents will have the correct auto naming settings applied to them.

When the option **Apply automatic naming to Documents in Blank Projects** is selected, the default settings will be used when uploading documents in projects which are created without a template.
Using the **Scope of the Counter** option the administrator can specify whether the counter will continue counting system wide, or whether it will reset for every project.

If the option **Reset per Project** is selected then, autoname will be generated as begin_0001_end and next document will be begin_0002_end and so on.

If **System wide Counter** is selected and files already exists, autoname will be generated as begin_0098_end and next can be begin_0111_end. The counter here depends on the number of files which are uploaded to the system and not on each of the project.

The SmartName [Project Attribute] and [Document Attribute] contains an extra option. When selecting these options, an extra drop-down appears to select the attribute. It is advised to set such attributes required in the creation view of the attribute category, else this part of the name will remain blank.

**Note:** Changing or modifying the attribute value after creation of the project or document will not change the existing name.

### 18.2 Things to Keep in Mind

The following are the important points to be known when using Autonaming Generation;

- Autoname Generation is set on the project or document and not the user or role.
- The prefix field cannot be empty.
- If the counter length is 0 or left empty, no numeric part will be added.
- The Prefix and Suffix fields are limited to 150 characters and maximum number for Counter Length field is 20.
- The [EditField] SmartName can used only in the Suffix and if required, the administrator can edit this field. If the [Edit Field] is empty, then it is not replaced by any text, but left blank.
- In prefix or suffix, ensure not to use square brackets [ ]. The system will take it as a SmartName.
- The administrator can use several SmartNames if desired, or a combination of SmartNames and text.
- If a SmartName is selected and the attribute is empty or not found in the WebCenter application, then this field is left blank.
- When the document autonaming settings for a template are changed, these settings are not automatically applied to all projects which are already created from this template. The project created earlier continues to follow the old autonaming setup.
- Project Autoname Generation happens at “transaction time”, meaning that until the project or document is uploaded or submitted the autoname cannot be set or predicted.
- If autoname has been configured the following message appears, when creating a new project.

18.3 Using SmartNames in Autoname Generation

18.3.1 What is a SmartName?

A SmartName is a variable that refers to a predefined value, for example \[Project Creation Date\] refers to the creation date of the current project.

You can use SmartNames in different pages in WebCenter. They are displayed between square brackets.

Folder: \[Project Name\]
Using SmartNames to specify a setting ensures that you can use the existing information without having to remember it and thereby reducing errors.

18.3.2 Using a SmartName

You can use SmartNames anytime you see the SmartName symbol in a text field.

1. Click .

2. In the Select to append a SmartName field or Insert a SmartName dialog, select the desired SmartName using one of the following methods:
   a) During the autoname generation, browse to the desired SmartName in the Select to append a SmartName field and select. Alternatively, you can also double-click the SmartName.
   b) In the Search using SmartNames, you can scroll in the main sections list and double-click on the desired SmartName.

   You can also search for a SmartName.
   • The search field has support for AND and OR operators.
   • Spaces can be used and will act as AND operators.
   • Semicolons can be used and will act as OR operators.
   • You can place your search term inside double quotes (" ) when an exact match is required.

Tip:
• You can type the first letters of the SmartName you are looking for to show it in the list.

18.3.3 List of Available SmartNames

The following is the list of available SmartNames for Projects and Documents;

<table>
<thead>
<tr>
<th>SmartNames for Projects</th>
<th>SmartNames for Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Customer Name]</td>
<td>[Customer Name]</td>
</tr>
<tr>
<td>[Customer ShortName]</td>
<td>[Customer ShortName]</td>
</tr>
<tr>
<td>[Customer Location]</td>
<td>[Customer Location]</td>
</tr>
<tr>
<td>[Customer Location ShortName]</td>
<td>[Customer Location ShortName]</td>
</tr>
<tr>
<td>[Project Manager UserName]</td>
<td>[Project Manager UserName]</td>
</tr>
<tr>
<td>[Project Manager LastName]</td>
<td>[Project Manager LastName]</td>
</tr>
<tr>
<td>[Project Manager Location]</td>
<td>[Project Manager Location]</td>
</tr>
<tr>
<td>[Project Manager Location ShortName]</td>
<td>[Project Manager Location ShortName]</td>
</tr>
<tr>
<td>[Project TemplateName]</td>
<td>[Project Manager Location Code]</td>
</tr>
<tr>
<td>[Requestor UserName]</td>
<td>[Project TemplateName]</td>
</tr>
<tr>
<td>[Requestor LastName]</td>
<td>[Author Name]</td>
</tr>
<tr>
<td>[Requestor Location]</td>
<td>[Author LastName]</td>
</tr>
<tr>
<td>[Requestor Location ShortName]</td>
<td>[Author FirstName]</td>
</tr>
</tbody>
</table>
18.3.4 Using SmartNames in Autonaming

You can use SmartNames to set the prefix and suffix in AutoNaming.

The SmartNames list contains general project information and all the attributes defined in WebCenter. You can use several SmartNames if desired or a combination of SmartNames and free text.

Note: To know more on configuring project information see Project and Document Attributes on page 152.

- Click the Insert SmartName button and select a SmartName from the list that appears next to the button.

If you select:

- [Project Attribute],
- [Document Attribute],
• or [Project Creation Date],

you will get another **Select to append a SmartName** field in which you can select a required attribute.

See below some examples of SmartNames in Autoname Generation:

| Prefix: | [Customer Location] [Creation Date:dd.MM.yy] | ![Image] |
| Counter Length: | 4 |
| Suffix: | [EditField] | ![Image] |
| Scope of the Counter: | Reset per Project | ![Image] |

The result will be Chicago_23.12.12_0001_printpromotion

| Prefix: | [Folder Name] | ![Image] |
| Counter Length: | 4 |
| Suffix: | [EditField] [Customer Location] | ![Image] |
| Scope of the Counter: | Reset per Project | ![Image] |

The result will be CAD_0001_printpromotion_Chicago

---

**18.4 Using Autoname Generation**

**18.4.1 System-Wide Project Autonaming**

1. Log in to WebCenter as an Admin user.
2. Click **Admin > Preferences > General**. The General page appears.
3. In the **Project Autoname Generation** section, enter the text boxes with appropriate **Prefix**, **Suffix** and the **Counter Length**.
   
   Click ![Image] to select required SmartNames. The **EditField** SmartName can used only in the **Suffix**.
The option **Use Automatic Naming for Creation of Blank Projects** allows to setup the autoname generation for blank projects also.

4. Click **Save** to make the changes.

### 18.4.2 Template-based Project Autonaming

1. Log in to WebCenter as an Admin user.
2. Click **Admin > Project Management > Projects**. The list of available projects appears in the Project Management page.
3. Click one of the required projects and then click **Configure > Project Creation**. By selecting the **Use Automatic Naming** option allows the Admin to **Use Default Automatic Naming** or **Use Custom Automatic Naming**.

   **Note:** By selecting **Use Default Automatic Naming**, the auto naming is inherited from the settings in **System wide Project Autoname settings**.

4. If you select the **Use Custom Automatic Naming** option, you have to enter the text boxes with appropriate **Prefix**, **Suffix** and the **Counter Length**.

   **Note:** Click ![SmartName](image) to select required SmartNames. The **EditField** SmartName can used only in the Suffix.
18.4.3 System-Wide Document Autonaming

1. Log in to WebCenter as an Admin user.
2. Click **Admin > Preferences > Document Types**. The Document Types page appears.
   a) Select the **Apply Automatic Naming for Creation of Blank Projects** check box, this allows the Admin to setup autonaming for blank projects.
   b) Select the **Apply Default Attribute Categories to Documents in Blank Projects** check box, this allows the Admin to setup the default attributes to documents in blank projects automatically.
3. Select the required Document type and then choose the **Automatic Document Naming**. The options None or Custom are available.
   a) If you select None option, then the autonaming feature is not used.
   b) If you select the Custom option, enter the text boxes with appropriate **Prefix**, **Suffix** and the **Counter Length**. The Scope of the Counter specifies whether you want the counter to work on all the documents in the system, or only to work on the documents of the project when a new document is created.

**Note:** Click to select required SmartNames. The **EditField** SmartName can used only in the **Suffix**.

---

**Project Creation**

- **Use Automatic Naming**
  - Use Default Automatic Naming
  - Use Custom Automatic Naming

| Prefix: | [Requester UserName] |
| Counter Length: | 5 |
| Suffix: | [Creation Date:yyyyMMdd Mm.dd G.'at' hh:mm:ss] |

5. Click **Change** to make the changes.
4. Click **Save** to make the changes.

### 18.4.4 Template/Project-based Document Autonaming

1. Log in to WebCenter as an Admin user.
2. Click **Admin > Project Management > Templates**. The list of available templates appears in the Template Management page.
3. Click one of the required templates and then click **Configure > Document Creation**. The Document Types page appears.
4. Select the required Document type and then in the **Automatic Document Naming** section choose between None, Default or Custom options.
   a) If you select the **None** option, the autonaming option is not selected.
   b) If you select the **Default** option, the setting as per **System wide Document Auto Naming Settings** are taken into consideration.
   c) If you select the **Custom** option, you can enter the text boxes with appropriate **Prefix**, **Suffix** and the **Counter Length**. The **Scope of the Counter** specifies whether you want the counter to work on all the documents in the system, or only to work on the documents of the project when a new document is created.

**Note:** Click ![Select SmartNames](image) to select required SmartNames. The **EditField** SmartName can be used only in the **Suffix**.

![Document Types](image)

The SmartName [Project Attribute] and [Document Attribute] contains an extra option. When selecting these options, an extra drop-down appears in which an administrator can select a required attribute.

5. Click **Save** to make the changes.
19. Migrating your WebCenter Data

As an Administrator, you can migrate your WebCenter data to a different WebCenter server, for example for testing purposes.

To do this, you will export different sets of data (Groups, Projects Templates, Task Types...) as XML files from a server, then import those XML files onto another server.

19.1 Possible Use Cases

1. A new upgrade/version of WebCenter is released and you want to test it on a test server, using the data from the production server.
2. You want to perform some tests on a test system, but don’t want to create dummy data. You can export your production data (for example a large number of groups with their visibility and download permissions) to the test system.
3. You want to copy data between different WebCenter installations.

19.2 Things to Know about Migrating Data

- You can migrate Groups, Projects, Templates, Attribute categories and Task Types between WebCenter systems. You can also import a Task Type’s Workflow into another Task Type (in the same or another WebCenter system).
- To migrate data, you export it as an XML file, then import that XML file on the new system.
- For best results, you should perform the migration in the following order:
  1. Groups,
  2. Attribute categories (with their attributes),
  3. Task Types (and Workflows),
  4. Templates,
  5. Projects.

19.3 Exporting Data

19.3.1 Exporting Groups

2. Search for the required group name(s) or select from the list available and then click Export Groups in the Action menu.
3. **Save the XML file generated** (*ExportedWebCenterGroups.xml*) **to your computer or a network location.**

**Note:**
- Downloading the XML file can take a few minutes depending on the size and number of groups selected.
- If an *ExportedWebCenterGroups.xml* file already exists in your download location, the file you download will be named *ExportedWebCenterGroups(1).xml*.

### 19.3.2 Exporting Attribute Categories

1. **Go to** Admin > Attributes > Attribute Categories.
2. **Select the attribute categories to export** and go to Actions > Export.
3. **Save the XML file generated** (*exportAttributeCategory.xml*) **to your computer or a network location.**

**Note:** If an *exportAttributeCategory.xml* file already exists in your download location, the file you download will be named *exportAttributeCategory(1).xml*.

### 19.3.3 Exporting Task Types

When migrating task types, the following is copied:
- the basic task type settings,
- the task type specifications and layout,
- the task type's workflow.

**Note:** If the task type's workflow uses other task types, you need to import these task types into the other system before (or at the same time as) importing the task type containing the workflow. Otherwise you will get an error message *(Not all the items in the Workflow are available on this WebCenter)* when importing the task type containing the workflow.

1. On the Task Types page, select the task type(s) to export and go to Actions > Export.
2. **Save the XML file generated** to your computer or a network location.

You can now *import* your task type(s) into another system.

### 19.3.4 Exporting a Workflow

You can export a workflow from a task type to an XML file, then import that XML file into another task type on the same or another WebCenter system.
Note: If the workflow uses other task types (than the task type it is part of), you need to import these task types into the other system before (or at the same time as) importing the workflow. Otherwise you will get an error message (Not all the items in the Workflow are available on this WebCenter) when importing the workflow.

1. On your task type’s Workflow tab, go to More actions... > Export.
2. Save the XML file generated to your computer or a network location.

You can now import your workflow(s) into another system.

19.3.5 Exporting Templates

1. Go to Admin > Project Management > Templates.
2. Search for the required template name(s) or select from the list available and then click Export in the Action menu.
3. Save the XML file generated (ExportedWebCenterProjects.xml) to your computer or a network location.

Note:
- Downloading the XML file can take a few minutes depending on the size and number of templates selected.
- If an ExportedWebCenterProjects.xml file already exists in your download location, the file you download will be named ExportedWebCenterProjects(1).xml.

19.3.6 Exporting Projects

1. Go to Admin > Project Management > Project.
2. Search for the required project(s) or select from the list available and then click Export in the Action menu.
3. Save the XML file generated (ExportedWebCenterProjects.xml) to your computer or a network location.

Note:
- Downloading the XML file can take a few minutes depending on the size and number of templates selected.
- If an ExportedWebCenterProjects.xml file already exists in your download location, the file you download will be named ExportedWebCenterProjects(1).xml.
19.4 Importing Data

19.4.1 Importing Groups

When importing Groups, the following details are imported:

- If no visibility settings are updated, then by default the group will be visible to All Project Managers.

- If users or Project Managers do not exist, WebCenter will not create them. Only the ones which are existing will be added.

- The download permissions for the group as specified in the XML, will be granted to the group.

- WebCenter only adds group members based on the user data in the migration file and does not remove existing group members if they do not exist in the migration file.

2. Click Import from XML on the Groups page.
3. Click Choose File and then select the XML file you exported.
4. Click Import. After the import completes, WebCenter shows a basic report.

<table>
<thead>
<tr>
<th>Groups</th>
<th>Import From XML</th>
<th>New Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Group feedback</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of Groups Created</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Number of Groups Modified</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Number of Groups Not Changed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Number of Groups Not Imported</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Return</td>
<td>Download Detailed Report in XML</td>
<td></td>
</tr>
</tbody>
</table>

Tip: Click the Download Detailed Report in XML link to download a detailed report of the import.

19.4.2 Importing Attribute Categories

1. On the Attribute Categories page, click Import.
2. Browse to the XML file that you saved during the export step and click Import.
19.4.3 Importing Task Types

1. On the Task Types page, select Import from XML.
2. Browse to the XML file that you saved during the export step and click Import.

Note: If you get an error message stating Not all the items in the Workflow are available on this WebCenter, it is because you are trying to import a task type containing a workflow that uses task types that are not available on this system. See Exporting Task Types on page 275 to know how to avoid this.

19.4.4 Importing a Workflow

1. On your task type’s Workflow tab, go to More actions... > Import.
2. Browse to the XML file that you saved during the export step and click Import.
3. If the Workflow tab already contained a workflow, confirm that you want to overwrite the existing workflow with the one you are importing by clicking OK.

Note: If you get an error message stating Not all the items in the Workflow are available on this WebCenter, it is because you are trying to import a workflow that uses task types that are not available on this system. See Exporting a Workflow on page 275 to know how to avoid this.

19.4.5 Importing Templates

When importing Templates and Projects, the following details are imported:

• The project will be created only with the information found in the XML file.
• If group members, tasks, attributes are not found in XML file, WebCenter will not create them.
• The project properties: User members, Permissions, Characteristics, Approval setup, Documents, Document autoname settings and Notifications are not imported through the XML file.

1. Go to Admin > Project Management > Templates.
2. Click Import from XML on the Template Management page.
3. Click Choose File and then select the XML file you exported.
4. Click Import. After the import completes, WebCenter shows a basic report.
19.4.6 Importing Projects

When importing Templates and Projects, the following details are imported:

- The project will be created only with the information found in the XML file.
- If group members, tasks, attributes are not found in XML file, WebCenter will not create them.
- The project properties: User members, Permissions, Characteristics, Approval setup, Documents, Document autoname settings and Notifications are not imported through the XML file.

1. Go to Admin > Project Management > Projects.
2. Click Import from XML on the Project Management page.
3. Click Choose File and then select the XML file you exported.
4. Click Import. After the import completes, WebCenter shows a basic report.

Tip: Click the Download Detailed Report in XML link to download a detailed report of the import.
19.5 Migration File Contents

Migration Files for Groups
In the XML migration file for Groups, you will find the following information:

- Group names.
- Visibility type.
- List of users.
- List of Project Managers that have visibility on the selected group.
- Download permissions for the selected group.

Migration Files for Projects and Templates
In the XML migration file for Projects and Templates, you will find the following information:

- Name, description, manager, company and location, sales person, status.
- Project group members and group member permissions.
- Attribute category and attributes.
- Tasks and task sequence.
- Project creation information and Project autoname option.
- Document library option.